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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country
of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test leads while they are
connected to a voltage source.

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it
inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.
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General Safety Summary

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product
or other property.
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Introduction to the Application Welcome

Welcome
DPOJET is a jitter, timing, and eye analysis tool for Tektronix Performance Digital Oscilloscopes
(DPO7000 and DSA/DPO70000 series). DPOJET enables you to achieve new levels of productivity,
efficiency, and measurement reliability on complex clock, digital, and serial data signals.

Some of the features of DPOJET are:

Advanced Jitter and Timing Analysis for clocks and data signals, with up to 99 simultaneous
measurements on 12 sources.

Jitter Guide/Serial Data wizard for easy configuration of popular measurement sets.

One Touch Jitter wizard for quick jitter summaries.

Accurate jitter decomposition and TJ (BER) estimation using industry-accepted methods.

Comprehensive measurement statistics.

Flexible measurement/statistic logging and export capabilities.

Sophisticated graphical analysis tools such as Histograms, Time Trends, Eye Diagrams, Spectrums,
Bathtub Plots and Real-Time Eye® diagrams with transition and non-transition bit separation.

Tektronix patented Programmable PLL software clock recovery.

Standards-specific support for clock recovery and jitter separation methods.

Capture and storage of worst-case waveforms for subsequent analysis.

Thorough remote programmability using oscilloscope-like syntax.

Five-Time Free Trial
You can refer to the Optional Applications Software on a Windows-Based Oscilloscope Installation
Manual for details on free trails which are available for all applications. The manual is available on the
Optional Applications Software on Windows-Based Oscilloscopes DVD, in the documents directory.

NOTE. Before evaluating an application, first check that your DSA/DPO series oscilloscope firmware
version is consistent with the version requirements mentioned in the application’s readme file. You can
check the firmware version number from the oscilloscope Help drop-down list (About TekScope). To check
the application’s firmware compatibility, refer to the System Requirements section of the readme.txt file.

If an application is introduced after you receive your oscilloscope, you can download the application as
described in the installation manual (Tektronix part number 071-1888-XX) to obtain the free trial. You can
download the manuals from www.tektronix.com/manuals and www.tektronix.com/software.
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Introduction to the Application Related Documentation

Related Documentation
Tektronix manuals are available at: www.tektronix.com/manuals and www.tektronix.com/software. Use
the following table to determine the document that you need:

Table 1: List of reference documents
For information on: Refer to:

Operating the Oscilloscope Oscilloscope user manual.
Oscilloscope user online help.

Software warranty

List of available applications

Compatible oscilloscopes

Relevant software and firmware version numbers

Applying a new option key label

Installing an application

Enabling an application

Downloading updates from the Tektronix Web site

Optional Applications Software on Windows-Based
Oscilloscopes Installation Manual, which is provided on
the Optional Applications Software on Windows-Based
Oscilloscopes CD-ROM, in the Documents directory.

xxx

Conventions
Online Help uses the following conventions:

When steps require sequence of selections using the application interface, the “>” delimiter marks
each transition between a menu and an option. For example, Analyze > Wizard > One Touch Jitter.

The terms “DPOJET application” and “application” refer to DPOJET.

The term “oscilloscope” refers to any product on which this application runs.

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the methods of choosing an option: with a mouse or
with the touch screen.

User interface screen graphics are taken from a DPO7000 series oscilloscope.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet only contains
information on installing the application from the DVD and on how to apply a new label. You can also find
the PDF and the Online Help at Start > Programs >TekApplications > DPOJET.
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Introduction to the Application Technical Support

Table 2: Icon descriptions
Icon Meaning

This icon identifies important information.

This icon identifies conditions or practices that could result
in loss of data.

This icon identifies additional information that will help you
use the application more efficiently.

xxx

Technical Support
Tektronix welcomes your comments about products and services. Contact Tektronix through mail,
telephone, or the Web site. Click Contacting Tektronix ) for more information.

Tektronix also welcomes your feedback. Click Customer feedback (see page 3) for suggestions for
providing feedback to Tektronix.

Customer Feedback
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or other comments you may have regarding the application or oscilloscope.

Direct your feedback via email to

techsupport@tektronix.com

Or FAX at (503) 627-5695, and include the following information:

General Information
Oscilloscope model number (for example: DPO7000 or DSA/DPO70000 series) and hardware
options, if any.

Software version number.

Probes used.
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Application-specific Information
Description of the problem such that technical support can duplicate the problem.

If possible, save the oscilloscope and application setup files as .set and associated .xml files.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Once you have gathered this information, you can contact technical support by phone or through e-mail.
In the subject field, please indicate “DPOJET Problem” and attach the .set, .xml and .wfm files to
your e-mail. If there is any query related to the actual measurement results, then you can generate a
.mht report and send it.

The following items are important, but optional:

Your name

Your company

Your mailing address

Your phone number

Your FAX number

Enter your suggestion. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

To include screen shots of the oscilloscope waveform and DPOJET user interface, from your oscilloscope
menu bar, click File > Save As > Screen Capture. To include screenshots of the DPOJET plots, select the
floppy-disk icon from the plots toolbar. In either case, enter a file name in the Save As dialog box, select
an image file format (For Example:.bmp or .png or .jpeg), choose a save location and select Save. You can
then attach the file(s) to your e-mail (depending on the capabilities of your e-mail editor).
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Getting Started Product Description

Product Description
DPOJET is a jitter, timing, and eye diagram analysis tool for Tektronix Performance Digital Oscilloscopes
(DPO7000 and DSA/DPO70000 series). DPOJET enables you to achieve new levels of productivity,
efficiency, and measurement reliability on complex clock, digital, and serial data signals.

The application provides the following features:

One Touch Jitter Summary.

Measurement Setup Wizard.

Auto-detection of signal type (clock or data).

RJ/DJ decomposition on repeating and arbitrary data patterns.

Spectral plot with peak Hold, Averaging, and Nominal.

Eye diagrams with transition and non-transition bits separation.

High and Low Pass measurement filters.

Selectable PLL and line edge detection and clock recovery methods.

Automatic reference level autoset for eye diagrams, jitter and timing measurements.

Timing Analysis
Timing analysis is the measurement of period, setup, hold, skew and other edge-to-edge data timing
relationships.

Eye Diagram Analysis
Eye diagram analysis is the plotting and measurement of eye diagrams and masks.

Jitter Analysis
Jitter Analysis is the measurement of Time Interval Error (TIE), advanced RJ/DJ decomposition, and
other clock to data edge relationships.

DPOJET Option Levels
The DPOJET application offers two different levels of features, depending on how it is configured. The
configurations are determined by the following order codes:

DJE – Jitter and Eye Diagram Analysis Tools - Essentials

DJA – Jitter and Eye Diagram Analysis Tools - Advanced
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NOTE. The application name “Jitter and Eye Diagram Analysis Tools” is the same for DJE and DJA.
However, Help > About DPOJET indicates the configured option level. Save/Recall is be compatible
between the option levels. If a setup file saved in DJA is recalled in DJE, only the capabilities available in
DJE will be recalled.

Jitter and Eye Diagram Analysis Tools - Essentials
You can use Essentials for basic timing and jitter analysis. Essentials offers:

Period, Frequency and Time Interval Error analysis.

Timing parametrics such as rise/fall times, pulse width and duty cycle.

Many graphical tools such as histograms, time trends, and spectrums.

Configurable HTML report generation.

Logging features for recording individual measurements, statistics, or worst-case waveforms.

Comprehensive remote control using oscilloscope-like GPIB syntax.

A wizard interface to ease common setup tasks.

Jitter and Eye Diagram Analysis Tools-Advanced
The Advanced configuration offers all the features of Essentials, and adds the following:

Jitter separation (RJ/DJ analysis).

Eye measurements.

Amplitude measurements.

Measurement filters.

Eye diagrams, bathtub plots or Mask Hits waveform plots.

Pass/Fail limits capability.

Compatibility
For information on oscilloscope compatibility, refer to the Optional Application Software on Microsoft
Windows Based Oscilloscopes Installation Manual, Tektronix part number 077-0067-XX. The manual is
available as a PDF file.
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Requirements and Restrictions
Microsoft .NET Framework version 2.0 or higher, MATLAB Runtime Component 7.5 is required to
install and operate DPOJET on your oscilloscope.

Supported Probes
The application supports the following probes:

TAP1500

TAP2500

TAP3500

P5100

P6015

P6101A

P6139A

P6241

P6243

P6245

P6249

P6150

P6158

P7240

P7260

P7330

P7340A

P7350

P7350SMA

P7360A

P7380A

P7380SMA

P7313A
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P7313SMA

P7513

Installing the Application
Refer to the Optional Applications Software on Windows-Based Oscilloscopes Installation Manual for the
following information:

Software warranty.

List of available applications, compatible oscilloscopes, and relevant software and firmware version
numbers.

Applying a new option installation key label.

Installing an application.

Enabling an application.

Downloading updates from the Tektronix Web site.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet contains
information on how to install the application from the DVD and on how to apply a new option installation
key label.
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Getting Started About DPOJET

About DPOJET
Click Help > About DPOJET to view application details such as the release software version number,
application name, and copyright.
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Operating Basics Starting the Application

Starting the Application
On the oscilloscope menu bar, click Analyze > Jitter and Eye Analysis > Select to open the application.

Application Interface Menu Controls
Table 3: Application Menu Controls descriptions
Item Description
Tab Shortcut to a menu in the menu bar or a category of menu

options; most tabs are short cuts.
Area Visual frame with a set of related options.
Option button Button that defines a particular command or task.
Field Box that you can use to type in text, or to enter a value with

the Keypad or a Multipurpose knob.
Check Boxes Use to select or clear preferences.
Scroll bar Vertical or horizontal bar at the side or bottom of a display

area that can be used for moving around in that area.
Browse Displays a window where you can look through a list of

directories and files.
Command button Button that initiates an immediate action such as Run

command button in the control panel.

Virtual Keypad icon
Click to use on-screen keypad to enter alphanumeric values.

MP knob references (a or b) Identifiers that show which Multi Purpose Knob (MPK) may
be used as an alternate means to control a parameter;
turn the knob on the oscilloscope front panel to adjust the
corresponding parameter Also, the value can be entered
directly on the MPK display component.

xxx

Virtual Keypad

Select the icon and use the virtual keypad to enter alphanumeric values, such as reference voltage
levels.
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Tips on DPOJET User Interface
Here are some tips to help you with the application user interface:

Use the Serial Data/Jitter Guide to rapidly set up and initiate sets of commonly used measurements.
After running the Serial Data/Jitter Guide, you may modify the configuration parameters to meet
specific needs.

Select a measurement to create a measurement and add it to the current measurement table. New
measurements initially use the same source as the earlier measurement, or the most recently used
source. Click to change the measurement source or adjust other source parameters such as
the reference levels.

Select any measurement multiple times to create multiple copies. This may be useful if you wish to
run the same measurement with different configuration options.

Use the Single button to obtain a single set of measurements from a single new waveform
acquisition. Pushing the button again before processing has completed will interrupt the processing
cycle.

Use the Run button to continuously acquire and accumulate measurements. Push the button
again to interrupt the current acquisition.

Use the Recalc button to perform measurements on the waveform currently displayed on the
oscilloscope, that is without performing a new acquisition. This is useful if you wish to modify a
configuration parameter and re-run the measurements on the current waveform.
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Application Directories
The installation directory for DPOJET is C:\Program Files\TekApplications\DPOJET. During
installation, the application sets up directories for various functions such as to save setup files. The file
name extension is used to identify the file type.

Table 4: Application directories
Default directory Used for
C:\TekApplications\DPOJET\Images Exported plot files.
C:\TekApplications\DPOJET\Limits Pass/fail limits files.
C:\TekApplications\DPOJET\Patterns Bit patterns.
C:\TekApplications\DPOJET\Logs Log files. Consists of three subfolders:

Statistics for statistics log files (.csv)

Measurements for measurement log files (.csv) and

Waveforms for worst case waveforms (.wfm)
C:\TekApplications\DPOJET\Masks Mask files for various serial data standards. For Example -

PCIE, FBDIMM, SATA.
C:\TekApplications\DPOJET\Reports Report files (.mht ).
C:\TekApplications\DPOJET Error log file, DPOJETErrors.log.
C:\TekApplications\DPOJET\Examples Various tutorial and support files.
xxx

File Name Extensions
Table 5: File name extensions
File Extension Description
.csv Ascii file containing Comma Separated Values. This file

format may be read by any ascii text editor (such as
Notepad) or may be imported into spreadsheets such as
Excel.

.xml Ascii file containing measurement setup information, limits
or other data in Extensible Markup Language.

.set Binary file containing oscilloscope setup information in a
proprietary format.

.mht An HTML archive file, compatible with common Windows
applications; and contain the full report, including text and
graphics.

.wfm Binary file containing an oscilloscope waveform record in a
recallable, proprietary format.

xxx
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Application Menu Shortcuts
The DPOJET application provides shortcuts for navigating the user interface. Use Alt+ A for the Analyze
menu and Alt+A+J for Jitter and Eye Analysis.

NOTE. Alt+A+J is common for all submenus except the Help menu.

Table 6: Application shortcuts
Menu Items SubMenu Shortcut

One Touch Jitter Alt +A+J+W+OWizard
Serial Data/Jitter Guide Alt +A+J+W+J

Select Alt +A+J+S
Configure Alt +A+J+C
Results Alt +A+J+R
Plots Alt +A+J+P
Reports Alt +A+J+O

Data Snapshot Alt +A+J+E+DExport
Measurement Summary Alt +A+J+E+S

Data Logging Alt +A+J+L
Preferences Alt +A+J+F
Limits Alt +A+J+I
Measurement Summary Alt +A+J+M
Deskew Alt +A+J+K
Help
About DPOJET Alt +H+J
Help on Jitter and Eye Analysis Alt +H+T
xxx

Returning to the Application
When you access oscilloscope functions, the DPOJET control windows may be replaced by the
oscilloscope control windows or by the oscilloscope graticule. You can access oscilloscope functions
in the following ways:
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From the menu bar on the oscilloscope, choose Analyze > Jitter And Eye Analysis > Select.

Alternatively, you can switch between recently used control panels using the forward or backward
arrows on the right corner of the control panel.

Saving a Setup
The DPOJET application state is automatically saved along with the oscilloscope state. To save the
oscilloscope settings and application state, follow these steps:

1. Click File > Save As > Setup.

2. In the file browser, select the directory to save the setup file.

3. Select or enter a file name. The application appends *_DPOJET.xml to store DPOJET setup, and
*.set to store oscilloscope settings.

4. Click Save.

NOTE. After the oscilloscope application is started, DPOJET needs to be launched at least once before
any saved DPOJET configuration can be recalled.

Recalling a Saved Setup
To recall the default application setup and oscilloscope settings, do the following steps:

1. Click File > Recall.

2. Select the directory in the file browser from where you can recall the setup file.

3. Select a .set file and click Recall.

NOTE. Only .set files can be selected for recall; any corresponding _DPOJET.xml file in the same directory
will be recalled as well, if DPOJET has been launched at least once since the oscilloscope application
was started. If DPOJET has not been launched at least once, the oscilloscope settings will be recalled
but the DPOJET configuration will be ignored.

Recalling the Default Setup
To recall the default application and oscilloscope settings, click File > Recall Default Setup.
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Setting Up the Application for Analysis
Refer to the following sections for more details on various measurements:

Period and Frequency measurements

Jitter measurements

Time measurements

Eye measurements

Amplitude measurements

More Measurements

Table of Measurements-Period/Freq
Definitions of the period and frequency-related measurements are given in the following table:

Table 7: Period/Frequency measurements definitions
Measurement Description
Period For clock signals, the elapsed time between consecutive

crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair.
For data signals, the elapsed time between consecutive
crossings of the mid reference voltage in opposite directions
divided by the estimated number of unit intervals for that
pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in
N identical period measurements.

Frequency The inverse of the period for each cycle or unit interval.
CC–Period The cycle-to-cycle period; the difference in period

measurements from one cycle to the next, that is the first
difference of the Period measurement.

N–Period The duration of N periods.
Pos Width Amount of time the waveform remains above the mid

reference voltage level.
Neg Width Amount of time the waveform remains below the mid

reference voltage level.
+Duty Cycle The ratio of positive width to period, expressed in %.
–Duty Cycle The ratio of negative width to period, expressed in %.
+CC–Duty The difference between two consecutive positive widths.
–CC–Duty The difference between two consecutive negative widths.
xxx
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Table of Measurements-Jitter
Definitions of the jitter-related measurements are given in the following table.

NOTE. All jitter measurements except TIE are statistical measurements that require sufficient record length
so that all deterministic effects can be observed and the random jitter can be modeled.

Table 8: Jitter measurements definitions
Measurement Description
TIE Time Interval Error is the difference in time between an

edge in the source waveform and the corresponding edge in
a reference clock or explicitly by another source signal. The
reference clock is determined by a clock recovery process.

RJ Random Jitter is the statistics for all timing errors not
exhibiting deterministic behavior, based on the assumption
that they follow a Gaussian distribution. Random Jitter is
typically characterized by its standard deviation.

RJ–δδ Random Jitter as defined above, but calculated based on a
simplified assumption that the histogram of all deterministic
jitter can modeled as a pair of equal-magnitude Dirac
functions (impulses known as delta-functions).

DJ Deterministic Jitter is the statistics for all timing errors that
follow deterministic behavior. Deterministic Jitter is typically
characterized by its peak-to-peak value.

DJ–δδ Deterministic Jitter as defined above, but calculated on the
same simplified model as described under RJ–δδ.

PJ Periodic Jitter is the statistics for that portion of the
deterministic jitter which is periodic, but for which the period
is not correlated with any data in the waveform.

DDJ Data-Dependent Jitter is the statistics for that portion of the
deterministic jitter directly correlated with the data pattern
in the waveform.

DCD Duty Cycle Distortion is the statistics for that portion of the
deterministic jitter directly correlated with signal polarity, that
is the difference in the mean timing error on positive edges
versus that on negative edges.

TJ@BER Total Jitter at a specified Bit Error Rate (BER). This
combines the Random and Deterministic effects, and
predicts a peak-to-peak jitter that will only be exceeded with
a probability equal to the BER.
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Table 8: Jitter measurements definitions (cont.)

Measurement Description
Jitter Summary This is not an individual measurement but a convenience

function. Pressing this button automatically adds a set of
eleven jitter-related measurements with a single action. The
measurements are: TIE, RJ, RJ–δδ, DJ, DJ–δδ, PJ, DDJ,
DCD, TJ@BER, Width@BER , and Phase Noise .

Phase Noise The RMS magnitude for all integrated timing jitter falling
between two specified frequency limits. This measurement
is only applicable for clock signals.

xxx

Table of Measurements-Time
Definitions of the time-related measurements are given in the following table:

Table 9: Time measurements definitions
Measurement Description
Rise Time Elapsed time between the Low reference level crossing and

the High reference level crossing on the rising edge of the
waveform.

Fall Time Elapsed time between the High reference level crossing
and the Low reference level crossing on the falling edge
of the waveform.

High Time Amount of time the waveform remains above the high
reference voltage level.

Low Time Amount of time the waveform remains below the low
reference voltage level.

Setup Elapsed time between the designated edge of a data
waveform and that of a clock waveform, based on their
respective mid reference level crossings.

Hold Elapsed time between the designated edge of a clock
waveform and that of a data waveform, based on their
respective mid reference level crossings.

Skew Time difference between two similar edges on two
waveforms assuming that every edge in one waveform has
a corresponding edge (either the same or opposite polarity)
in the other waveform; edge locations are determined by the
mid reference voltage level.

xxx
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Table of Measurements-Eye
Definitions of the eye-related measurements are given in the following table:

Table 10: Eye measurements definitions
Measurement Description
Height The measured clear vertical eye opening at the center of

the unit interval. Height = High(min) – Low(max)
Width Measured clear horizontal eye opening at the middle

reference level.
Width = UI(mean) – TIE(max) – TIE(min)

Width@BER The horizontal eye opening projected to correspond to
a specified Bit Error Rate. This number is obtained by
measuring the jitter on the waveform performing RJ/DJ
separation analysis, creating a bathtub curve, and reporting
the bathtub width at the appropriate error rate. This eye
width may not match the observed eye width because
it is a statistical measure. The measurement requires a
sufficient record length so that all deterministic effects can
be observed and the random jitter can be modeled.
Width(BER) = UI(mean) – TJ(BER)

Mask Hits The number of unit intervals for which mask violations
occurred. A mask violation occurs when, during a unit
interval, the waveform passes through a segment of the
defined mask. Mask hits are separately tallied for Segment
1 (upper), Segment 2 (center-of-eye mask) and Segment 3
(lower), and the total for all three segments is also reported.
Thus, as many as three hits can be added to the total count
for each unit interval. The population for this measurement
gives the total number of unit intervals observed.

xxx

Table of Measurements-Amplitude
Definitions of the amplitude-related measurements are given in the following table:

Table 11: Amplitude measurements definitions
Measurement Description
High Vertical value in the central portion of the unit interval (UI)

for high data bits. The percent of the UI over which the
waveform is evaluated is adjustable, as is the method
by which a single value is derived from this span. The
measurement may optionally be limited to transition or
non-transition bits only.
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Table 11: Amplitude measurements definitions (cont.)

Measurement Description
Low Vertical value in the central portion of the unit interval (UI)

for low data bits, with configuration options matching those
of the High measurement.

High–Low Difference between the mean value of the High
measurement and the mean value of the Low measurement.

Common Mode Common-mode voltage for the two

sources. .
T/nT-Ratio Ratio of the transition eye-voltage to the nearest subsequent

non-transition eye voltage, expressed in decibels.
V–Diff –Xovr Voltage level at the crossover voltage of a differential signal

pair.
xxx

Table of Measurements-More
Measurements in the More category may include timing, jitter, amplitude or eye measurements. Generally,
they are measurements that have been modified to support a specific standard or otherwise deviate from
the generic measurements. Their definitions are given in the following table:

Table 12: More measurements definitions
Measurement Description
DDR Setup–SE Elapsed time between the designated edge of a data

waveform and that of a single-ended DQS waveform, based
on their respective DDR-specific reference level crossings.

DDR Setup–Diff Elapsed time between the designated edge of a data
waveform and that of a differential DQS waveform, based
on their respective DDR-specific reference level crossings.

DDR Hold–SE Elapsed time between the designated edge of a
single-ended DQS waveform and that of a data waveform,
based on their respective DDR-specific reference level
crossings.

DDR Hold–Diff Elapsed time between the designated edge of a differential
DQS waveform and that of a data waveform, based on their
respective DDR-specific reference level crossings.

DDR tCK(avg) Calculated as the average clock period across a sliding
200-cycle window.

DDR tCL(avg) Defined as the average low pulse width calculated across a
sliding 200-cycle window of consecutive low pulses.

DDR tCH(avg) Defined as the average high pulse width and is calculated
across a sliding 200-cycle window of high pulses.
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Table 12: More measurements definitions (cont.)

Measurement Description
DDR tERR(n) Defined as the cumulative error across multiple consecutive

cycles from tCK(avg).
DDR tERR(m-n) Defined as the cumulative error across multiple consecutive

predefined cycles from tCK(avg).
DDR tJIT(duty) Defined as the cumulative set of the largest deviation of

any single tCH from tCH(avg) and the largest deviation of
any single tCL from tCL(avg).

DDR tJIT(per) Defined as the largest deviation of any single tCK from
tCK(avg).

xxx

One Touch Jitter
One Touch Jitter is a process for automatically performing complex jitter analysis with a single menu
selection. The process selects a waveform source, sets the horizontal and vertical scales, chooses
measurements, generates statistical results and creates plot summary (Histogram, Spectrum, Bathtub and
Eye Diagram). To run this process, select Analyze > Jitter and Eye Analysis > Wizard > One Touch
Jitter.

By default, the DPOJET application chooses an appropriate source for the jitter measurements from the
available active source(s) (amplitude >50 mV) before generating the jitter summary.

NOTE. If the source amplitude is not greater than 50 mV, the application displays a message “Signal
amplitude is extremely low for the selected source”.

The following logic is used if none or many sources are active:

None of the sources are active (see page 22)

Only one source is active (see page 22)

Two sources are active (see page 22)
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Three sources are active (see page 22)

Four or more sources are active (see page 23)

Case 1: None of the sources are active
If none of the sources are active, you are prompted to select any one of the Ch, Ref or Math sources.
The selected source is validated to have amplitude >50 mV. When the amplitude of the selected source
is >50 mV, then autoset is performed to increase vertical and horizontal resolution of the signal. The
selected source is assigned for all single source jitter measurements. The results and plots are generated
for a single sequence.

Case 2: Only one source is active
The application checks if the active source has amplitude >50 mV. The selected source is assigned for all
single jitter measurements. The results and plots are generated for a single sequence.

Case 3: Two sources are active
The application checks whether the active sources are a differential pair. Creates a Math waveform taking
the difference of the other two (Example: Math1=Ref1–Ref2). The lowest numbered Math waveform
is considered as the source for all single jitter measurements. The results and plots are generated for a
single sequence.

If the active sources are not a differential pair, the application checks if one of the source is a clock with a
period that divides the other sources. An explicit clock recovery method derives the clock from the clock
source. The application creates explicit-clock measurements TIE, Height, TJ@BER, RJ–δδ, DJ–δδ and
Width@BER for the source. The results and plots are generated for a single sequence.

If one of the active sources is not a clock, the application selects a single source from the active sources
using the following priority:

1st- Lowest numbered Math

2nd- Lowest numbered Channel

3rd- Lowest numbered Ref

The results and plots are generated for a single sequence.

Case 4 : Three sources are active
The application checks whether one of the active sources is a Math, which is defined as difference of two
sources (Example: Math1=Ref1–Ref2 ). The application selects the Math waveform as the source for all
single source jitter measurements. The results and plots are generated for a single sequence.

If one of the active sources is not a Math, the application selects a single source from the active sources
using the following priority:

1st-Lowest numbered Math
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2nd-Lowest numbered Channel

3rd-Lowest numbered Ref

The application creates single source jitter measurements. The results and plots are generated for a single
sequence.

Case 5: Four or more sources are active
If four or more sources are active, the application selects a single source from the active sources using
the following priority:

1st-Lowest numbered Math

2nd-Lowest numbered Channel

3rd-Lowest numbered Ref

The application creates single source jitter measurements for the selected source. The results and plots
are generated for a single sequence. The following figure shows the summary plot after One Touch
Jitter is performed.
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About Serial Data/Jitter Guide
The Serial Data/Jitter Guide allows you to set up, configure and run a measurement without intimate
knowledge about the control menus.

Select Analyze > Jitter and Eye Analysis > Wizard > Serial Data/Jitter Guide to launch the Serial
Data/ Jitter Guide.

The Serial Data/ Jitter Wizard includes the following steps:

Select Measurement

Configure Measurement

Select Source(s)

Configure Autoset Options

Select Plots

NOTE. You can exit the Serial Data/Jitter Wizard without affecting any settings in the DPOJET application
by clicking Cancel anytime before clicking the Finish button.
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Select Measurement
In this step, you can select any of the listed measurements:

Period and Frequency

Skew

Time Interval Error (TIE)

Jitter Summary includes Total Jitter (TJ@BER), RJ, DJ, PJ, DDJ, TIE, and DCD measurements and
plots

Eye Summary includes Height, Width, Width@BER, and Unit Interval measurements and plots

By default, the Period and Frequency measurement is selected. Click Next to accept the measurement

and proceed to Configure Measurement. The transition to next step is represented by on the left
along with selections or default values.
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About Configuring Measurement
By default, the configuration parameters are displayed for Period and Frequency, TIE and Eye
measurements. The Configure Measurement option is available only for Skew and Jitter Summary. The
selection in the previous step is displayed on the left.

Configure Skew Measurement

Configure Jitter Summary Measurement

Configure Measurement-Skew
If you select Skew in the previous step, you can configure edges by selecting the From and To edges and
set the measurement limits.

Click Next to select the measurement sources.

Related Topics
Configure Edges for Skew Measurement
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Configure Measurement-Jitter Summary
If you select Jitter Summary measurement in the previous step, you can set the pattern length by selecting
Repeating pattern and then entering the pattern length in the text box. If you have a non-repeating
waveform pattern or if the pattern length is unknown, select Arbitrary.

NOTE. The measurements that you select also determine the plot types.

Click Next to select the measurement sources.

Related Topics
RJ/DJ Analysis Parameters

RJ/DJ
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Select Sources
In this step, you can select the measurement source(s). The source selection depends on the measurement
type. By default, Source1 is displayed automatically for all the measurements depending on the waveform
last used. If Ch1/Ref1/Math1 is displayed for Source1, Source2 is Ch2/Ref2/Math2 else Ch1/Math1/Ref1
will be selected as Source2.

The Source2 option is displayed only for two source measurements such as Skew.
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Click Next to configure autoset.

Configure Autoset Options
In this step, you can choose to automatically adjust the oscilloscope settings or the reference levels before
the measurement. The default of Yes is recommended. By selecting No, you will retain the current
oscilloscope settings and/or ref levels.

Click Next to select plots.
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Select Plots
In this step, you can select the plots that you want to display. The measurements that you selected earlier
also determine which plot types will be available in this step. The following table lists the available
plots for measurements:

Table 13: Measurements and available plots
Measurement Plots
Period and Frequency Period Trend, Period Spectrum, Period Histogram.
Skew Skew Trend, Skew Spectrum.
TIE TIE Trend, TIE Spectrum, TIE Histogram.
Jitter Summary TIE Trend, TIE Spectrum, TIE Histogram, and Bathtub

Curve.
Eye Summary Eye Diagram (Transition Bit), Eye Diagram (Non Transition

Bit) Unit Interval Histogram, and Eye Width@BER.
xxx

In this example, the selections shown are for a Period and Frequency measurement.
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Click Finish to start the acquisition sequence using the selected settings. The Serial Data/Jitter Guide
window closes and the results screen is displayed.
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NOTE. None of the user specified settings are retained if you click Cancel before clicking Finish.

About Jitter And Eye Diagram Analysis Options
Click Analyze > Jitter And Eye Analysis to view the following options:

Export Data Snapshot

Export Measurement Summary

Data Logging

Preferences

Limits

Measurement Summary
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Deskew

Deskew
To ensure accurate results for two-channel measurements and differential signals acquired on two channels,
it is important to first deskew the probes and oscilloscope channels before you take measurements
of your DUT (see page 33).

The application includes an automated deskew utility that you can use to deskew any pair of oscilloscope
channels.

NOTE. To produce the best deskew results, you should connect the probes to the fastest slew rate signals
from your DUT.

Connecting to a Device Under Test (DUT)
You can use any compatible probes or cable interface to connect between your DUT and oscilloscope.

WARNING. To avoid electric shock, remove power from the DUT before attaching probes. Do not touch
exposed conductors except with the properly rated probe tips. Refer to the probe manual for proper
use. Failure to do so may cause injury or death.

Refer to the General Safety Summary in your oscilloscope manual.

Deskewing on Oscilloscopes with Bandwidth Extension
Some Tektronix oscilloscopes feature software-based bandwidth extension. The bandwidth extension
may be enabled on a per-channel basis.

Enabling or disabling bandwidth extension on any channel affects the skew on that channel. Thus, you
should deskew probes and channels after you make such configuration changes. Bandwidth Extension
provides improved timing accuracy, phase matching, and amplitude accuracy. It also will provide noise
reduction. We recommend Bandwidth Extension be used at all times.

Steps to Deskew Probes and Channels
To deskew probes and oscilloscope channels, follow these steps:

1. Refer to Connecting to a Device Under Test before starting the procedure.

2. Connect both probes to the fastest signal in your DUT.
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Set up the oscilloscope as follows:

1. Use the Horizontal Scale knob to set the oscilloscope to an acquisition rate so that there is a minimum
of two, preferably five, samples per edge or more samples on the deskew edge.

2. Use the Vertical Scale and Position knobs to adjust the signals to fill the display without missing
any part of the signals.

3. Set the Record Length so that there are more than 100 edges in the acquisition.

4. Launch the DPOJET application.

5. Click Analyze > Jitter And Eye Analysis > Deskew.

6. Set the Reference channel source to Ch1. The source waveform is the reference point used to deskew
the remaining channels.

7. Set the Channel to be Deskewed source as Ch2.

8. To start the process, click Perform Deskew.

9. Repeat steps 7 and 8 for other Ch waveforms.

10. Select Summary (see page 35) to view the deskew values.

34 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Deskew Summary

Deskew Summary
The Deskew Summary dialog lists the channel source and its deskew values.
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Export Data Snapshot-Statistics
You can save a snapshot of the current statistics in .csv format. The default location is
C:\TekApplications\DPOJET\Logs\Statistics.

Click Analyze > Jitter and Eye Analysis > Export > Data Snapshot > Statistics to view the following:

Table 14: Data Snapshot- Statistics options
Item Description
Select Target Measurements Displays the measurement list. Click a row to select the

measurement. By default, all measurements are selected.
Select All Selects all the measurements in the list for saving statistics.
Clear All Deselects all the measurements from the list.
Save Statistics
Save Saves the current statistics of selected target measurements

to a log file.
File Name
Browse Saves the .csv file in the specified directory. The file format

is YYMMDD_HHMMSS_Stats.csv. The default directory is
C:\TekApplications\DPOJET\Logs.

Close Accepts the changes and closes the window.
xxx
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NOTE. The default location for saving log files can be changed in the Preferences dialog box.

Related Topics
Export Data Snapshot-Measurement

Export Data Snapshot-Measurement
You can save a snapshot of the data points in .csv format. The default location is
C:\TekApplications\DPOJET\Logs\Measurements.

Click Analyze > Jitter and Eye Analysis > Export > Data Snapshot > Measurement to view the
following:
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Table 15: Data Snapshot- Measurement options
Item Description
Select Target Measurements Displays the measurement list. Click a row to select the

measurement. By default, all measurements are selected.
Select All Selects all the measurements in the list for saving statistics.
Clear All Deselects all the measurements from the list.
Save Measurements
Save Saves the data points for current acquisition of selected

target measurements in a log file.
Folder
Browse Saves the .csv file in the specified directory. The

default directory is C:\TekApplications\DPO-
JET\Logs\Measurements.

File Names
View Displays View Log File Names (see page 43)

dialog box which lists the measurements and
their source(s) with corresponding log file
name inYYMMDD_HHMMSS_<Measurement
Name>-<SourceName>.csv format.

Close Accepts the changes and closes the window.
xxx

View Log File Names
The View Log File Names dialog box lists the measurements and their source(s) with corresponding
log file name in YYMMDD_HHMMSS_<Measurement Name>-<SourceName>.csv format. Click Close
to close the dialog box.
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Related Topics
Export Data Snapshot

Export Measurement Summary
Click Analyze > Jitter and Eye Analysis > Export > Measurement Summary to save the generated
report in C:\TekApplications\DPOJET\Reports.The exported measurement summary contains
information only about application setup and configuration.
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Data Logging-Statistics
The application can continuously log (save to file) the calculated statistics. You can save the statistics to a
“comma separated value” (.csv) file to import into a text editor, a spreadsheet, or an analysis tool.

By default, all measurements are selected. You can select individual measurements by selecting the
row in the table on the left.

The steps for logging statistics are:

1. Click Analyze > Jitter and Eye Analysis > Data Logging > Statistics to view the Logging Statistics
screen.
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2. Select the measurements which you want to log in the Select Target Measurements table on the
left. Click Select All to select all the measurements for logging or click Clear All to deselect the
current measurements list.

3. Click On/Off to enable/disable automatic logging statistics for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\TekApplications\DPOJET\Logs\Statistics.

Table 16: Log-Statistics options
Item Description
Select Target Measurements Displays the measurement list. Select the check box to

select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.
Clear All Deselects all the measurements in the list.
Log Statistics
Off Disables automatic logging for all selected measurements.
On Enables automatic logging for all selected measurements.
File Name
Browse Saves the .csv file in the specified directory. The file format

is YYMMDD_HHMMSS_Stats.csv. The default directory is
C:\TekApplications\DPOJET\Logs\Statis-

tics.
xxx
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NOTE. Microsoft Excel has a limitation where you cannot increase the number of rows (65,536) or
columns (256) beyond the maximum row and column limits. Opening log files in Wordpad or another
analysis package is recommended. An error message “File not loaded completely” is displayed, if you try
to open a log file with data exceeding the aforesaid row and column limits.

Related Topics
Data Logging-Measurement

Data Logging-Worst Case

Data Logging-Measurement
You can log the actual individual measurement data values as measurement files.

1. Click Analyze > Jitter and Eye Analysis > Data Logging > Measurement to view the Logging
screen.

2. Select the measurements that you want to log in the Select Target Measurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current
measurements list.

3. Click On/Off to enable/disable logging for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\TekApplications\DPOJET\Logs\Measurements.
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Table 17: Log-Measurements options
Item Description
Select Target Measurements Displays the measurement list. Select the check box to

select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.
Clear All Deselects all the measurements from the list.
Log Measurements
Off Disables automatic logging for all selected measurements.
On Enables automatic logging for all selected measurements.
Folder
Browse Saves the .csv file in the specified directory.

The default directory is C:\TekApplications\DPO-
JET\Logs\Measurements.

File Names
View Displays View Log File Names (see page 43) dialog

box which lists the selected measurements with
source(s) and their corresponding log file names
in YYMMDD_HHMMSS_<MeasurementName>-
<SourceName>.csv format.

xxx

View Log File Names
The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in YYMMDD_HHMMSS_<MeasurementName>-<SourceName>.csv
format. Click Close to close the dialog box.
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Related Topics
Data Logging-Statistics

Data Logging-Worst Case
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Data Logging-Worst Case
1. Click Analyze > Jitter and Eye Analysis > Data Logging > Worst Case to view the Worst Case

Logging screen.

2. Select the measurements which you want to log in the Select Target Measurements table on the
left. Click Select All to select all the measurements for logging or click Clear All to deselect the
current measurements list.

3. Click On/Off to enable/disable worst case logging for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\TekApplications\DPOJET\Logs\Waveforms.

Table 18: Log-Worst Case options
Item Description
Select Target Measurements Displays the measurement list. Select the check box to

select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.
Clear All Deselects all the measurements in the list.
Log Worst Case Waveforms
Off Disables the application to save worst case waveforms for

all selected measurements.
On Enables the application to save worst case waveforms for

all selected measurements.
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Table 18: Log-Worst Case options (cont.)

Item Description
Folder
Browse Saves the .csv file in the specified directory.

The default directory is C:\TekApplications\DPO-
JET\Logs\Waveforms.

File Names
View Displays View Log File Names (see page 46) dialog

box which lists the selected measurements with
source(s) and their corresponding log file names
in YYMMDD_HHMMSS_<MeasurementName>-

<Source(s)>_Max<Source Number>.wfm and

<MeasurementName>-<Source(s)>_Min<Source

Number.wfm † format.
xxx

† For example, if the selected measurement is Skew1 with Ref1 and Ref3 as sources, then the file names will be Skew1-Ref1,Ref3_Max1.wfm,
Skew1-Ref1,Ref3_Min1.wfm, Skew1-Ref1,Ref3_Max2.wfm, and Skew1-Ref1,Ref3_Min2.wfm.

View Log File Names
The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in YYMMDD_HHMMSS_<MeasurementName>-<Source(s)>_Max<Source
Number>.wfm and <MeasurementName>-<Source(s)>_Min<source Number>.wfm format. Click
Close to close the dialog box.
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Related Topics
Data Logging-Statistics

Data Logging-Measurement

Measurement Configuration Summary-Measurement
Click Analyze > Jitter and Eye Analysis > Measurement Configuration Summary > Measurement to
view measurement, source and the configuration parameters of each measurement.

Table 19: Measurement configuration information
Item Description
Measurement Displays the measurement name.
Source Displays the selected source.
Others Displays the other configuration information related to the

selected measurement.
OK Closes the window.
xxx
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Related Topics
Measurement Summary-Ref Levels

Measurement Summary-Misc

Measurement Summary-Ref Levels
Click Analyze > Jitter and Eye Analysis > Measurement Configuration Summary > Ref Levels to
view the ref level tab. This tab provides information about ref level configuration per source. Displays the
reference voltage levels for the high, mid, and low thresholds for the rising edge and for the falling edge of
each active source, and the hysteresis.

Table 20: Ref Level configuration information
Item Description
Source Displays the selected source.
Rise High Displays the high threshold level for the rising edge of the

source.
Rise Mid Displays the middle threshold level for the rising edge of

the source.
Rise Low Displays the low threshold level for the rising edge of the

source.
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Table 20: Ref Level configuration information (cont.)

Item Description
Hysteresis Displays the threshold margin to the reference level which

the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

Fall High Displays the high threshold level for the falling edge of the
source.

Fall Mid Displays the middle threshold level for the falling edge of
the source.

Fall Low Displays the low threshold level for the falling edge of the
source.

OK Closes the window.
xxx

Related Topics
Measurement Configuration Summary-Measurement

Measurement Summary-Misc

Measurement Summary-Misc
Click Analyze > Jitter and Eye Analysis > Measurement Configuration Summary > Misc tab to
view various configuration parameters. The Miscellaneous tab shows whether the Gating, Qualify, and
Stat Pop Limit functions are enabled; if enabled, it also shows the source for qualification, the size for
population, and various other configuration choices.
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Table 21: Miscellaneous configuration information
Item Description
State Displays On when Gating, Qualify and Population are

enabled and Off when they are disabled.
Source Displays the selected source for qualify.
Size Specifies the maximum population which can be obtained

for each active measurement.
OK Closes the window.
xxx

Related Topics
Measurement Configuration Summary-Measurement

Measurement Summary-Ref Levels

About Preferences Setup
The applications provides Preferences Setup, where you can set options. These options remain unchanged
until you reset them. Click Analyze > Jitter and Eye Analysis > Preferences to view the Preferences
screen. To use the application more efficiently, you can set the options in the following tabs:

Preferences-General

Preferences-Measurement

Preferences-Path Defaults

Preferences-General
Click Analyze > Jitter and Eye Analysis > Preferences > General to view the following:
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Table 22: Preferences-General options
Item Description
View Log Displays the error/warning log file in a notepad window

when the button is pushed.
Clear Log Clears the error/warning log file when the button is pushed.
Display Units Selects the display units for time measurements, between

seconds or Unit Intervals.
Default Image Type Selects the default image format (JPEG, PNG or BMP) that

will be used by those functions that save images.
Notifier Duration Determines how long the Warning notifier will remain on

the screen before disappearing. (The notifier may also be
dismissed manually).

Cancel Discards all changes and closes the Preferences window.
OK Accepts all changes and closes Preferences window.
xxx

Related Topics
Preferences-Measurement

Preferences-Path Defaults
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Preferences-Measurement
Click Analyze > Jitter and Eye Analysis > Preferences > Measurement to view the following:

The Measurement tab allows you to limit Rise and Fall measurements to transition bits only, or allow these
measurements for all bits. Here, the transition bits refer to edge transitions for which the preceding
transition was only one unit interval away. This may be important for signals with pre-emphasis, since
the transition following a string of two or more like bits has an intentionally low swing that you may
not want to measure.

You can enable or disable high-performance eye rendering from this tab. This provides a trade-off between
greater fidelity or greater rendering speed. You can also select the Dual Dirac model and the waveform
interpolation type.

Table 23: Preferences-Measurement options
Item Description
Limit Rise/Fall measurements to transition bits only When selected, determines whether Rise Time and Fall

Time measurements are performed on all bit or only on
transition bits.

52 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Preferences-Measurement

Item Description
Enable high-performance eye rendering When enabled, determines whether eye diagrams are

optimized for speed or fidelity. When disabled, all unit
intervals (UI) in the waveform(s) are included in the
rendered eye. This gives the highest fidelity eye rendering,
but can take considerable amount of time for long records.
When this option is checked, a statistically representative
subset of the UI is rendered, so that eye diagrams for long
waveforms can be displayed in a shorter time. The rules
for high-performance rendering are as follows: 1) If the
waveform contains 15,000 or fewer UI, all the UIs in the
waveform are rendered. 2) If the waveform includes more
than 15,000 UI, it is subdivided into segments of 2000 UI
each. The entire waveform is scanned to find the specific
UI, that are the worst-case violators for six different points
around the eye. For each of these worst case violators,
the entire segment of 2000 UI in which it lies is rendered.
Depending on whether multiple worst-case violators lie in
the same segment or not, as few as 2000 UI but typically
from 8000 to 12,000 UI will be rendered in the final eye.

Dual Dirac Model When selected, determines which parameter-extraction
method is used when RJ/DJ separation is done under
the Dual-Dirac model. This affects results for the RJ–δδ
and DJ–δδ measurements only. When Fibre Channel is
selected, RJ and DJ parameters are extracted according
to guidelines given in ANSI/INCITS Technical Report
TR-35-2004 “Methodologies for Jitter and Signal Quality
Specification”. RJ and DJ values are selected that cause an
exact match between the bathtub curves from the dual-dirac
and the full analytical models at two prescribed BER levels.
When PCI/FB-DIMM is selected, RJ and DJ parameters
are determined using the methodology defined in the
PCI-Express Gen 2 and Fully-Buffered DIMM specifications.
In this technique, the bathtub curves are plotted on a
Q-scale that linearizes the tails of the bathtub, and the RJ
and DJ values are derived from where the asymptotes to
the curves intersect the BER=0 line.

Waveform Interpolation Type Select the type of interpolation that is used between sample
points, to determine the exact time when a waveform
crosses a reference voltage level. Linear interpolation is
faster but introduces distortion that raises the jitter noise
floor slightly. Sin(x)/x Interpolation, also known as Sinc
Interpolation, approaches theoretically perfect waveform
reconstruction but is computationally expensive.

Cancel Discards the changes and closes the window.
OK Accepts the changes and closes the window.
xxx

Related Topics
Preferences-General
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Preferences-Path Defaults

Preferences-Path Defaults
Click Analyze > Jitter and Eye Analysis > Preferences > Path Defaults to view the following:

The Path Defaults allows you to set the path for images, reports and log files. Click Browse to modify the
default directory path.

Table 24: Preferences-Path Defaults options
Item Description
Default image export directory Selects the directory to which images will be saved, unless

overridden at the time of the export.
Default logging export directory Selects the directory to which logs will be saved, unless

overridden at the time of the export.
Default report export directory Selects the directory to which reports will be saved, unless

overridden at the time of the export.
Cancel Discards the changes and closes the window.
OK Accepts the changes and closes the window.
xxx

Related Topics
Preferences-General

Preferences-Measurement
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Limits
Limits file allows you to determine Pass or Fail status for tests. Each serial data application provides limits
file that includes combinations of all measurements and statistical characteristics, and an appropriate
range of values for each combination.

The application does not provide any limits file. You can create one by specifying limits for any of
the result parameters such as Mean, Std Dev, Max, Min, peak-to-peak, population, MaxPosDelta and
MinPosDelta. For each of these result parameters, you can specify Upper Limit (UL), Lower Limit (LL),
or Both. The measurement names in the limits file must be entered as mentioned in
Setting Up the Application for Analysis (see page 16).

NOTE. The limits file supports only absolute values.

To include Pass/Fail status in the result statistics, you can create a limits file using an XML editor or any
other editor in the following format. If the file is created in any other editor such as notepad, it should
be saved in Unicode format.

<?xml version="1.0" encoding="utf-16" ?>

<Main>

<Measurement>

<NAME>Period</NAME>

<STATS>

<STATS_NAME>Mean</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_NAME>StdDev</STATS_NAME>

<LIMIT>LL</LIMIT>

<UL>1121</UL>

<LL>0121</LL>

</STATS>

<STATS>

<STATS_NAME>Max</STATS_NAME>

<LIMIT>BOTH</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_NAME>Min</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>1</LL>

</STATS>
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<STATS>

<STATS_NAME>PeakToPeak</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>1</LL>

</STATS>

<STATS>

<STATS_NAME>MaxPosDelta</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>1121</UL>

<LL>1121</LL>

</STATS>

<STATS>

<STATS_NAME>MinNegDelta</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_NAME>Population</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

</Measurement>

</Main>
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Table 25: Limits options
Item Description
Pass/Fail Test
Off/On Enables (On) or Disables (Off) the display of limit information

in results. Select On to choose a limits file for the selected
measurement.

Select Limits File
Browse To select an existing limits file or locate the directory.
Close Accepts the changes and closes the window.
xxx

About Taking a New Measurement
If you want to change the trigger settings or localize the measurements, you should do so before you
take any measurements.

NOTE. When you run any measurement, Sampling mode in the oscilloscope should be set to “Real Time”.
You need to do this setting in the oscilloscope to take DPOJET measurements.

Selecting a Measurement
To take a measurement, click Analyze > Jitter And Eye Analysis > Select.

The application provides you different methods to set up the application:

Wizard

Measurement Setup sequence

The measurement categories are Period/Freq, Jitter, Time, Eye, Amplitude, and More as shown in the
following table:
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Table 26: Measurement selections
Category Measurements

Period Pos Width Neg Width Freq
N–Period +Duty Cycle –Duty Cycle

Period/Freq

CC–Period +CC–Duty –CC–Duty
TIE RJ RJ–δδ Jitter Summary
TJ@BER DJ DJ–δδ Phase Noise

Jitter

PJ DDJ DCD
Rise Time Fall Time Skew *

High Time Low Time
Time

Setup * Hold *

Eye Width Width@BER
Height
Mask Hits
High Common Mode
Low T/nT-Ratio

Ampl

High–Low V–Diff –Xovr *

DDR Setup-SE * DDR Hold-Diff *

DDR Setup-Diff *

More

DDR Hold-SE *

xxx

* Two Source Measurements

Wizard
The Serial Data/ Jitter Guide allows you to set up, configure, and run the selected set of measurements
without requiring any knowledge of the control menus. However, it does not provide access to
many of the advanced features.

Measurement Setup Sequence
The Measurement Setup Sequence buttons in the left navigation panel shows the logical order you
would follow to set up the application if you do not use the Wizard.

Warning Log Notifiers

Warning Log Notifiers display error messages or warnings. Warnings ( ) or Error ( ) messages are
also shown in the results tab. You can click View Log to view the error log information in a text editor.
Click OK to discard the displayed error message.
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You can set the duration for which the warning notification should appear on the screen in the Preferences
(see page 50) dialog box or click OK to discard the warning information.

NOTE. The error or warning log is saved as DPOJETErrors.log in C:\TekApplications\DPOJET
subfolder.

Navigation Panel
The Navigation Panel appears on the left of the application window. It consists of the following tabs:
Select, Configure, Results, Plots and Reports.

Table 27: Navigation panel functions
Tab Description
Select Displays the various measurements available for selection.

By default, this tab is highlighted. You can click any
measurement categorized with Period/Freq, Jitter, Time,
Eye and Amplitude tabs.

Configure Displays the configuration for the selected measurement.
Results Displays the result for the selected measurement.
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Table 27: Navigation panel functions (cont.)

Tab Description
Plots Displays the result as a two-dimensional plot for additional

measurement analysis. You can select and configure plots
for selected measurements.

Reports Displays the configuration for generating reports in .mht
format. Allows you to select results, plots and details.

xxx

Control Panel
The Control Panel appears on the right of the application window. Using this panel, you can start or stop the
sequence of processes for the application and the oscilloscope to acquire information from the waveform.
The controls are Clear, Recalc, Single and Run. The following table describes each of these controls:
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Table 28: Control panel selections
Item Description
Clear Clears the current result display and resets any statistical

results and autoset ref levels.
Recalc Runs the selected measurements on the current acquisition.
Single Initiates a new acquisition and runs the selected

measurements.
Run Initiates a new acquisition and runs the selected

measurements repeatedly until Stop is clicked. Used only
for live sources.

Show Plots Displays the plot summary window when clicked. This
button appears in the control panel only when a plot is
selected.

DDR Analysis Shortcut to access the DDRA application from DPOJET.
Appears in the control panel only when DDRA is opened
using Analyze > DDR Analysis.

xxx

The control panel with Show Plots is as shown:

Sources Setup
The application takes measurements from waveforms specified as input sources. You can select an
oscilloscope channel input (live), a reference or a math waveform as the source and also view labels of
the selected waveforms.

You can configure sources using any of the following options:

Click icon in the table which lists the selected measurements.

Double-click anywhere on row in the table which lists the selected measurements.

The source selections depend on the selected measurement. For differential input sources, you need
to use only math waveforms.
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NOTE. Setup, Hold, V–DIff–Xovr, Common Mode and Skew are two source measurements. The Source2
option is displayed only for two source measurements.

When more than one single source measurement is selected, Apply to all single source measurements
option is enabled in the source configuration screen.

When more than one two source measurement is selected, Apply to all two source measurements
option is enabled in the source configuration screen.

NOTE. Custom measurement names (Ex: tDQSH) are not displayed for DDRA selected measurements
in the DPOJET source configuration screen. Instead, their DPOJET-based ( Pos Width) measurement
names are displayed.
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Related Topics
Source Autoset

Ref Levels

Custom Source Name
Use a virtual keyboard to create a label for the selected waveform using the option Label under Vertical >
Label on your oscilloscope menu bar. For more details, refer to your oscilloscope online help.

Custom source names are displayed for both DPOJET and DDRA measurements. The DPOJET
application displays DQ (Data Source) and DQS (Strobe). A tool tip displays the Custom source name and
the base source (in brackets) on moving the mouse over the row in the measurement table, results, Data
Logging, Measurement Configuration Summary, Export to Ref, and Data Snapshot.

The custom source names (DQ and DQS) appears in the following screens:

Measurement table

Source Configuration
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Results

Plots

Data Snapshot
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Data Logging and

Measurement Summary
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Export Results to Ref
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Source Autoset
The Source Autoset allows you to automatically adjust the oscilloscope’s vertical and/or horizontal settings
for live sources (Ch1-Ch4) to improve measurement accuracy.

The Vertical Scale option automatically checks the peak-to-peak level of live sources. The vertical scale
and offset of all signals with a peak-to-peak value less than six divisions are adjusted so the peak-to-peak
will be eight divisions. If the maximum or minimum value of a signal is “clipped”, the vertical scale and
offset are adjusted so that the peak-to-peak value will be eight divisions.

The Horizontal Resolution option automatically checks the number of samples/edge on the rising and
falling transitions (Rise Time/Resolution and Fall Time/Resolution) of all live channels. The oscilloscope
horizontal resolution is set to the largest value that does not cause the samples/edge of the fastest edge to
fall below the specified target. The target is five samples per edge. The Horizontal Resolution sets the
acquisition sampling mode to Real Time for signals with very high edge speeds. The default record
length is 500 k points.

To automatically define both the vertical and horizontal settings for all channel sources, select the Vert
and Horiz button. The Vert and Horiz option also applies an oscilloscope autoset on each channel before
performing the vertical scale and horizontal resolution autoset.

Follow these steps to automatically define the vertical or horizontal settings for active sources:

1. Ensure that any channel waveform that you want to autoset is visible on the oscilloscope.

2. For Vert & Horiz and Horizontal resolution, the edge resolution is configured for five samples per
edge or more for better edge timing and measurement accuracy.

3. Select one of the following options:

Vert & Horiz to autoset both vertical and horizontal setting.

Vert Scale button to autoset oscilloscope vertical settings only.

Horiz Res to autoset oscilloscope horizontal settings only.

Undo to return the oscilloscope to its state before autoset.
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Table 29: Autoset configuration options
Item Description
Vertical Scale If a channel waveform does not exceed six vertical divisions,

decreases the scale so that the waveform occupies about
eight divisions.

Horiz Res Sets the horizontal resolution so that the number of samples
on the fastest transition (edge) exceeds a specified target.

Vert & Horiz Performs a sequence: Oscilloscope Autoset, Vertical scale
and Horizontal resolution.

Undo Returns to the settings present before an Autoset was
performed; disabled after measurements are taken until you
perform another source autoset.

Ref Levels Setup Click Ref Levels Setup in the Source Configuration screen
to hide/unhide the Ref Levels Setup.

xxx

68 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Ref Levels

Ref Levels
Timing measurements are based on state transition times. By definition, edges occur when a waveform
crosses specified reference voltage levels. Reference voltage levels must be set so that the application
can identify state transitions on a waveform. By default, the application automatically chooses reference
voltage levels when necessary.

The DPOJET application uses three basic reference levels: High, Mid and Low. In addition, a hysteresis
value defines a voltage band that prevents a noisy waveform from producing spurious edges. The reference
levels and hysteresis are independently set for each source waveform, and are specified separately for
rising versus falling transitions. There are two ways to set the reference voltage levels: automatic (see
page 71) and manual (see page 72).

High, Mid, and Low Reference Voltage Levels
The application uses three reference voltage levels: High, Mid, and Low.

For most measurements, the application only uses the Mid reference voltage level. The Mid reference
level defines when the waveform state transition occurs at a given threshold.

For Rise Time and Fall Time measurements, the High and Low reference voltage levels define when
the waveform is fully high or fully low.
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Rising Versus Falling Thresholds
You can specify thresholds for each of the reference voltage levels: High, Mid, and Low. The application
uses the thresholds to determine the following events:

A Low/Mid/High rising event, which occurs when the waveform passes through the corresponding
Rise threshold in the positive direction.

A Low/Mid/High falling event, which occurs when the waveform passes through the corresponding
Fall threshold in the negative direction.

For a given logical reference level (such as Low, Mid, or High), rising and falling events alternate as
time progresses.

NOTE. In many cases, the rising and falling thresholds for a given reference voltage level are set to the
same value. In those cases, a hysteresis value helps prevent spurious edges produced by small amounts of
noise in a waveform.

Using the Hysteresis Option
The hysteresis option can prevent small amounts of noise in a waveform from producing multiple threshold
crossings. You can use a hysteresis when the rising and falling thresholds for a given reference voltage
level are set to the same value.

The reference voltage level ± the hysteresis value defines a voltage range that must be fully crossed by
the waveform for an edge event to occur. If the decision threshold is crossed more than once before the
waveform exits the hysteresis band, the mean value of the first and last crossing are used as the edge
event time.

For example, if the waveform rises through the Threshold – Hysteresis, then rises through the Threshold,
then falls through the Threshold, then rises through both the Threshold and the Threshold + Hysteresis, a
single edge event occurs at the mean value of the two rising crossings.
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Example of Hysteresis on a Noisy Waveform

Automatic Versus Manual Reference Voltage Levels
Each measurement source may be configured to automatically choose voltage reference levels (default), or
to lock the reference voltages to levels of your choosing.

In the Ref Levels Setup panel, a table at the left edge contains all of the currently active measurement
sources. An Autoset check box appears beside each source. To enable or disable Autoset for a given
source, choose the source in the left column and select the corresponding check box to toggle its state.

For more details, refer to Understanding When Ref Level Autoset will Occur (see page 72) and
Understanding How Ref Level Autoset Chooses Voltages (see page 72).

Table 30: Configure sources ref levels autoset configuration
Item Description
Autoset * Calculates and displays the reference voltage levels for all

sources where the autoset option is set according to the
Autoset Ref Level Setup.

Setup Specifies the Base-Top method and relative percent to be
used for all reference voltage levels when autoset occurs.

Status Specifies Armed/Disarmed status indicating whether
the ref level voltages will be recalculated/retained for a
measurement.

xxx

* If you do not perform Autoset using Autoset button, the application updates the reference levels (if required) when you select Single or Run
to take measurements.
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Understanding When Ref Level Autoset will Occur
When Autoset is enabled for a given source, the individual reference levels are displayed but you may
not manually adjust them. Instead, the reference levels are automatically recalculated whenever one of
the following events occur:

A measurement sequence is initiated for the first time after a source has become active.

A measurement sequence is initiated for the first time after all results have been cleared.

The Autoset button at the right edge of the panel is pressed.

The Autoset button is provided as a convenience, but it is never required. Autoset will always be run (if
enabled) before an uninitialized source is used for a measurement.

An Armed indicator appears in the upper right corner of the panel whenever a new source has been added
or deleted or measurement results have been cleared. This lets you know that the reference levels will be
recalculated the next time either the Single or the Run button is selected.

If DisArmed indicator appears, the displayed reference levels will be retained if a measurement sequence
is performed with no further configuration changes. Of course, you can cause the reference levels to be
recalculated at any time by selecting the Autoset button.

Understanding How Ref Level Autoset Chooses Voltages
Once triggered, the Reference Level Autoset function uses the following logic to determine actual voltage
levels.

For each applicable source, the Top (high logic level) and Base (low logic level) are first determined. Then,
the High, Mid and Low levels are calculated as percentages of the Top-Base difference. For example,
if the Top and Base are 2.8 volts and 0.4 volts respectively and the High percentage level is 90%, this
threshold would be calculated as:

HighThres= Base+ High Percent (Top-Base)= 0.4+0.9 (2.8–0.4)= 2.56

Click Setup to select a method used to calculate the Top and Base of the waveform and also the percentages
used for the High, Mid and Low thresholds for each source. The Autoset Ref Levels (see page 74) appears.

Manually Adjusting the Reference Voltage Levels
Whether or not you use the application to automatically calculate the initial reference voltage levels, you
may need to manually change the values. To set the reference levels manually, follow these steps:

1. Click icon in the table which lists the selected measurements to view the source configuration
screen.

2. Select the desired source from the Source list.

NOTE. You cannot select inactive sources.

72 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Ref Levels

3. Clear the Autoset option for the sources you wish to set manually.

4. Select the reference levels or hysteresis options and manually adjust the values. The values will not
change when you select Autoset or take measurements.

NOTE. A source will become inactive if all measurements on that source are removed. If a new
measurement is then added on that source, the source once again becomes active, and defaults to Autoset.
If you clear all measurement on a source that was set to Manual, you must reselect the Manual state (if
desired) when the source is again added.

Table 31: Configure sources ref levels configuration
Item Description
Autoset * Calculates and displays the reference voltage levels for all

sources where the autoset option is set according to the
Autoset Ref Level Setup.

Setup Specifies the Base-Top method and relative percent to be
used for all reference voltage levels when autoset occurs.

Ref Levels Setup (one level per source) †

Rise High Sets the high threshold level for the rising edge of the
source.

Rise Mid Sets the middle threshold level for the rising edge of the
source.

Rise Low Sets the low threshold level for the rising edge of the source.
Fall High Sets the high threshold level for the falling edge of the

source.
Fall Mid Sets the middle threshold level for the falling edge of the

source.
Fall Low Sets the low threshold level for the falling edge of the

source.
Hysteresis Sets the threshold margin to the reference level which

the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

Close Accepts the changes and closes the window.
Status Specifies Armed/Disarmed status indicating whether

the ref level voltages will be recalculated/retained for a
measurement.

xxx

* If you do not update ref levels by clicking Autoset, the application updates the reference levels (if required) when you select the Single or Run
to take measurements.

† Default setting are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).
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Autoset Ref Levels
Click Setup in the Ref Level Setup screen to select a method used for calculating Top and Base of the
waveform and also the percentages used for the High, Mid and Low thresholds for each source. The
Autoset Ref Levels screen appears.

Table 32: Autoset ref level configuration
Item Description
Base Top Method
Min-Max Uses the minimum and maximum values in the waveform

to determine the base and top amplitude. Useful on a
waveform with low noise and free from excessive overshoot.

Low-High Histogram (Full Waveform) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes of the
entire waveform; the histogram should have a peak at the
nominal high level, and another peak at the nominal low
level.

Low-High Histogram (Center of Eye) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes in the
center of each bit (unit interval) while ignoring the waveform
during bit transitions. The histogram should have a peak
at the nominal high level and another peak at the nominal
low level.

Auto Automatically determines the best Base Top method to use.
Set Ref Level % Relative to Base Top *
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Table 32: Autoset ref level configuration (cont.)

Item Description
Rise High Sets the high threshold level for the rising edge of the

source.
Rise Mid Sets the middle threshold level for the rising edge of the

source.
Rise Low Sets the low threshold level for the rising edge of the source.
Fall High Sets the high threshold level for the falling edge of the

source.
Fall Mid Sets the middle threshold level for the falling edge of the

source.
Fall Low Sets the low threshold level for the falling edge of the

source.
Hysteresis Sets the threshold margin to the reference level which

the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

OK Accepts the changes and closes the window.
xxx

* Default setting are 90%(High), 50% (Mid), 10% (Low), and 3% (Hysteresis).

About Configuring a Measurement
You can configure the measurements listed under the following categories:

Period/Freq

Jitter

Time

Eye

Amplitude

More

NOTE. Configure tabs are displayed only when you select a measurement.

The following tables lists the configure tabs displayed for each measurement.
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Table 33: Period/Freq measurements

UI Name

Mea-
sure-
ments Edges

Bit
Config

Clock
Recov-
ery RJDJ Filters General Global

Clock
Period

Period

Data
Period

Freq Clock
Fre-
quency
Data
Fre-
quency

Pos
Width

Pos
Width

Neg
Width

Neg
Width

N–Pe-
riod

N–Pe-
riod

+Duty
Cycle

+Duty
Cycle

-Duty
Cycle

-Duty
Cycle

CC-Pe-
riod

CC-Pe-
riod

+CC-
Duty

+CC-
Duty

-CC-
Duty

-CC-
Duty

xxx

Table 34: Jitter measurements

UI Name

Mea-
sure-
ments

Bit
Config Edges

Clock
Recov-
ery RJDJ Filters General Global

Clock
TIE

TIE

Data TIE
Clock TJTJ@BER
Data TJ
Clock
DCD

DCD

Data
DCD
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Table 34: Jitter measurements (cont.)

UI Name

Mea-
sure-
ments

Bit
Config Edges

Clock
Recov-
ery RJDJ Filters General Global

Clock RJRJ
Data RJ
Clock DJDJ
Data DJ

DDJ DDJ
Clock
RJ–δδ

RJ–δδ

Data
RJ–δδ
Clock
DJ–δδ

DJ–δδ

Data
DJ–δδ
Clock PJPJ
Data PJ

Jitter
Sum-
mary 1

Phase
Noise
xxx

1 Jitter Summary is not an individual measurement but a convenience function. Pressing this button automatically adds a set of eleven
jitter-related measurements with a single action. The measurements are: TIE, RJ, RJ–δδ, DJ, DJ–δδ, PJ, DDJ, DCD, TJ@BER,
Width@BER , and Phase Noise.

Table 35: Timing measurements
Measure-
ments Bit Config Edges

Clock
Recovery RJDJ Filters General Global

Rise Time
Fall Time
Skew
High Time
Low Time
Setup
Hold
xxx
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Table 36: Eye measurements
Measure-
ments Bit Config Edges

Clock
Recovery RJDJ Filters General Global

Width
Width@BER
Height
Mask Hits
xxx

Table 37: Amplitude measurements
Measure-
ments Bit Config Edges

Clock
Recovery RJDJ Filters General Global

High
Common
Mode
Low
T/nT Ratio
High–Low
V–Diff–Xovr
xxx
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Table 38: More measurements
Measure-
ments Bit Config Edges

Clock
Recovery RJDJ Filters General Global

DDR
Setup-SE
DDR
Setup-Diff
DDR
Hold-SE
DDR Hold-
Diff
DDR
tCK(avg)
DDR
tCH(avg)
DDR
tCL(avg)
DDR
tERR(n)
DDR
tERR(m-n)
DDR
tJIT(duty)
DDR
tJIT(per)
xxx

Related Topics
Bit Config

Edges

Clock Recovery

RJDJ

Filters

General

Global

About Global
This configuration tab is common for all measurements. You can limit the waveform data analysis by
Gating, Qualifying and Populating the waveform data.
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Gating
Gating allows you to focus the analysis on a specific area of the waveform bounded by a gated region,
which is a way to filter unnecessary information.

You can set up a gated region in one of the following ways:

Zoom

Cursors

Table 39: Global-Gating options
Item Description
Off No gating occurs; application takes measurements over

the entire waveform.
Zoom Zooms the specified region of the source waveform to take

measurements within the selected area. The region of
waveform within the zoom is analyzed.

Cursors Gates the waveform with Vertical cursors. The region of
waveform within the cursors is analyzed.

xxx
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Qualify
Qualifiers allows you to limit the application to more narrowly defined conditions before taking
measurements. All sources for the measurements and Qualify input must have the same Horizontal Sample
Rate, Record Length, and Position to ensure that measurements function properly. For measurements
which require clock recovery such as TIE or eye measurements, only the first qualified region will be
measured even if multiple qualified regions are present. For all other measurements, the entire waveform
is processed.

Table 40: Global-Qualify options
Item Description
Off Disables the application from using the defined conditions

while taking measurements.
On Enables the application to use the defined conditions while

taking measurements.
Configure Displays the Qualify with Logic (see page 81) dialog box.
xxx
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Configuring Qualify with Logic
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Table 41: Qualify-Configure options
Item Description
Source * Selects a waveform to qualify the signal or clock source

used for the measurement. The input source waveforms or
files are Ch, Ref, Math and Search (see page 83). Displays
the burst control type selected in DDRA when you turn on
the qualifier. Also indicates that ASM is turned on.

Mid Shows the vertical reference level of the qualifier waveform. ‡

Hysteresis Shows the amount of hysteresis applied to the vertical
reference level of the qualifier waveform. Hysteresis
prevents small amounts of noise in a waveform from
producing multiple threshold crossings.

Active
High † Enables measurements in regions † where the qualifier

waveform exceeds the mid reference level.
Low † Enables measurements in regions † where the qualifier

waveform falls below the mid reference level.
OK Accepts the changes and closes the window.
xxx

* Measurement and Qualify sources must have the same Horizontal Sample Rate, Record Length, and Position to ensure that measurements
function properly.

† For measurements that require clock recovery, only the first qualified region will be measured even if multiple qualified regions are present.
‡ The default behavior for all reference levels is to automatically adjust based on the signal amplitude after a "Clear" operation, unless you disable

the autoset checkbox in the source configuration panel. Whether you use the Qualify with Logic dialog box to adjust the levels or not, be aware
that the levels may change if automatic adjustment is still enabled. For more information, refer to Automatic Versus Manual Reference Voltage
Levels (see page 71).

Search Behavior in DPOJET
When search is configured, the application analyzes the identified marks on the source waveform. Read
and Write bursts are selected in ASM when search is selected as the qualify source. Each Mark indicates
the start and stop of a burst. These marks are used by the DPOJET measurement when the qualify source is
configured to Search. You can configure up to eight searches (Search1 – Search8) in ASM (Advanced
Search and Mark). The same search number gets reflected in DPOJET. Search is used for Multiple burst
analysis. Multiple burst is used for all DDR measurements except clock measurements. For more details,
refer to your oscilloscope online help.

Population
The Population control allows you to limit the amount of waveform data that is analyzed. This is often
done in industry standards to make sure that there is consistency between measurement techniques.
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Table 42: Global-Population options
Item Description
Off Disables the application from using a Population limit while

taking measurements.
On Enables the application to use a Population limit while

taking measurements.
Configure Displays the Population Limit (see page 84) dialog box

wherein you can set a limit on a maximum population to
obtain, for selected measurements.

xxx

Configuring Population Limit

Table 43: Population-Configure options
Item Description
Limit By
Population The limit determines the population of measurement

observations that will be accumulated. Some measurements
may accumulate observations more quickly than others.
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Table 43: Population-Configure options (cont.)

Item Description
Acquisitions The limit determines the number of acquisition cycles that

will be performed.
Stop Conditions
Each Measurement Each measurement stops accumulating as soon as it

reaches the specified limit. Sequencing does not stop until
all measurements have reached the limit, at which time
every measurement will have exactly the limit.

Last Measurement Sequencing continues and all measurements continue
accumulating until the last (slowest accumulating)
measurement reaches the limit, at which time they all stop.
When sequencing stops, all measurements except one may
have higher population than the limit.

Limit Specifies the number of acquisitions or measurements the
application takes before sequencing stops.

OK Accepts the changes and closes the window.
xxx

General
This configuration tab allows you to customize the measurement name and qualify the measurement within
a selected result range. The General tab looks the same for all the measurements but is not common. The
values are different for different measurements. You can set the custom name per measurement here. Use
the virtual keyboard to enter the measurement name of your choice. Measurements selected in DDRA are
the custom names for the measurements defined in DPOJET. A tool tip displays the custom name and the
DPOJET-based measurement name (in brackets) on moving the mouse over the row in the measurement
table, results, data snapshot, and measurement configuration summary.

Table 44: General options
Item Description
Off Disables the application from using the specified

measurement limits.
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Table 44: General options (cont.)

Item Description
On Enables the application to use the specified measurement

limits.
Max or Min value Specify the maximum and minimum range of valid

measurement values measurements. The default values
for the Measurement Range Limits options vary by
measurement.

Custom Measurement Name Option to modify the measurement name. Allows adding a
user-specified name to any measurement. This is useful for
aligning DPOJET measurements with a user measurement
list or standard.

xxx

NOTE. If a max value smaller than the min value is entered, it is accepted and the min value is also silently
reduced to the same value. Likewise, if a min value larger than the max is entered, both are set to that value.

Filters
This configuration tab allows you to modify the measurement data by applying a High Pass filter to block
out low frequency band components or a Low Pass filter to block out high frequency band components.
For Example: Selecting a 1 MHz high pass filter can reduce the effect of SSC on results.

For some measurements (Period, Frequency, TIE, +Duty Cycle, –Duty Cycle, +CC Duty , – CC Duty ,
CC–Period, Positive Width, Negative Width, N–Period, Rise Time, Fall Time, Low Time, High Time,
Common ModeV, High–Low, High, Low and T/nT Ratio), the measurements versus time waveform
(time trend) that is derived from the original oscilloscope waveform can be filtered before it is passed to
the statistics and plotting subsystems.
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Band Pass Filtering
You can create a band pass filter by enabling both the High Pass and the Low Pass filters on a measurement.
The cut-off frequency for the Low Pass filter must be greater than or equal to the cut-off frequency for the
High Pass filter.

You should be aware that setting the cut-off frequencies close to each other may effectively filter out all
of the measurement data, or all but a small amount of timing noise. This diagram shows the spectrum
of the measurement data passed to the statistics and plotting subsystems when you use both the High
Pass and the Low Pass filters.

High Pass filters attenuate low frequencies, and filter out DC values entirely. When a high pass filter is
added to a period or frequency measurement, the mean value of the filtered measurement goes to zero.
This can be seen by creating a Time Trend plot of a high-pass-filtered period or frequency measurement.
Although this is the correct theoretical behavior for the filtered measurement, it is not very useful if the
Results panel reports that the mean period or frequency is zero. For this reason, the mean values that
appear in the results panels for Period and Frequency measurements are the values before the filter.
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Table 45: Filter options
Item Description
High Pass
Filter Spec When enabled, blocks the low frequency band and passes

only the high frequency band of the waveform; defined as
1st order, 2nd order, 3rd order Butterworth and No filter, being
the default.

Freq (F1) * High Pass filter cut off frequency at which the filter
magnitude falls by 3 dB.

Low Pass
Filter Spec When enabled, blocks the high frequency band and passes

only the low frequency band of the waveform; defined as 1st

order, 2nd order, 3rd order Butterworth, and No filter, being
the default.

Freq (F2) * Low Pass filter cut off frequency at which the filter magnitude
falls by 3 dB.

Advanced Displays the Advanced Filter Configuration (see page 88)
dialog box.

xxx

* Includes a 3 dB cut-off frequency.

Advanced Filter Configuration
The measurement filters are implemented using infinite impulse response (IIR) designs. As with any
causal filter, a transient may occur at the filter’s output in response to the arrival of the input signal. It is
usually desirable to exclude this transient from the measurement results.

In the DPOJET application, the filter transient is managed in two ways. First, the input to the filter is
gently “ramped up” from zero to its full value over some ramp time tr. Second, the output of the ramp
is “blanked” over some duration tb, so that the remaining effects of any transient are omitted from
measurement results, statistics and plots. The sequence of operations is depicted here:
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The ramp function has a raised-cosine profile and is defined in the time domain as:

You may adjust the ramp time tr by means of the Advanced control panel. If you wish to turn off the
ramp function, set the ramp time to 0.

Similarly, you may adjust the blanking duration tb by means of the Advanced control panel. Setting the
blanking duration to 0 will allow you to see the entire filtered measurement, including any transients.

Both, the ramp time tr and the blanking duration tb, are set relative to the reciprocal of the lowest filter
frequency Fc. By default, both of these parameters are set to 1/Fc. Since they are normalized to the filter
frequency, they will automatically adjust if you change the filter cut-off frequency.

The complete set of signal processing options, together with representative waveforms that suggest how
the options affect the measurement vector, are shown here:
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Table 46: Advanced filter configuration options
Item Description
Ramp Time Duration of the raised-cosine smoothing function applied to

the measurement vector before the vector is filtered.
Blanking Time Duration of the filter’s output that is suppressed. The

blanked portion of the output is not included in the
measurement statistics, or in any plots.

OK Accepts changes and closes.
xxx

About Clock Recovery
Clock recovery refers to the process of establishing a reference clock, the edges of which can be used
as a basis for timing comparisons. The Clock Recovery configuration tab allows you to select one of
the following clock recovery methods:

Constant Clock - Mean

Constant Clock - Median

Constant Clock - Fixed

Phase Locked Loop Standard BandWidth

Phase Locked Loop Custom BandWidth

Explicit Clock - Edge

Explicit Clock - PLL

The first four methods derive the reference clock from the same channel upon which the measurement
is defined. This is the conventional method of clock recovery for serial data communications, where no
separate clock is available. The last two methods (Explicit Clock) derive the reference clock from a
channel other than the one upon which the measurement is defined.

About Constant Clock Recovery
In Constant Clock Recovery, the clock is assumed to be of the form A*sin (2Π ft +Φ), where the frequency
(f) and phase (Φ) are treated as unknown constants. Once a source waveform has been acquired and the
edges extracted, one or both of these constants are determined using linear regression, so that the recovered
clock minimizes the mean squared sum of the Time Interval Error (TIE) for that waveform.

If Constant Clock - Mean is selected as the clock recovery method, both the frequency and the phase
are chosen to minimize the mean squared error.

If Constant Clock - Fixed is selected as the clock recovery method, the precise frequency specified is
used but the phase is chosen so that the median error between the recovered and measured edges is zero.
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If Constant Clock - Median is selected as the clock recovery method, the phase is chosen so that the
median error between the recovered and measured edges is zero.

Constant Clock - Mean
This method provides the following options that control how the clock recovery is performed:

Auto Calc First Acq

Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.
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Table 47: Constant Clock - Mean options
Item Description
Auto Calc First Acq Calculates the best fit of the initial acquisition or the first

acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) PLL-Standard clock recovery
options that have Clock Recovery as configuration tab.

Advanced Displays the Clock Recovery Advanced Setup (see page 94)
dialog box.

xxx

Constant Clock - Median
This method provides the following options that control how the clock recovery is performed:

Auto Calc First Acq

Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.
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Table 48: Constant Clock - Median options
Item Description
Auto Calc First Acq Calculates the best fit of the initial acquisition or the first

acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup (see page 94)
dialog box.

xxx

Constant Clock - Fixed
This method provides a single option that controls how the clock recovery is performed: the Clock
Frequency. With Fixed Constant Clock recovery, no attempt is made to derive information about the
actual data rate from the signal under test. Instead, the precise frequency that you specify will be used.
(However, the clock phase will be chosen so that the median difference between the recovered and
measured edges is zero.)

NOTE. Click Apply to All to apply the clock recovery configuration to all selected measurement(s) that
have Clock Recovery as configuration tab.
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Clock Recovery Advanced Setup
The Advanced Clock Recovery methods are used when unusually high noise defeats normal clock recovery
methods. Under most normal operating conditions, these methods are not required nor recommended.
Nominal Data Rate and Known Data Pattern are the two advanced clock recovery methods.

In Nominal Data Rate, you can provide the nominal data rate to the clock recovery algorithm. Normally,
the application analyzes your data and determines the nominal data rate automatically. Using Nominal
provides a starting point or hint to the clock recovery algorithm from which it analyzes data.

In Known Data Pattern, the pattern is specified by using an ASCII text file containing the characters 1
and 0. The file may contain other characters, spaces and tabs for formatting purposes, but they will be
ignored. Several files for commonly used patterns are included with the application, and you may use these
as examples if you wish to create your own pattern files. Click Browse to modify the default location
for pattern files.

Table 49: Advanced clock recovery options
Item Description
Nominal Data Rate
Off, On Enables (On) or disables (Off) the advanced clock recovery

through data rate guidance.
Bit Rate Defines the nominal data rate in bits per second (b/s). Use

the pop-up keypad to set the data rate.
Known Data Pattern
Off , On Enables (On) or disables (Off) advanced clock recovery

through a known data pattern.
Pattern File Name
Browse Selects a file to use for the data pattern.
OK Accepts changes and closes.
xxx
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About PLL Clock Recovery Setup
When PLL-based clock recovery is selected, the application simulates the behavior of the hardware Phase
Locked Loop clock recovery circuit. This is a feedback loop in which the Voltage-Controlled Oscillator
(VCO) is used to track or follow slow variations in the bit rate of the input waveform. Such loops are
frequently used to recover the clock in communication links that do not transmit the clock as a separate
signal. The PLL parameters in the application may be adjusted to simulate with the behavior of a receiver
in such a link, within certain guidelines.

NOTE. The effective transfer function of a PLL loop is not equal to the PLL Loop BW setting. The Transfer
function depends on the factors such as damping, transition density and type.

PLL Standard BW
The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type II loop is chosen, you can specify the damping factor.

To set the loop bandwidth automatically, based on a serial standard, select PLL: Standard BW as the clock
recovery method. From the Standard: b/s list box, select the standard that matches your data link. For
example, choose “PCI-E: 2.5” to test a 2.5 Gbit/second PCI-Express link. In this case, the PLL bandwidth
will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in PCI-Express standard.

You can use the PLL Model list box to choose between Type I and Type II loop. A Type I loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type II loop approaches zero
frequency with a 1/s2 slope (In much of the PLL literature, these terms are used interchangeably with
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First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

NOTE. Although it is possible to configure a Type II PLL with a bandwidth up to 1/10 of the baud rate,
such a loop will have poor dynamic performance. This is because Type II loops have less phase margin
than Type I loops. A preferred alternative to using a Type II PLL with a bandwidth close to its baud rate is
to use a 2nd order high-pass measurement filter to emulate the effects of the PLL.

Table 50: PLL-Standard clock recovery options
Item Description
PLL Model Selects between a Type I or Type II phase-locked loop.
Damping Use the keypad to specify the damping ratio of the PLL. It is

enabled only for Type II phase-locked loop.
Loop BW Displays the bandwidth that has been selected based on

the current standard.
Standard: b/s Implicitly sets the loop bandwidth of the clock recovery PLL,

based on selection of the industry standard and data rate in
bits/second.

Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have clock recovery as
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup (see
page 94).

xxx

PLL Custom BW
The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type II loop is chosen, you can specify the damping factor.
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To manually control the loop bandwidth, select PLL: Custom BW as the clock recovery method and use
the User BW control to select the 3 dB bandwidth of the loop, in Hz.

You can use the PLL Model list box to choose between a Type I and Type II loop. A Type I loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type II loop approaches zero
frequency with a 1/s2 slope. (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

NOTE. Although it is possible to configure a Type II PLL with a bandwidth up to 1/10 of the baud rate,
such a loop will have poor dynamic performance. This is because Type II loops have less phase margin
than Type I loops. A preferred alternative to using a Type II PLL with a high bandwidth is to use a 2nd
order high-pass measurement filter to emulate the effects of the PLL.

Table 51: PLL-Custom clock recovery options
Item Description
PLL Model Selects between Type I or Type II phase-locked loop.
Damping Use the keypad to specify the damping ratio of the PLL. It is

enabled only for Type II phase-locked loop.
Loop BW Explicitly sets the loop bandwidth of the clock recovery PLL.
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup (see
page 94).

xxx
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About Explicit Clock Recovery
In Explicit Clock Recovery, the reference clock is not derived from the measurement’s target source at all,
but is instead taken from a separately-identified source. Since the source used for the measurement now
differs from the source used to derive the reference clock, selecting this type of clock recovery converts
the measurement from a single-source measurement to a dual-source measurement. The reference clock
source is always shown on the right when the two sources appear in a measurement table. Changing the
clock-recovery method back to a non-explicit clock method will change the measurement back to a
single-source measurement.

Explicit Clock-Edge
Select Explicit Clock-Edge method if you want to use the edges found in the selected clock source
(possibly multiplied up by an integral number). If the Clock Multiplier is set to 1 (the default), only these
edges will be used. If the Clock Multiplier is set to a number N other than 1, linear interpolation will be
used between each pair of actual edges to create N-1 additional reference edges. The interpolated edge
times, combined with the actual edges, give a total of N reference edge times per actual edge.
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Table 52: Explicit-Clock edge options
Item Description
Clock Source Select Ch1 to Ch4, Ref1 to Ref4, or Math1 to Math4 as

reference source for clock recovery.
Clock Edge Specify whether the rising, falling or both edges of selected

source should be considered.
Clock Multiplier Specify the number of edges to be used.
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Advanced Explicit Clock-Edge (see page 100)
dialog wherein you can adjust the timing relation between
reference clock source and data source.

xxx

Advanced Explicit Clock-Edge
To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data. The (positive or negative) time delay you specify will be used to shift the
reference clock edges before the measurement software associates each data edge with the closest clock
edge.

Related Topics
Effect of Nominal Clock Offset on Eye Diagrams
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Explicit Clock-PLL
Select Explicit Clock-PLL as the clock recovery method if you want to feed the edges from the selected
clock source through a PLL rather than using them directly. The actual edges from the clock source will
be used to drive a software PLL model, and the edge times coming out of the PLL will be used as the
reference edges for the target measurement. If the Clock Multiplier is set to a number N other than 1, the
output of the PLL will have N edges per actual edge.

Table 53: Explicit-Clock PLL options
Item Description
Clock Source Select Ch1 to Ch4, Ref1 to Ref4 or Math1 to Math4 as

reference source for clock recovery.
Clock Edge Specify whether the rising, falling or both edges of selected

source should be considered.
Clock Multiplier Specify the number of edges to be used.
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Advanced Explicit Clock-PLL (see page 101)
dialog wherein you can adjust the timing relation between
reference clock source and data source.

xxx

Advanced Explicit Clock-PLL
In the Advanced Explicit Clock- PLL, you can specify the PLL type, bandwidth, damping factor and
nominal clock offset relative to data. Damping numeric input is enabled only for Type II phase-locked loop.
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Nominal Clock Offset Relative to Data
To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data. The (positive or negative) time delay you specify will be used to shift the
reference clock edges before the measurement software associates each data edge with the closest clock
edge.

Related Topics
Effect of Nominal Clock Offset on Eye Diagrams

Effect of Nominal Clock Offset on Eye Diagrams
Nominal Clock Offset does not affect the eye diagrams directly. Data and clock timing relationship is
maintained ignoring the clock offset value. The clock offset still affects the eye diagram shape indirectly
through edge labeling and TIE measurement but not with alignment.
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Bit Config for Eye Height Measurements
This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition or
All bits) are included when measuring Eye Height.

Table 54: Bit Config for eye height
Item Description
Bit Type
All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.
Non-Transition Eye analysis only on non-transition bits.
xxx

Bit Config for Mask Hits Measurements
This configuration tab allows you to select the waveform bit type (All bits, Transition, Non-Transition) and
the mask to be used for Mask Hits measurements.
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Table 55: Bit Config for mask hits
Item Description
Bit Type
All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.
Non-Transition Eye analysis only on non-transition bits.
Mask
Browse Allows selection of the mask file. (If none of the supplied

mask files meets your need, you may create a custom mask
file with a text editor by using one of the existing mask
specification files as a template.)

xxx

Bit Config for Amplitude Measurements
This configuration tab is present only for High, Low and High–Low measurements. You can select the
waveform bit type (All Bits, Transition, Non-Transition) and method.

Table 56: Bit Config for amplitude measurements
Item Description
Bit Type
All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.
Non-Transition Eye analysis only on non-transition bits.
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Table 56: Bit Config for amplitude measurements (cont.)

Item Description
Measure the Center X% of the Bit Determines what percentage (1 to 100) of a unit interval,

centered in the middle of the bit, shall be included in each
measurement. The waveform points selected by the
percentage form a distribution (vertical histogram) from
which a single value is extracted, based on the Method
control.

Method Determines whether the Mean value or the Median of the
selected distribution is used for the measurement value for
each unit interval.

xxx

About RJ/DJ
This configuration tab allows you to select an appropriate decomposition method for jitter analysis. RJ/DJ
decomposition analysis breaks the timing jitter into various categories and uses the results to predict the
total jitter at a selected bit error rate (BER). The RJ/DJ tab is present for the RJ, DJ, PJ , DCD, DDJ, RJ–δδ,
DJ–δδ,TJ@BER and Width@BER measurements.

The DPOJET application offers two methods of RJ/DJ analysis:

A method based on spectral analysis that is appropriate for cyclically repeating data patterns.

A method that works for arbitrary data sequences.

Related Topics
RJDJ Analysis of Arbitrary Pattern

RJDJ Analysis of Repeating Pattern

RJ/DJ Analysis of Repeating Pattern
This method of RJ/DJ analysis uses a Fourier transform of the time-interval error signal to identify and
separate jitter components. It is described in the Fibre Channel - Methodologies for Jitter and Signal
Quality Specification (MJSQ) and has wide industry acceptance.

This method requires that the data signal be composed of a pattern of N bits that are repeated over and
over. The pattern length (N) must be known, although it is not necessary to know the specific bits that
make up the pattern.
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Table 57: RJ/DJ analysis of repeating options
Item Description
Data Signal Settings
Pattern Type Selects between repeating or arbitrary pattern analysis.
Pattern Length When the Pattern Type is set to Repeating, sets the pattern

length of the repetitive pattern data; use for spectrum
analysis RJ/DJ separation.

Total Jitter Component
BER= 1E-?
‡

Sets the Bit Error Rate exponent, thereby setting the
statistical level at which Total Jitter and Eye Opening are
reported.

Apply To All
Apply Applies the current settings to all the measurements having

RJDJ configuration tab.
xxx

‡ Only available for TJ@BER and Width@BER measurements.

RJ/DJ Analysis of Arbitrary Pattern
When the data pattern is not repeating, or is unknown, a second method of RJ/DJ analysis may be used. (It
may also be used if the pattern is repeating, and correlates well with the Spectral method in this case.) This
method assumes that the effects of Inter Symbol Interference (ISI) only last for a few bits. For example,
in a band-limited link where a string of ones follows a string of zeros, the signal may require three or
four bit periods to fully settle to the “high” state.

In this method, an analysis window with a width of K bits is slid along the waveform. For each position of
the window, the time interval error of the rightmost bit in the window is stored, along with the K-1 bit
pattern that preceded it. After the window has been slid across all positions, it is possible to calculate the
component of the jitter that is correlated with each observed K-1 bit pattern, by averaging together all the
observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length field allows you to select
how many bits are included in the sliding window. The window should include enough bits to encompass
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the impulse response of the system under test, usually 5 to 10 bits. A good practical test is to check
whether increasing the window length causes any appreciable change in the jitter results; if not, the
window length is effectively capturing all the ISI effects. The disadvantage of increasing the window
length is that it uses more memory and requires additional processing time.

The configuration menu also includes a field for selecting what population of each K-1 bit pattern must be
accumulated before the TIE associated with that pattern is considered accurate. Using a larger population
means that more observations are averaged together, so that the variance of the measurement is reduced.
Specifying a larger population has the disadvantage of requiring a longer measurement period before
results can be calculated and it may be necessary to sequence the instrument several times before enough
statistics are accumulated to provide results.

The arbitrary pattern approach for measuring jitter may not be appropriate if there are very-long-duration
memory effects in your data link. An example would be if there are impedance mismatch reflections that
arrive long enough after the initial edge to fall outside the analysis window.

Table 58: RJ/DJ analysis of arbitrary options
Item Description
Data Signal Settings
Pattern Type Selects between repeating or arbitrary pattern analysis.
Window Length When the Pattern Type is set to Arbitrary, sets the pattern window

length in terms of Unit Interval (UI) used for arbitrary pattern RJ/DJ
separation.

Population When the Pattern Type is set to Arbitrary, sets the minimum population
limit for each pattern to be qualified for arbitrary pattern RJ/DJ
separation.

Total Jitter Component †

BER= 1E-? Set the Bit Error Rate exponent, thereby setting the statistical level at
which Total Jitter and Eye Opening are reported.

Apply to All
Apply Applies the current RJ/DJ configuration settings to all the selected

measurement(s) having RJ/DJ configuration tab.
xxx

† Available only for TJ@BER and Width@BER measurements.
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Configuring Edges
This configuration tab allows you to select which waveform edge or edges the application will use to take
each measurement. Depending on the particular measurement, the tab will offer access to other options
and constraints that help guide the analysis. The application is able to automatically detect whether
a signal is clock or data, and will do so by default. This can be overridden by configuring the signal
type as Clock or Data.

The following configuration options apply to most measurements. Please see the subsequent sections for
Edge tabs corresponding to particular measurements.

Item Description
Signal Type
Clock Forces the signal type to be interpreted as a Clock.

Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
xxx
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Configuring Edges for Skew Measurements
This configuration tab is displayed for Skew measurements.

Item Description
From Edge - Defines which edge of the first waveform is used to take measurements.
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
To Edge - Defines which edge on the second waveform is used to take measurements.
Same as From Each measurement is defined by a pair of like edges (Rise

to Rise or Fall to Fall).
Opposite as From Each measurement is defined by a pair of opposing edges

(Rise to Fall or Fall to Rise).
xxx

Configuring Edges for Differential CrossOver Voltage Measurements
This configuration tab is displayed for Differential CrossOver Voltage measurements.
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Item Description
Main Edge - Defines which edges on the Source1 waveform are used to take the measurement.
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
xxx

Configuring Edges for Phase Noise Measurements
This configuration tab is displayed for Phase Noise measurements. Phase noise measurements are
undefined for data signals, so the signal is assumed to be a clock.

The Noise Integration Limits determine the portion of the phase noise spectrum that is integrated to
produce a single measurement per waveform acquisition.

Item Description
Active Edge-Defines which edge of the source waveform is used to take measurements.
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
Noise Integration Limits
Upper Frequency Sets the upper end of the noise integration frequency range.
Lower Frequency Sets the lower end of the noise integration frequency range.
xxx
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Configuring Edges for N-Period Measurements
This configuration tab is displayed for N–Period measurements.

Item Description
Signal Type
Clock Forces the signal to be interpreted as a Clock.

Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
N= Specifies number of cycles or unit interval in each N-period

group.
Edge Increment Specifies the temporal displacement in edges between

consecutive measurements.
xxx
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Configuring Edges for Two Source Measurements
This configuration tab is displayed for two source measurements: Setup and Hold.

Item Description
Clock Edge
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
Data Edge
Rise Only the rising edges of the signal are used.
Fall Only the falling edges of the signal are used.
Both Both the rising and falling edges of the signal are used.
xxx

Configuring Edges for CC-Period/Duty Cycle Measurements
This configuration tab is displayed for the CC–Period, +Duty Cycle and –Duty Cycle measurements.
These measurements are only defined for clock signals, and each measurement value is evaluated over one
full clock cycle.
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Item Description
Clock Edge
Rise Measurements are only initiated on the Rising edges of the

clock signal.
Fall Measurements are only initiated on the Falling edges of

the clock signal.
Both Measurements are initiated on both the Rising and falling

edges of the clock signal.
xxx

Configuring Edges for DCD Measurement
This configuration tab is displayed for DCD measurement.

Item Description
Signal Type
Clock Forces the signal type to Clock. Edges are selectable.
Data Forces the signal type to Data. Both rising and falling edges

are used.
Auto Automatically detects whether the signal is clock or data.
xxx

Configuring Edges for DDR tCH(avg) and DDR tCL(avg)
This configuration tab is displayed for both DDR tCH(avg) and DDR tCL(avg). Set the window size for
clock measurements. The measurement analysis is done on a sliding window of size 200 cycles with a step
increment of 1 cycle. You can set window size up to 1M, with a minimum of 200.
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Configuring Edges for DDR tERR(m-n)
This configuration tab is displayed for DDR tERR(m-n) measurement.

Item Description
Clock Edge
Rise Measurements are only initiated on the Rising edges of the

clock signal.
Fall Measurements are only initiated on the Falling edges of the

clock signal.
Number of Periods
Minimum Specify the minimum number of periods required to calculate

error across multiple consecutive cycles from tCK(avg).
Maximum Specify the maximum number of periods required to

calculate error across multiple consecutive cycles from
tCK(avg).

Window Size Measurement analysis is done on a window of size 200
cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.

xxx
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Configuring Edges for DDR tERR(n)
This configuration tab is displayed for DDR tERR(n) measurement.

Item Description
Clock Edge
Rise Measurements are initiated only on the Rising edges of the

clock signal.
Fall Measurements are initiated only on the Falling edges of the

clock signal.
Number of Periods Timing error (tERR) requires number of periods (n(per))

to calculate error across multiple consecutive cycles
from tCK(avg). You can configure n(per) up to 50, with a
resolution of 1.

Window Size Measurement analysis is done on a window of size 200
cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.

xxx

Configuring Edges for DDRtJIT(per), DDRtCK(avg) and DDRtJIT(duty)
This configuration tab is displayed for DDRtJIt(per), DDRtCK(avg) and DDRtJIT(duty).
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Item Description
Clock Edge
Rise Measurements are only initiated on the Rising edges of the

clock signal.
Fall Measurements are only initiated on the Falling edges of the

clock signal.
Window Size Measurement analysis is done on a window of size 200

cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.

xxx

Sequencing
Use the Control Panel (see page 60) to start or stop the sequence of processes the application and
oscilloscope use to acquire information from a waveform. The application then determines if the algorithm
for the selected measurement can be applied to the waveform information. Sequencing is the steps to
acquire waveform information, determine if the information is usable for the measurement, take the
measurement, and display the results (and plots if selected).

When you click Recalc, Single or Run, the corresponding button is changed to Stop and the Progress
indicator is displayed. For more details, refer to the Control Panel (see page 60).

The Progress Indicator displays the sequencer state. Select Stop, if you want to interrupt the sequence
before its completion.

For more details on progress bar status messages, refer to Progress Bar Status Messages (see page 167).
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Viewing Statistical Results
There are two ways to view the statistical results of measurements:

Summary

Details

The application displays results for the measurements for all acquisitions or for the current acquisition. By
default in the detail view, the limits will not be shown unless the limits are turned on.

Result statistics for most of the measurements show Population in terms of UI or transitions. According to
the JEDEC specification, the analysis for most of the clock measurements is done for a 200-cycle moving
window. However, for clock measurements such as DDRtCL(avg) and DDRtCH(avg), the population is
shown as tCK(avg) units. For Data Eye Width, the population number is shown as per acquisition.
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Table 59: Results menu options
Item Description

Displays an error message. You can click to view the
error log information in a text editor.

Displays a warning. You can click to view the error
log information in a text editor.

Description Lists the measurement name and the source.
Mean Lists a statistical mean value for the measurement data.
Std Dev Lists a statistical standard deviation value for the

measurement data.
Max Lists a statistical maximum value for the measurement data.
Min Lists a statistical minimum value for the measurement data.
p-p Lists a statistical peak-to-peak value for the measurement

data.
Population † Lists the total number of measurement data points used

for displaying the statistics.
Max-cc Lists the maximum cycle-to-cycle differences per acquisition.
Min-cc Lists the minimum cycle-to-cycle differences per acquisition.

Options

Click to view Save Current Stats, View Result Summary,
View Result Details, Export to Ref Waveform, View Plot
Summary, and Display Units-Absolute options.

Save Current Stats... Saves the current statistics as log information.
View Results Summary Displays the summary of the results for all acquisitions.
View Results Details Displays the detailed results specifying values for High

Limit, Low Limit, Pass/Fail, and current acquisition.
Export to Ref Waveform Exports time trend data of the selected measurement to

the reference memory.
Display Units- Absolute Default display unit is Absolute.

Click to view the result details.

xxx

† Jitter measurements such as RJ, DJ show population in terms of acquisitions.

NOTE. For Mask Hits measurement, only Mean, Max, Min and Population values are displayed in the
results table. On clicking , Hits in Segment 1, Segment 2 and Segment 3 are displayed. For Mask Hits
measurements, mean indicates the total number of hits for all acquisitions.

The results tab with limits turned on is as follows:
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Results with Error/Warning Notification

The results tab with error icon is as shown. You can click View Log to view the error log information
in a text editor.

The results tab with warning icon is as shown. You can click View Log to view the error log
information in a text editor.
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Export Results to Ref Waveform
Using this option, you can export the time trend plot of a measurement to any of the available reference
memory, Ref1-Ref4. Click on the right corner of the results panel to select the “Export Results to
Ref” option.

The Export Results to Ref waveform dialog box appears. It lists all the possible measurements that have
time trend result data (that is measurements for which time trend plot is enabled in the plot panel).

From the list of measurements, results of any one measurement can be exported to any one of the reference
memory (Ref1-Ref4) which is not used as source of any measurement.
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Before exporting results to a reference memory, the application checks for the following:

If any of the ref waveforms are already used as source for one of the measurement(s), then you cannot
export the results on those ref destinations. The application prevents exporting by displaying an
error message 2003 (see page 168).

If all the reference waveforms (Ref1-Ref4) are already used as sources for various measurements, the
“Export Results to Ref Waveform” is not displayed. Instead, an error message 2002 (see page 168) is
displayed.

If a ref destination is assigned to a measurement from the list which is not empty (that is, if the ref is
already defined and holds any other recalled waveform), a warning prompts you from overwriting the
existing definition of the selected destination ref.

In case of any error (2002 or 2004) or warning (Overwriting the existing definition) and you select
the response as “No”, the destination ref reverts to its previous value. For example, if the selected
measurement is Period-Ref1, and the destination ref assigned to the measurement is Ref3, and if you
try to change the destination from Ref3 to Ref1, an error message 2003 (see page 168) is displayed.
Ref3 is retained as the destination ref.

Time trend result export to the reference waveform for a measurement is independent of time trend
plot. Time trend result can be exported to ref without selecting/defining plots in the plots panel.

If “Export Results to Ref” is selected without any measurement selection, an error message 2005
(see page 168) is displayed.

If none of the selected measurements have time trend data, an error message 2007 (see page 168) is
displayed and “Export Results to Ref” dialog is not displayed.

If the selected measurements have no results (results are cleared or measurements are not run to
produce results), an error message 2006 (see page 168) is displayed and “Export Results to Ref”
dialog box is not displayed.

If the destination is none for all measurements, the results are not exported to ref on clicking OK. An
information/warning 2008 (see page 168) is displayed.

Results as Plots
The application can display the results as two-dimensional plots for easier analysis. Before or after you
take measurements, you can set up the Select Plots and Plots Configure menus to define up to four plots.
The last plot selected is displayed when the application completes sequencing (see page 116).

If you set up plots after sequencing, the application displays the plot based on the current measurement
and result.

NOTE. When taking measurements in the Run mode, you must stop the sequencing before you can use
some plot features.
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Table 60: Plot type definitions
Item Description
Time Trend Represents the measurement values versus the time

location.
Data Array Represents the measurement values versus the index

number of the measurement array.
Histogram 1 Represents measurements sorted by value as a distribution

of measurement values versus the number of times the
value occurred.

Spectrum Represents the frequency content computed using the FFT
of the Time Trend of the measurement data.

Transfer Represents the magnitude ratio of spectrum of time trend
data of two measurements from the following set: Clock
Period, Clock Frequency, Clock TIE, Clock PLL TIE, Data
Period, Data Frequency, Data TIE, Data PLL TIE.

Phase Noise 2 Represents the phase noise of a clock signal and is plotted
in the frequency domain for only Clock TIE measurements.

Eye Diagram 3 Represents data for the eye diagram based on the
recovered clock as the timing reference; used for mask
testing.

Waveform 4 Represents the acquired waveform. It is available for use
with eye diagram mask tests to locate bit errors in the
real-time waveform.

Bathtub 5 Represents the Bit Error Rate versus the unit interval for
measurements that include RJ/DJ analysis.

xxx

1 Available for all measurements except Mask Hits.
2 Available only for Phase Noise measurement.
3 Available only for all Eye and TIE measurements.
4 Available only for Mask Hits measurement.
5 Available for TJ@BER and Width@BER measurements.
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You can select the measurements from the displayed measurement list table on the left. The Plots for the
selected measurements are displayed in Select Plots. The plots which are not applicable for the selected
measurement are not available under Select Plots. You can select up to 4 plots.

Plot Usage
This section provides a description of various plots such as Histogram, Time Trend, Data Array, Spectrum,
Transfer, Phase Noise, Eye Diagram, Waveform, and Bathtub.

Histogram Plot Usage
A Histogram plot displays the results such that the horizontal axis represents the measurement values and
the vertical axis represents the number of times that each value occurred. Unlike most other plots, a
histogram plot can accumulate measurements over multiple acquisitions, up to a total population size of
2.1 billion.

Histograms are particularly useful in analyzing jitter. A histogram of the Time Interval Error (TIE)
represents the basis of jitter analysis using a histogram approach. In a histogram, Deterministic Jitter (DJ)
is bounded so that the horizontal span of the plot will remain relatively constant. Random Jitter (RJ) is
unbounded and amplitude (horizontal span) will continue to grow as more population is acquired. The TIE
histogram provides a good way to quickly and informally assess jitter.

Spectrum Plot Usage
A Spectrum plot is obtained from the Fourier Transform of measurement data from a Time Trend.
This plot is useful in identifying periodic frequency components that contribute to timing errors, such
as phase modulation.

When the signal has a repetitive data pattern, an analysis of the TIE Spectrum of the signal can be used to
separate Random Jitter (RJ) from Deterministic Jitter (DJ) as well as to separate subcomponents such as
Periodic Jitter (PJ), ISI and DCD. Spectral components (spikes ) that do not correlate with the frequencies
contained in the data pattern can be a clue that external deterministic noise sources are coupling into a
system.

Data Array Plot Usage
A Data Array plot shows measurement values versus measurement index, where the indexes are always
equally spaced along the horizontal axis. In contrast, the measurement values on a Time Trend plot are
not equally spaced along the horizontal time axis.

Time Trend Plot Usage
A Time Trend plot is a waveform trace of a measurement versus time. Each measurement value is placed
precisely at the time at which the measurement took place. Measurements that involve two timing points
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are placed at the midpoint between those two time. For example, a Risetime measurement is placed
halfway between the low threshold crossing and the high threshold crossing.

A Time Trend plot is useful, for example, in determining if the embedded clock in a serial bit stream is
modulated outside the capabilities of your receiver to recover the clock. If the TIE time trend plot starts
to take an unexpected periodic shape, then this could indicate that you have uncorrelated periodic jitter
from crosstalk or from power supply coupling.

Bathtub Plot Usage
A Bathtub curve is the industry standard way of viewing the statistical Jitter Eye Opening. A Bathtub
curve represents eye opening as a function of the BER (Bit Error Ratio). Most serial standards call for
Total Jitter to be measured at a BER of 10-12. The eye opening represented by the Bathtub Curve is what is
left of the unit interval after the total jitter measurement is subtracted.

The Jitter Eye opening and the Total Jitter have the following relationship:

Total Jitter + Jitter Eye Opening = 1 Unit Interval

The Bathtub Curve plot shows the eye opening and total jitter values as functions of the BER level. The
plot is obtained from jitter analysis that performs RJ/DJ separation.

Phase Noise Plot Usage
A Phase Noise plot shows a frequency domain view of the jitter noise on a waveform normalized in
an industry-standard way. The vertical axis is logarithmic and uses the units of dBc/Hz, which means
“decibels (relative to the carrier) per Hertz”. The horizontal axis is logarithmic with units.
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Transfer Function Plot Usage
A Transfer Function plot shows the magnitude ratio of the frequency spectrums of two measurements
on logarithmic axes. This can be a useful way to depict the response of a system to stimuli at various
frequencies, or to identify poles and zeros in a system characteristic equation. Suppose that x(t) is a
jitter measurement at the input of a device, and y(t) is a corresponding jitter measurement at the output
of the device. The Transfer Function plot can be used to show the following function, where X(f) is
the Fourier Transform of x(t):

The horizontal axis of the Transfer Function plot goes up to the Nyquist frequency of X or Y, whichever is
lower. These plots work best if averaged across multiple acquisitions to reduce the effects of measurement
noise.

Waveform Plot Usage
The waveform plot is only applicable to the Mask Hits measurement. It depicts a copy of the source
waveform, with all mask violations denoted in a highlight color. These are the same violations that
appear on the Mask Hits eye diagram, but the waveform plot allows them to be seen in the context of a
continuous-time waveform.

Eye Diagram Plot Usage
An eye diagram is a plot of the voltage versus time for a serial bit stream, with the time axis “wrapped”
so that all unit intervals are superimposed on top of each other in a time-aligned fashion. Because the
resulting plot has many waveforms overlaid, color grading is used to separate areas with many coincident
waveforms from areas that are only rarely crossed.

If there is an area free of waveforms in the center of the diagram, the eye is said to be “open”,
and a comparator circuit repetitively sampling the waveform at this point in the unit interval could
unambiguously separate the two logic states. For experienced signal integrity engineers, the eye diagram
allows many common problems to be recognized instantly.

Selecting Plots
Before or after you take measurements, you can set up plots for the selected measurements by following
these steps:
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1. Click Plots in the navigation panel (see page 59) to view the Select Plot window. The currently active
measurements and source(s) are displayed in the table on the left (measurement table).

2. Click any of the plot icons that are available for the selected measurement. The corresponding plot
type and measurement are then added to a table on the right (plot table).

3. Add another plot for the current measurement, or select a different measurement and choose from its
plot types. A maximum of four plots can be selected at any given time.

Table 61: Plot selections
Item Description
Plots Lists only the plots which are available for the selected

measurement. Click a plot icon to add the plot type to the
table on the right.

Clear Selected Clears the selected plot from the plot table.
Clear All Clears all plots from the plot table.
Configure Allows you to adjust display options for the selected plot.
xxx

About Configuring Plots
Most plot types (except Data Array and Waveform) have display options that can be adjusted for each
instance of the selected plot.
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The steps to configure a plot are:

1. Select a plot instance by clicking on a row from plot table on the right.

2. Click Configure to display a pop-up window with the available configuration options.

3. Adjust the configuration options and click OK to accept the changes and close the window.

4. Click Show Plots in the control panel to view the configured plot.

NOTE. The Show Plots icon appears in the control panel (see page 60)only when one or more plots
are defined.

Related Topics
Configuring a Time Trend

Configuring a Histogram Plot

Configuring a Spectrum Plot

Configuring a Transfer Plot

Configuring a Phase Noise Plot

Configuring an Eye Diagram for Mask Hits

Configuring an Eye Diagram Plot for Eye Height

Configuring a Bathtub Plot

Configuring a Bathtub Plot
Select a Bathtub plot in the table on the right and click Configure to configure the plot.
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Item Description
Vertical Scale
Log Selects logarithmic scaling for the vertical axis.
Linear Selects linear scaling for the vertical axis.
Minimum Displayed BER=1E? Sets the lower axis limit for logarithmic plots to this value

(expressed as the negative of a base-10 exponent).
OK Accepts the changes and closes the window.
xxx

Configuring a Spectrum Plot
Select a Spectrum plot in the table on the right to and click Configure to configure the plot.

Item Description
Vertical Scale
Log Selects logarithmic scaling for the vertical axis.
Linear Selects linear scaling for the vertical axis.
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Item Description
Base Sets the lower axis limit for logarithmic plots to this value

(expressed as a base-10 exponent). Available only when
the vertical scale is log.

Horizontal Scale
Log Selects logarithmic scaling for the horizontal axis.
Linear Selects linear scaling for the horizontal axis.
Mode Selects whether the plot shows only the most recent

spectrum, the uniform average of all spectrums since
the last time the results were cleared, or the peak of the
envelope of all spectrums since the last time the results
were cleared.
Normal- Shows magnitude values from the most recent
acquisition.
Average - Averages the magnitude values at each
frequency.
Peak Hold - Keeps the maximum value at each frequency.

OK Accepts the changes and closes the window.
xxx

Configuring a Time Trend
Select a Time Trend plot in the table on the right and click Configure to configure the plot.

Item Description
Vector Connects measurement points with straight lines to form a

continuous waveform.
Bar Places a vertical bar at the horizontal position of each

measurement with a height (positive or negative) that
represents the value of that measurement; a horizontal
baseline represents the mean value of the Time Trend.

OK Accepts the changes and closes the window.
xxx
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Configuring a Histogram Plot
Select a Histogram plot in the table on the right and click Configure to configure the plot.

Item Description
Vertical Scale
Linear Selects linear scaling for the vertical axis.
Log Selects logarithmic scaling for the vertical axis.
Number of Bins
Resolution Defines resolution by the number of bins into which Span is

divided: 25, 50, 100, 250, or 500.
Horizontal Scale
Auto Scale Causes the horizontal scale of the histogram to be adjusted

automatically based on the accumulated data points.
If subsequently acquired data falls outside the current
horizontal scale, histogram bins are consolidated so that the
number of bins is preserved and the horizontal scale allows
all data to be plotted. When checked, disables the “Center”
and “Span” numerical inputs.

Center Manually sets the value for the horizontal center of the
Histogram, for subsequent plot updates.

Span Manually sets the value for the total horizontal range of the
Histogram, for subsequent plot updates.

Autoset Uses the results of the latest acquisition to determine
the logical values for the Center and Span options (if the
population of the measurement is three or more).

OK Accepts the changes and closes the window.
xxx
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Configuring a Transfer Plot
Select a Transfer Function plot in the table on the right and click Configure to configure the plot.

Item Description
Definition
Numerator Measurement for which the magnitude spectrum is used as

a reference.
Denominator Measurement for which the magnitude spectrum is used

to normalize the numerator.
Vertical Scale
Linear Selects linear scaling for the vertical axis.
Log Selects logarithmic scaling for the vertical axis (default).
Horizontal Scale
Linear Selects linear scaling for the vertical axis.
Log Selects logarithmic scaling for the horizontal axis (default).
Mode Selects whether the plot shows only the most recent

spectrum, or the uniform average of all spectrums since the
last time the results were cleared (default).
Normal - updates the plot with current values.
Average - averages the magnitude values at each
frequency.

OK Accepts the changes and closes the window.
xxx
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Configuring a Phase Noise Plot
Select a Phase Noise plot in the table on the right and click Configure to configure the plot.

Item Description
Vertical Position
Baseline Sets the lower axis limit for logarithmic plots to this value.
OK Accepts the changes and closes the window.
xxx

Configuring an Eye Diagram Plot for Eye Height
Select an Eye Diagram plot (for all eye measurements other than Mask Hits) in the table on the right and
click Configure to configure the plot.

Item Description
Mask
On Enables display and mask testing.
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Item Description
Off Disables display and mask testing.
Browse Select a mask file to import from the C:\TekApplica-

tions\DPOJET\Masks directory.
Horizontal Scale
Auto Scale When checked, causes the horizontal scale to be adjusted

automatically.
Resolution Manually sets the horizontal resolution, when Auto Scale

is unchecked.
Superimpose Reference Clock Eye (if available) When checked, superimposes DQS eye onto the data eye

diagram.
Ref Clock Alignment Determines how an eye diagram is positioned on the plot.

The position is determined by the eye reference point,
which is the location of overlapping recovered or explicit
clock edge locations. Typically, the eye is located so that
waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is
centered on the plot facilitating cursor measurements and
mask testing.

Auto Determines the alignment property automatically. Eye
diagram is aligned automatically. Auto is typically equivalent
to Left.

Center Eye reference point is centered on the plot. Center
alignment is appropriate for DDR Write bursts or other
signals with explicit reference clock where the clock and
data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so
that eye opening is centered. Left alignment is appropriate
for DDR Read bursts and signals with recovered clock or
explicit clock where the clock and data signals are in phase.

OK Accepts the changes and closes the window.
xxx

Related Topics
Effect of Nominal Clock Offset on Eye Diagrams

NOTE. If there is unwanted skew between the data and explicit clock signals, the channels must be properly
deskewed. Please refer to your oscilloscope online help on how to deskew the channels.

Configuring an Eye Diagram for Mask Hits
An eye diagram plot is activated whenever a mask hits measurement is selected. Click Configure in
the plots panel to configure the plot.
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Item Description
Mask Shows which mask has been selected (For the Mask Hits

measurement, the mask selection is performed as part of
measurement configuration rather than plot configuration).

Horizontal Scale
Auto Scale When checked, causes the horizontal scale to be adjusted

automatically.
Resolution Manually sets the horizontal resolution, when Auto Scale

is unchecked.
Superimpose Reference Clock Eye (if available) When checked, superimposes DQS eye onto the data eye

diagram.
Ref Clock Alignment Determines how an eye diagram is positioned on the plot.

The position is determined by the eye reference point,
which is the location of overlapping recovered or explicit
clock edge locations. Typically, the eye is located so that
waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is
centered on the plot facilitating cursor measurements and
mask testing.

Auto Determines the alignment property automatically. Eye
diagram is aligned automatically. Auto is typically equivalent
to Left.

Center Eye reference point is centered on the plot. Center
alignment is appropriate for DDR Write bursts or other
signals with explicit reference clock where the clock and
data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so
that eye opening is centered. Left alignment is appropriate
for DDR Read bursts and signals with recovered clock or
explicit clock where the clock and data signals are in phase.

OK Accepts the changes and closes the window.
xxx
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Related Topics
Effect of Nominal Clock Offset on Eye Diagrams

NOTE. If there is unwanted skew between the data and explicit clock signals, the channels must be properly
deskewed. Please refer to your oscilloscope online help on how to deskew the channels.

About Viewing Plots
You can create and configure up to four plots. If you already have measurement results, creating a plot will
cause it to be displayed immediately. If there are no current results, the plot will be created when you
sequence the application and results have been calculated. The Show Plots icon appears in the control
panel whenever at least one plot is defined. The Show Plots icon appears in the control panel
whenever at least one plot is defined. By default, all defined plots windows are grouped in a single window
on the upper half of the display, but the window can be moved, resized, or dragged to a second monitor.
The application includes tools to help you select which plots to view, to size and position the plot windows,
to save plot information, to use the zoom function, and to use the cursors functions.

If your windows desktop is extended to a second monitor, you can drag the plots window to the second
monitor.

NOTE. When sequencing is complete, the plot window displays with the last plot selected. The plot window
also updates whenever you reconfigure a plot.

Using a Second Monitor to View Plots
If your oscilloscope setup includes a second monitor that extends the Windows desktop, you can select and
drag the title bar of the plot window to position it in the second monitor. This allows you to simultaneously
display a waveform on the oscilloscope, measurement results, and the plot for easy viewing.

Toolbar Functions in Plot Windows
The Plot Toolbar window includes the following functions:

DPOJET Jitter and Eye Diagram Analysis Tools 135



Operating Basics Moving and Resizing plots

Table 62: Plot toolbar functions
Icon Functions

Export Figure.

Print Figure.

Zoom and Pan.

Vertical and Horizontal Cursor controls.

Moving and Resizing Plots.

Plot properties.

Plot Summary Views.

Full view of plots 1 to 4.

xxx

Moving and Resizing plots
You can move and resize plot windows the same way you would move and resize any window.

You can change the plot size to the whole display of the oscilloscope, or to half the display. When
viewing a plot in half the display, you can position the plot to the top or bottom. The tools also return
the plot to the original size. To position a plot quickly on the oscilloscope, select one of the following
tools in the plot window:

enlarges the plot to fill the entire display.

positions the plot to the top.

positions the plot to the bottom.

always keep the plot on top layer.

Using Zoom in a Plot
Once you have created a plot, you can use the Zoom tools to examine the data at various scales.

TIP. If you prefer to use the zoom functions in a plot window with your finger, you can activate the Touch
Screen on the oscilloscope.
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Table 63: Zoom functions in a plot
Item Description

Zoom in (Horizontal and Vertical) – Expands part of the plot;
the data appears in more detail.
Zoom out – Contracts part of the plot; the data appears in
less detail.
Zoom in (Horizontal only) – Expands the horizontal axis only
and retains the vertical axis.
Resets the zoom to 100%.

xxx

Changing the Scale of Data in a Plot (Zoom)
To change the scale of the data in a Plot Details window, select one of the following plot zoom tools:

zooms in to expand the scale.

zooms out to contract the scale.

zooms in to expand the horizontal axis only.

moves the plot anywhere within the scale.

zooms in to restore the entire waveform data.

When you select the tool, you can use a select-drag-release action to expand part of the waveform
(zoom in) by an arbitrary amount on both axes. After you select (touch with a finger or click with the
mouse) and begin dragging, a bounding box shows what part of the waveform will be expanded upon
release.

Select any part of the plot to expand the data by a factor of two (2X) equally on both axes. Double
selecting expands the data to the maximum factor.

To contract an expanded part of the data (zoom out), select anywhere on the data. The view contracts to
the values that existed before the most recent expansion of the data. Selecting multiple times will restore
successively earlier views. To expand the scale of the horizontal axis only by a factor of two (2X), click a
part of the waveform. The plot retains the scale of the vertical axis.

TIP. Select to see the entire available waveform.

Using Cursors in a Plot
Cursors allow you to view numerical values associated with a plot based on cursor locations. There are
two types of cursors:
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Horizontal cursors

Vertical cursors

Table 64: Cursor functions in a plot
Item Description

Displays the vertical coordinate where each cursor touches
the plot and the difference (Δ) between the cursors.
Displays the horizontal coordinate where each cursor
touches the plot and the difference (Δ) between the cursors.
Brings the cursors into the visible part of the plot.

Displays the plot properties.

xxx

Cursors in a Plot
You can use cursors to read the coordinate where each cursor (line) touches the plot and also view the
difference (Δ) between the two cursors. The steps to use cursors in a plot details window are:

1. Select any of the following cursors:

to use horizontal cursors.

to use vertical cursors.

to bring cursors into the visible plot.

2. Select and drag either cursor to move the cursor to the desired part of the plot. The cursor readout
changes to reflect the cursor position.

NOTE. You can drag cursors only when the Zoom functions are disabled.

TIP. If you prefer to move the cursors in the plot window with your finger, you can activate the touch
screen on the oscilloscope.

Exporting Plot Files

You can export plot image in Plot Toolbar window. Click to save the contents of the plot window in
any of the format as a MATLAB figure format (.fig), .bmp, .jpg, .png, .emf, .tif, .mat and .csv.

The steps to export a plot file are:

1. Set up the plot window.

2. Select to save the plot as a figure.
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3. Select the directory and enter a file name.

4. Click Save. The application saves the file in C:\TekApplications\DPOJET\images.

Printing Plots
The steps to print a plot are:

1. Verify that the printer is configured.

2. Set up the plot window with zoom, cursors, or grid functions.

3. Click icon in the plot details/summary window. The Print Preview dialog is displayed.

4. Click to set up the printing options and print a plot file.

NOTE. You can customize the print layout using the MATLAB page setup options. The DPOJET online
help does not provide information on MATLAB page setup. For more information, refer to the MATLAB
documentation.

About Reports
You can use the Reports to configure and generate a compliance report to view later or to share with others.
You can also access reports using Analyze > Jitter and Eye Analysis > Reports. You can select the
option which you want to display in the report as shown in the following table:

Table 65: Report generation options
Item Description
Content Options
Include setup configuration Select/Clear the option to include/exclude the setup

information like DPOJET version, oscilloscope version, and
status in the generated report.
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Table 65: Report generation options (cont.)

Item Description
Include complete application configuration Select/Clear the option to include/exclude the complete

configuration details in the generated report.
Include summary pass/fail results Select/Clear the option to include/exclude the pass/fail

status in the generated report.
Included detailed results Select/Clear the option to include/exclude the measurement

result details in the generated report.
Include plot images Select/Clear the option to include/exclude the plot images

like measurement plots and oscilloscope waveform in the
generated report.

Save Options
Auto increment report name if duplicate Select/Clear the option to autoincrement the report name

if its already existed. The autogenerated report is of
YYMMDD_HHMMSS_ savedfile.mht format.

View report after generating Select this option to view the report after generation.
Report Name Lists the directory path where the last generated report is

stored.
Save Saves the changes in the default report directory.

Manipulates the report name based on “Auto increment
report name if duplicate” option.

Save As Displays the browser where you specify the directory to
save the generated report. You can also edit the report
name in the Save As browser. The generated report is
saved in C:\TekApplications\DPOJET\Reports.

xxx
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Reports Format
The generated reports are in .mht format and includes the following configured set of information:

Setup Configuration such as DPOJET version, oscilloscope version, and the Pass/Fail status.

Measurement Configuration such as measurement name, source and other configuration parameters.

Source Reference Levels displays the reference voltage levels for the high, mid, and low thresholds
for the rising edge and for the falling edge of all sources, and the hysteresis.

Miscellaneous Settings such as Gating, Qualify and Population status.

Pass/Fail Summary indicating the Pass/Fail status for the selected measurements.

Measurement Results with statistics.

Plot Images includes both selected plots and oscilloscope waveforms.
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Introduction to the Tutorial
This tutorial teaches how to set up the application, take measurements, and view results as plots or statistics.

Before you begin the tutorial, perform the following tasks:

Set up the oscilloscope.

Start the application.

Recall the tutorial waveform.

NOTE. The screen captures shown in this section are from a DPO7254 oscilloscope.

Setting Up the Oscilloscope
The steps to set up the oscilloscope are:

1. Click File > Recall Default Setup in the oscilloscope menu bar to recall the default settings.

2. Press the individual CH1, CH2, CH3, and CH4 buttons as needed to add or remove active waveforms
from the display.

Starting the Application
Click Analyze > Jitter and Eye Analysis > Select to open the application.

Waveform Files
The application provides the following tutorial waveforms:

Rt-EyeTutorial.wfm

ckminus_50gs_18g_20m_pat1.wfm

ckplus_50gs_18g_20m_pat1.wfm

dplus_50gs_18g_20m_pat1.wfm

dminus_50gs_18g_20m_pat1.wfm

The waveform files are found at C:\TekApplications\DPOJET\Examples.
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Recalling a Waveform File
To recall a waveform file, follow these steps:

1. Click File > Recall in the oscilloscope menu bar to display the Recall dialog box.

NOTE. If the application is in button mode, select the Recall button to recall the tutorial waveform.

2. ClickWaveform icon in the left of the Recall dialog box.

3. Select Ref1, Ref2, Ref3, or Ref4 as the Destination option.

4. Browse to select the waveform. Use the keypad to edit the waveform file name.

5. Click Recall. The oscilloscope recalls and activates the Reference Waveform control window.

6. Click On to display the waveform.

7. Click to return to the application. Alternatively, DPOJET can also be accessed from Analyze
> Jitter and Eye Analysis > Select.

In the Summary tutorial, the tutorial waveforms are recalled as Math waveforms using the following setup:

dplus_50gs_18g_20m_pat1.wfm is recalled as Ref1 and dminus_50gs_18g_20m_pat1.wfm as Ref2.

NOTE. Using Math Setup ( Select Math > Math Setup in the menu bar to view the Math Setup dialog.
For more details, refer to the “Math Equation Editor: Controls in your oscilloscope online help), set
Math1=Ref1–Ref2 (Data signals)..

ckplus_50gs_18g_20m_pat1.wfm is recalled as Ref3 and ckminus_50gs_18g_20m_pat1.wfm as Ref4.

NOTE. Using Math Setup, set Math2 =Ref3–Ref4 (Clock Signals).

Taking a Period Measurement
In this lesson, you will learn how to take a period measurement and view the results. You can also learn the
following tasks:

Select a measurement and a source
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Configure measurement

Take measurements

View results as plots or statistics

View reports

Return to the application

Setting up a Period Measurement
Follow these steps to take a period measurement:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

2. To view the DPOJET application, select Analyze > Jitter and Eye Analysis > Select.

3. Go to Select in the left navigation panel. Click Period in the Measurements area. The application
shows the measurement and source selection on the right of the display. The current measurement
selection is displayed as Period1. The subsequent selections will be Period2, Period3 and so on. In
this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for Period1. New
measurements initially use the same source as the earlier measurement, or the most recently used
source.

4. Click or the row which lists the selected measurement to configure the source. Select Ref1 for
Period1. For more details, refer to Source Setup (see page 61).

5. Click Ref Levels Setup. The Configure Reflevel menu appears. For more details, refer to Ref
Levels (see page 69).

6. Click Configure in the left navigation panel of the main application window to view the configure
tabs. For more details, refer to About Configuring a Measurement (see page 75).

7. Click Plots to view the available plots for the selected measurement . Select Time Trend for Period.
For more details, refer to Configuring Time Trend (see page 129).

8. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The plots are displayed as shown:
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NOTE. You can log result statistics (see page 36), measurement data points (see page 37) to a .csv file and
worst case waveforms (see page 45) to a .wfm file.

Taking a TIE Measurement
For jitter application, we use PLL TIE measurement. The steps to take a TIE measurement are:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

2. Go to Select in the left navigational panel. Click Jitter tab to select TIE in the Measurements area.
The application shows the measurement and source selection on the right of the display. In this
example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for TIE1.

3. Click or the row which lists the selected measurement to configure the source. Select Ref1 for
TIE1. For more details, refer to Source Setup (see page 61).
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4. Click Ref Levels Setup in the source configuration dialog. The Configure Reflevel menu appears. For
more details, refer to Ref Levels (see page 69).

5. Click Configure in the left navigation panel to view the configure tabs. For more details, refer to
Configuring Measurements (see page 75).

6. Click Plots to view the available plots for the selected measurement. Select Time Trend and Spectrum
plots for TIE measurement. For more details, refer to Configure Plots (see page 126).

7. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The plots are displayed as follows:

NOTE. You can log result statistics (see page 36), measurement data points (see page 37) to a .csv file and
worst case waveforms (see page 45) to a .wfm file.

Taking an Eye Height and Width Measurement
For signal integrity application, we use Eye Height and Width measurements.

1. Select Analyze > Jitter and Eye Analysis > Select to run the DPOJET application.

2. Go to Select in the left navigation panel. Click Eye tab to select Height and Width measurement. In
this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for Height1 and Width1.
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3. Select Ref1 as source for Height and Width measurements. For more details, refer to Source Setup
(see page 61).

4. Click Plots to view the available plots for the selected measurement. Select Eye Diagram for Height
measurement.

5. Select Eye diagram Plot type and click Configure to turn on the Mask in the Configure Eye Diagram
for Eye Height dialog. For more details, refer to the Configuring Eye Diagram Plot for Eye Height
(see page 132).

6. Select Histogram plot for Width measurement.

7. Click Single to run the application. When complete, the result statistics is shown in the results tab.

8. The Plot summary window is displayed as shown in the following figure:

NOTE. You can log result statistics (see page 36), measurement data points (see page 37) to a .csv file and
worst case waveforms (see page 45) to a .wfm file.
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Summary Tutorial
For a summary tutorial, we use the following example:

Case 1: Period measurement with Low pass filters to show SSC profile:

1. Select Analyze > Jitter and Eye Analysis > Select to run the DPOJET application. For more details
on waveforms recalled on Math1, Refer Recalling a Waveform File (see page 144).

2. Select Period measurement on Math1.

3. Click Configure. In the Filters configuration tab, select 2nd order low pass filter and specify the
cut-off frequency as 33kHz. (F2= Fbaud/1667).

4. Go to Plots. Select Time Trend for Period measurement.

5. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The Time Trend plot is as shown.

Case 2: A pair of TIE for showing jitter integration caused by SSC and the effect of a high pass filter
on SSC spectrum plots:

1. Click Jitter to select TIE measurement.

2. Select Math1 (see page 144) as the source for both TIE1 and TIE2.
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3. Click Configure. Do the following settings for TIE1 and TIE2 in the Filters configuration tab:

Select “No Filter” for TIE1.

Select 2nd order High Pass filter for TIE2. In this example, we have set F1 cut-off frequency
as 1 GHz.

4. Go to Plots. Select Time Trend for both TIE1 and TIE2.

5. Select Spectrum plot for both TIE1 and TIE2.

6. Click Single to run the application. When complete, the result statistics is shown in the results tab.

7. A Plot Summary window shows Time Trend plots for TIE1, TIE2 and Spectrum plots for TIE1, TIE2.

NOTE. You can log results as statistics (see page 36), measurement data points (see page 37) to a .csv file
and worst case waveforms (see page 45) to a .wfm file.
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Stopping the Tutorial
If you need more than one session to complete the tutorial lessons, you can stop the tutorial and return
to it later.

To save the application setup , refer to Saving a Setup File (see page 15) . To exit the DPOJET application,

click present at the right corner of the application.

Returning to the Tutorial
To return to the tutorial setup, you can start the application and then recall the saved setup. To recall the
application setup, refer to Recalling a Saved Setup File (see page 15).
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About Parameters
This section describes the DPOJET application parameters and includes the menu default settings. Refer to
the user manual for your oscilloscope for operating details of other controls, such as front-panel buttons.

The parameter tables list the selections or range of values available for each option, the incremental unit of
numeric values, and the default selection or value.

Refer to the GPIB (see page 205) section for a complete list of the GPIB Command Syntax. The topics
include a complete list of the GPIB commands along with the arguments, variables, and variable values
that correspond to the DPOJET parameters.

Measurement Select Parameters
The Measurement Select includes the following measurement categories:

Period/Freq: Frequency, Period, CC–Period , N–Period, Pos Width, Neg Width, +Duty Cycle, –Duty
Cycle, +CC–Duty, and –CC–Duty.

Jitter: TIE, RJ, DJ, PJ, DDJ, DCD, RJ–δδ, DJ–δδ, TJ@BER, Jitter Summary, and Phase Noise.

Time: Rise Time, Fall Time, High Time, Low Time, Setup, Hold, and Skew.

Eye: Height, Width, Mask Hits, and Width@BER.

Ampl: High, Low, Common Mode, High–Low, T/nT Ratio, and V–Diff –Xovr .

More: DDR Setup–SE, DDR Setup–Diff, DDR Hold–SE, DDR Hold–Diff, DDR tCK(avg), DDR
tCH(avg), DDR tCL(avg), DDR tERR(n), DDR tERR(m–n), DDR tJIT(duty) and DDR tJIT(per).

You can set the Source option as any of the following waveforms: Ch1, Ch2, Ch3, Ch4, Ref1, Ref2, Ref3,
Ref4, Math1, Math2, Math3, or Math4.

Table 66: Source parameters
Option Parameters Default
Source1 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch1
Source2 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch2
xxx

Autoset Parameters
The Configure Source Autoset includes the following command buttons:

Vert Scale

Horiz Res
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Vert & Horiz

Undo

Ref Level Menu Parameters
The Configure Ref Level menu parameters includes the following command buttons:

Autoset

Setup

Table 67: Source autoset ref level parameters
Option Parameters Default setting
Source Ch1-Ch4, Ref1-Ref4, Math1-Math4
Autoset Set, Clear Set
Rise High –20 V to 20 V 1 V
Rise Mid –20 V to 20 V 0 V
Rise Low –20 V to 20 V –1 V
Fall High –20 V to 20 V 1 V
Fall Mid –20 V to 20 V 0 V
Fall Low –20 V to 20 V –1 V
Hysteresis 0 to 10 V 30 mV
xxx
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Autoset Ref Levels Parameters

Table 68: Autoset ref levels parameters
Option Parameters Default setting
Base Top Method Min-Max

Low-High Histogram (Full
Waveform)

Low- High Histogram (Center of
Eye)

Auto

Auto

Rise High 1 to 99% 90%
Rise Mid 1 to 99% 50%
Rise Low 1 to 99% 10%
Fall High 1 to 99% 90%
Fall Mid 1 to 99% 50%
Fall Low 1 to 99% 10%
Hysteresis 0 to 50% 3%
xxx

Preferences Parameters
The Analyze > Jitter and Eye Analysis > Preferences includes the following tabs:

General

Measurement

Path Defaults

Table 69: Preferences parameters
Option Parameters Default setting
General
Display Units Seconds, Unit Intervals Seconds
Default Image Type PNG, JPG, BMP PNG
Notifier Duration 2 to 20 s 5 s
Measurement
Limit Rise/Fall measurements to
transition bits only

Set, Clear

Enable high-performance eye
rendering

Set, Clear Set

Dual Dirac Model Fibre Channel,
PCI/FB-DIMM

PCI/FB-DIMM
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Table 69: Preferences parameters (cont.)

Option Parameters Default setting
Waveform Interpolation Type Linear, Sin(x)/x Linear
Path Defaults
Default image export directory Browser C:\TekApplications\DPOJET\Images

Default logging export directory Browser C:\TekApplications\DPOJET\Logs

Default report output directory Browser C:\TekApplications\DPOJET\Reports

xxx

Deskew Parameters
The Analyze > Jitter and Eye Analysis > Deskew includes the following command buttons:

Perform Deskew

Summary

Table 70: Deskew parameters
Option Parameters Default setting
Reference Channel
Source Ch1, Ch2, Ch3, Ch4 Ch1
Mid –20 V to 20 V 0 V
Hysteresis 0 to 10 V 30 mV
Channel to be Deskewed
Source Ch1, Ch2, Ch3, Ch4 Ch2
Mid –20 V to 20 V 0 V
Hysteresis 0 to 10 V 30 mV
Edges Rise, Fall, Both Rise
Deskew Range
Max Value –24.9 ns to 25 ns 1 ns
Min Value –25.0 ns to 24.9 ns –1 ns
xxx

Data Logging Parameters
The application includes the following Log menus:

Statistics

Measurement

Worst Case
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Table 71: Logging parameters
Option Parameters Default
Statistics
Select Target Measurements Set, Clear Set
Log Statistics Off, On Off
File Name Browser C:\TekApplications\DPO-

JET\Logs\Statistics

Measurement
Select Target Measurements Set, Clear Set
Log Measurements Off, On Off
Folder Browser C:\TekApplications\DPO-

JET\Logs\Measurements

Worst Case
Select Target Measurements Set, Clear Set
Log Worst Case Waveforms Off, On Off
Folder Browser C:\TekApplications\DPO-

JET\Logs\Waveforms

xxx

Control Panel Parameters
The Control Panel menu includes the following command buttons:

Clear

Recalc

Single

Run

Show Plots

NOTE. Show Plots appears in the control panel only when one or more plots are selected.

Bit Config Parameters
The Eye configure menu has the following parameters

Option Parameters Default setting
Bit Type All Bits, Transition, Non-Transition All Bits
Mask * Browser C:\TekApplications\DPO-

JET\Masks
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Option Parameters Default setting
Measure the Center of the Bit † 1 to 100% 1%
Method † Mean, Mode Mean
xxx

* The Mask selector is available only for Mask Hits measurement.
† Available only for High, Low and High–Low measurements.

Edges Parameters
The Edges configure menu depends on the measurement selected.

Edges-Two Source Parameters

Option Parameters Default setting
Clock Edge Rise, Fall, Both Rise
Data Edge Rise, Fall, Both Both
xxx

Edges-Phase Noise Parameters

Option Parameters Default setting
Active Edge Rise, Fall, Both Rise
Noise Integration Limits
Upper Frequency 0 to 1 T 1 MHz
Lower Frequency 0 to 1 T 0 Hz
xxx

Edges-CrossOver Parameters

Option Parameters Default setting
Main Edge Rise, Fall, Both Both
xxx

Edges-TIE Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto
Clock Edge Rise, Fall, Both Rise
xxx

Edges-Skew Parameters

Option Parameters Default setting
From Edge Rise, Fall, Both Both
To Edge Same as From, Opposite as From Same as From
xxx
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Edges-N-Period Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto
Clock Edge Rise, Fall, Both Rise
N= 1 to 1M 6
Edge Increment 1, 10 K 1
xxx

Edges-DCD Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto
xxx

Edges-DDR tCH(avg) and DDR tCL(avg)

Option Parameters Default setting
Window Size 200 to 1M 200
xxx

Edges-DDR tERR(m-n)

Option Parameters Default setting
Clock Edge Rise, Fall Rise
Number of Periods
Maximum 6 to 50 The value varies for different DDR

generations. For example: For DDR
(6–10) measurement, the maximum
default is 10.

Minimum 2 to 50 The value varies for each DDR
generation. For example: For DDR
(6–10) measurement, the minimum
default is 6.

Window Size 200 to 1M 200
xxx

Edges-DDR tERR(n)

Option Parameters Default setting
Clock Edge Rise, Fall Rise
Number of Periods 2 to 50 The value varies for each DDR

generation. For example: For DDR
tERR(7per) measurement, the default
value is 7.

Window Size 200 to 1M 200
xxx
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Edges-DDR tJIT(per), DDR tCK(avg) and DDRtJIT(duty)

Option Parameters Default setting
Clock Edge Rise, Fall Rise
Window Size 200 to 1M 200
xxx

Clock Recovery Parameters
The Clock recovery configure menu depends on the clock recovery method being selected.

PLL Clock Recovery Method Parameters

Option Parameters Default setting
PLL Standard BW
PLL Model Type I, Type II Type I
Standard: b/s IBA2500 : 2.5G , PCI-E : 2.5G

FC133 : 132.8M, FC266 :265.6M,
FC531: 531.2M, FC1063: 1.063G ,
FC2125:2.125G,
SerATAG1:1.5G, SerATAG2:3.0,
SerATAG3:6.0G
USB FS:12M, USB HS:480M
1394b S400b : 491.5M, 1394b S800b
: 983.0M, 1394b S1600b : 1.966G
GB Ethernet : 1.25G
100BaseT:125M
OC1:51.8M, OC3:155M, OC12:622M,
OC48:2.488G,
FC4250:4.25G, FC8500:8.5G
PCI_E_GEN2: 5.0G,IBA_GEN2 :
5.0G
FBD1:3.2G, FBD2 : 4.0G, FBD3:
4.8G
XAUI: 3.125G, XAUI_GEN2: 6.25G
SAS15:1.5G, SAS3: 3.0G, SAS6:
6.0G
RIO125 :1.25G, RIO250 :2.5G ,
RIO3125 :3.125G

PCI-E : 2.5G

Damping 1 0.5 to 2 700 m
Loop BW 1 to 2.5 GHz 1.5 MHz
PLL Custom BW
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Option Parameters Default setting
PLL Model Type I, Type II Type I
Loop BW 1 to 2.5 GHz 1.5 MHz
xxx

1 Enable only for Type II PLL models.

Constant Clock Recovery Method Parameters

Option Parameters Default setting
Constant Clock-Mean
Auto Calc First Acq, Every Acq First Acq
Constant Clock-Median
Auto Calc First Acq, Every Acq First Acq
Constant Clock-Fixed
Clock Frequency 1 Hz to 25 GHz 2.5 GHz
xxx

Explicit Clock Recovery Method Parameters

Option Parameters Default setting
Explicit Clock-Edge/Explicit Clock-PLL
Clock Source Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch2
Clock Edge Rise, Fall, Both Both
Clock Multiplier 1 to 10 K 1
xxx

Advanced Clock Recovery Configuration Parameters

Option Parameters Default setting
PLL Custom BW/PLL Standard BW/ Constant Clock-Mean/Constant Clock-Median
Nominal Data Rate Off, On Off
Bit Rate 1 b/s to 25 Gb/s 2.5 b/s
Known Data Pattern On, Off Off
Pattern Filename Browse C:\TekApplications\DPO-

JET\Patterns

Explicit Clock: Edge
Nominal Clock Offset Relative to Data –1 to 1 s 0 s
Explicit Clock:PLL
PLL Method Type I,Type II Type I
Damping 0.5 to 2 700 m
Loop B/W 1 to 2.5 GHz 1.5 MHz
Nominal Clock Offset Relative to Data –1 to 1 s 0 s
xxx
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RJDJ Analysis Parameters
The RJDJ configure menu has the following parameters:

Table 72: RJDJ analysis parameters
Option Parameters Default setting
Data Signal Settings
Pattern Type Repeating, Arbitrary Repeating
Pattern Length * 2 UI to 1M 2 UI
Window Length † 2 to 16 UI 5 UI
Population † 5 to 5000 100
Total Jitter Component
BER = 1E-? ‡ 2 to 18 in whole numbers 12
xxx

* Only for Repeating Patterns.
† Only for Arbitrary Patterns.
‡ Only for TIE, TJ@BER and Width@BER measurements.

Filters Parameters
The Filter configure menu has the following parameters:

Table 73: Filters parameters
Option Parameters Default setting
High Pass (F1)
Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter
Freq (F1) 1 Hz to 1000 GHz 1 KHz
Low Pass (F2)
Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter
Freq (F2) 1 Hz to 1000 GHz 1 KHz
xxx

Advanced Filter Configure Parameters
The Advanced Filter Configuration includes the following parameters:

Option Parameters Default setting
Ramp Time 0/F to 10/F 2/F
Blanking Time 0/F to 10/F 4/F
xxx
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General Parameters
The General configure menu has the following parameters:

Table 74: General parameters
Option Parameters Default setting
Measurement Range Limits Off, On Off
xxx

Maximum and minimum values vary for different measurements. For more details, refer to Measurement
Values.

Global Parameters
The Global configure menu has the following parameters:

Table 75: Global parameters
Option Parameter Default setting
Gating
Gating Off, Zoom, Cursors Off
Qualify
Qualify Off, On Off
Qualify With Logic
Source Ch1-Ch4, Ref1-Ref4, Math1-Math4,

Search1-Search8
Ch1

Mid –20 V to 20 V O V
Hysteresis 0 to 10 V 30 mV
Active High, Low High
Population
Population Off, On Off
Population Limit
Limits By Population, Acquisitions Acquisitions
Limit 1 to 2 31 1 K
Stop Condition Each Measurement, Last

Measurement
Each Measurement

xxx
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Histogram Plot Parameters
The Histogram plot has Autoset as the command button.

Option Parameters Default setting
Vertical Scale Log, Linear Linear
Number of Bins
Resolution 25, 50, 100, 250, 500 250
Horizontal Scale
Auto Scale Set, Clear Set
Center -1.00E+12 to 1.00E+12 1.00E–07
Span 1.00E–12 to 1.00 E+12 4.00E–09
xxx

Eye Diagram Plot Parameters
The Eye Diagram plot has the following parameters:

Option Parameters Default setting
On, Off OffMask
Browser C:\TekApplications\DPO-

JET\Masks

Horizontal Scale
Auto Scale Set, Clear Set
Resolution 2.00E–13 to 2.00E–08 1.00E–12
Superimpose Reference Clock Eye
(if available)

Set, Clear Clear

Ref Clock Alignment Auto, Centre and Left Auto
xxx

Spectrum Plot Parameters
The Spectrum plot has the following parameters:

Option Parameters Default setting
Vertical Scale Log, Linear Linear
Base –20 to 15 –15
Horizontal Scale Log, Linear Linear
Mode Normal, Average, Peak Hold Normal
xxx
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Time Trend Plot Parameters
The Time Trend plot has the following parameters:

Option Parameters Default setting
Mode Vector, Bar Vector
xxx

Phase Noise Plot Parameters
The Phase Noise plot has the following parameters:

Option Parameters Default setting
Vertical Position
Baseline –200 to 0 –170
xxx

Bathtub Plot Parameters
The Bathtub plot has the following parameters:

Option Parameters Default setting
Vertical Scale Log, Linear Log
Minimum displayed BER= 1E-? 2 to 18 * 14
xxx

* Applicable for Log and Linear scale only.

Transfer Function Plot Parameters
The Transfer Function plot has the following parameters:

Option Parameters Default setting
Vertical Scale Log, Linear Log
Horizontal Scale Log, Linear Log
Mode Normal, Average Average
xxx

Reports
The Reports menu has the following command buttons:
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Save

Save As

Option Parameters Default setting
Include Setup configuration Set, Clear Set
Include complete application
configuration

Set, Clear Set

Include pass/fail results summary Set, Clear Set
Include detailed results Set, Clear Set
Include plot images Set, Clear Set
Auto increment report name if
duplicate

Set, Clear Set

View report after generating Set, Clear Set
Report Name Browser C:\TekApplications\DPO-

JET\Reports

xxx
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Progress Bar Status Messages
Function/Measurement module Status/Message Description
Autoset-Source Autoset VertAuto-Chx Vertical autoset for Chx is going on.
Autoset-Source Autoset HorizAuto-Chx Horizontal autoset for Chx is going on.
Autoset-Source Autoset Zooming Horiz Zooming the horizontal scale after

horizontal autoset.
Autoset-Ref Level Autoset RefAuto-Chx Reference level autoset for Chx is

going on.
Autoset-Ref Level Autoset RefAuto-Refx Reference level autoset for Refx is

going on.
Autoset-Ref Level Autoset RefAuto-Mathx Reference level autoset for Mathx is

going on.
Sequencing Sequencing Refers to the measurement

setup-edge extraction.
Measurement Name Running the measurement specified

by name.
Plotting Plotting is started.
Bathtub Creating Bathtub plot.
Spectrum Creating spectrum plot.
Time Trend Creating time trend plot.
Histogram Creating Histogram plot.
Transfer Func Creating Transfer Function plot.
Eye Mask Hits Creating Eye Diagram plot.
Eye Height Creating Eye Diagram plot.
Data Array Creating Data Array plot.

Plots

Phase Noise Creating Phase noise plot.
Edge Extraction Finding Edges Extracting Edges from signal

waveform.
Clock Data Recovery Recovery Clk Clock and Data recovery.
Worst case logging Saving WC Wfm Logging the worst case waveform.
Trigger Slow Trigger Waiting for trigger/trigger not available.
Measurements Name Progress Bar Display
Amplitude High Low Ampl High–Low
Amplitude HighV Amp High
Amplitude LowV Ampl Low
CMV Common Mode
DCD DCD
DDJ DDJ
DiffXovrV V-Diff-Xovr
DJ DJ
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Function/Measurement module Status/Message Description
DJδδ DJ–δδ
EdgeExtractor Edge Extractor
EyeHeight Eye Height
EyeMaskHits Eye Mask Hits
EyeWidth Eye Width
EyeWidthBER Eye Width@BER
FallTime Fall Time
Frequency Freq
HighTime High Time
Hold Hold
LowTime Low Time
NegativeDutyCycle –Duty Cycle
NegativeDutyCycleCycle –CC–Duty
NegativeWidth Neg Width
NPeriod N–Period
PerCycleCycle CC–Period
Period Period
PhaseNoise Phase Noise
PJ PJ
PositiveDutyCycle +Duty Cycle
PositiveDutyCycleCycle +CC–Duty
PositiveWidth Pos Width
RiseTime Rise Time
RJ RJ
RJδδ RJ–δδ
Setup Setup
Skew Skew
TIE TIE
TJ TJ@BER
TNTRatio T/nT Ratio
xxx

Error Codes
Code Description
W410 Number of edges are not sufficient for a measurement: Positive Width.
E1001 Vertical Autoset Failed: Signal on Source x has extreme offset.
E1002 Vertical Autoset Failed: Amplitude of Source x is too small.
E1003 Vertical Autoset Failed: Amplitude or DC offset of Source x is too high.
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Code Description
E1004 Vertical Autoset Failed: No signal on Source x.
E1005 Vertical Autoset Failed: Signal on Source x exceeds top of scale.
E1006 Vertical Autoset Failed: Signal on Source x exceeds bottom of scale.
E1007 Vertical Autoset Failed: Signal on Source x is clipped on top.
E1008 Vertical Autoset Failed: Signal on Source x is clipped on bottom.
E1009 Vertical Autoset Failed: Measurement error ( ISDB error code = 6 ) on Source x.
E1010 Vertical Autoset Failed: Measurement error ( ISDB error code = 7 ) on Source x.
W1011 A change to Source x vertical settings caused overload disconnect. Original settings

are restored and Source x is reconnected. Ignore oscilloscope message.
E1012 Vertical Autoset Failed: None of the selected measurements use live sources

(Ch1-Ch4). Horizontal autoset works for live sources only.
E1013 Vertical Autoset Failed: Invalid signal on Source x.
E1020 Horizontal Autoset Failed: None of the selected measurements use live sources

(Ch1-Ch4). Horizontal autoset works for live sources only.
E1021 Horizontal Autoset Failed: On Source x, cannot determine resolution of rising/falling

edges.
E1022 Horizontal Autoset Failed: Horizontal resolution is at the maximum.
E1035 Oscilloscope has gone into invalid state. Please restart the system.
E1040 Autoset Failed: None of the live sources (Ch1-Ch4) selected.
W1051 Ref Level Autoset: Waveform for the source x is clipped.
W1053 Ref Level Autoset: Source amplitude is extremely low.
E1054 Ref Level Autoset: Error in setting reference levels.
E1055 Ref Level Autoset Failed: No waveform to measure.
E1056 Ref Level Autoset: Unstable Histogram for waveform on source x.
E1057 Ref Level Autoset: No selected source.
E1058 Ref Level Autoset Failed: Invalid signal on source x.
E1059 Ref Level Autoset Error: Source x is not defined.
E2002 All the refs are used as sources by the measurements. Export to Ref is not possible.
E2003 Ref ‘x’ is already used as a measurement source.
E2004 Ref ‘x’ is already used as a destination for other measurement.
E2005 No measurement(s) are selected. Export to Ref is not possible.
E2006 No results available to export to ref.
E2007 There are no time trend results for the selected measurement(s).
E2008 No ref destination is selected. Results will not be exported to ref.
E3001 Could not open or create a log file. Please ensure that you have read/write permission

to access log folders and files.
E3002 The specified path is invalid (for example: The specified path is not mapped to a drive).
E3003 The specified path, file name or both exceed the system defined length. For Example:

On Windows-based platforms, the path name must be less than 248 characters and file
names less than 260 characters.
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Code Description
E3004 The specified path directory is read-only or is not empty.
E3005 Please ensure that the file is currently not in use by other process and/or has not

exceeded the file size limit.
E3006 Invalid filename: Check whether the file name contains a colon (:) in the middle of

the string.
E3007 Select at least one measurement from the table before you save.
E3008 There are currently no results to save. Please run a measurement.
E3010 Access to file/directory denied. Please ensure that the file/directory has read/write

permissions.
E3011 Mask Hits Measurements will not be selected as this feature is not available for Mask

Hits measurement.
E3012 Folder does not exist.
E4000 Not enough data points. Unable to render plot(s).
E4001 Out of memory. Please remove a measurement and try again.
E4002 Not enough data points for spectrum computation.
E4003 Low Memory. The entire waveform was not processed and the measurement results

are for part of the waveform.
E4004 Edge Extraction failure.
E4005 Qualifier: Horizontal parameters do not match across waveforms.
W4006 A maximum of 10 qualifier zones are supported. The entire waveform will not be

processed and hence partial measurement results are available.
xxx

Measurement Values
The following table lists the maximum and minimum values of all measurements:

NOTE. Measurement Range Limits are provided for each measurement under the General configure
tab of the DPOJET application. These range limits are always ON (OFF is disabled) for two-source
measurements such as Skew, Setup, Hold and others. The range limits are used by the algorithms to
associate the valid edge of first source to the valid edge of the second source.

Measurement Range Limits (Max) Measurement Range Limits (Min)
Name Default Max Min Default Max Min
Period/Freq measurements
Period 1 ms 1 ks 0 ns 0 ns 1 ks 0 ns
CC–Period 1 ns 1 s 1 fs –1 ns –1 fs –1 s
Freq 10GHz 50GHz 1 MHz 10 KHz 50 GHz 1 MHz
N–Period 1 ms 1 ks 0 ns 0 ns 1 ks 0 ns
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Measurement Range Limits (Max) Measurement Range Limits (Min)
Pos Width/
Neg Width

10 ns 1 Ms 1 ps 1 ns 1 Ms 1 ps

+Duty
Cycle/–Duty
Cycle

90 % 100 % 0 % 10 % 100 % 0 %

+CC–Duty/
–CC–Duty

1 ns 1 ks –1 ks –1 ns 1 ks –1 ks

Jitter Measurements
TIE 1 ns 1 µs –1 µs –1 ns 1 µs –1 µs
RJ 1 ns 1 µs 0 ns 1 ns 1 µs 0 ns
RJ–δδ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
TJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
DJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
DJ–δδ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
Phase Noise 1 ms 1 ms 0 s 0 s 1 ms 0 s
DCD 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
DDJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
PJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns
Time Measurements
Rise Time 200 ns 1 ks 0 ns 0 s 1 ks 0 ns
Setup 10 ns 1 s –1 s 0 ns 1 s –1 s
High Time 10 ns 1 Ms 1 ps 0 s 1 Ms 1 ps
Fall Time 200 ns 1 ks 0 ns 0 s 1 ks 0 ns
Hold 10 ns 1 s –1 s 0 ns 1 s –1 s
Low Time 10 ns 1 Ms 1 ps 0 s 1 Ms 1 ps
Skew 10 ns 1 s –1 s –10 ns 1 s –1 s
Eye Measurements
Height 500 mV 1 kV 0 mV 50 mV 1 kV 0 mV
Width 1 ns 1 s 0 ps 50 ps 1 s 0 ps
Mask Hits 500 Hits 1 MHit 0 Hits 0 Hits 1 MHit 0 Hits
Width@BER 0.9 UI 1.0 UI 0 UI 0.1 UI 1.0 UI 0 UI
Amplitude Measurements
Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

High 500 mV 10 V –10 V –500 mV 10 V –10 V
T/nt-Ratio 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB
High–Low 500 mV 10 V –10 V –500 mV 10 V –10 V
Low 500 mV 10 V –10 V –500 mV 10 V –10 V
V–Diff–Xovr 500 mV 10 V –10 V –500 mV 10 V –10 V
More Measurements
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Measurement Range Limits (Max) Measurement Range Limits (Min)
DDR
Setup–SE

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
Setup–Diff

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
Hold–SE

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
Hold–Diff

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
tCK(avg)

1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

DDR
tCH(avg)

1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

DDR
tCL(avg)

1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

DDR
tJIT(duty)

10ns 1 ms – 1ms –10 ns 1 ms –1 ms

DDR
tJIT(per)

10ns 1 ms – 1ms –10 ns 1 ms –1 ms

DDR tERR(n) 10ns 1 ms – 1ms –10 ns 1 ms –1 ms
DDR
tERR(m-n)

10ns 1 ms – 1ms –10 ns 1 ms –1 ms

xxx
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About Algorithms
The DPOJET application can take measurements from one or two waveforms. The number of waveforms
used by the application depends on the type of measurement being taken.

Oscilloscope Setup Guidelines
For all measurements, use the following guidelines to set up the oscilloscope:

1. The signal is any channel, reference, or math waveform.

2. The vertical scale for the waveform must be set so that the waveform does not exceed the vertical
range of the oscilloscope.

3. The sample rate must be set to capture sufficient waveform detail and avoid aliasing.

4. Longer record lengths increase measurement accuracy but the oscilloscope takes longer to measure
each waveform.

Period

If the Signal Type is Clock
The Period measurement calculates the duration of a cycle as defined by a start and a stop edge. Edges
are defined by polarity, threshold, and hysteresis. The application calculates clock period measurement
using the following equation:

Where:

PClock is the clock period.

T is the VRefMid crossing time for the selected polarity.

If the Signal Type is Data
The Period measurement calculates the duration of a Unit Interval. The application calculates this
measurement using the following equation:

Where:
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PData is the data period.

TData is the VRefMid crossing time in either direction.

Kn=Cn–Cn-1is the estimated number of unit intervals between two successive edges. Cn is the calculated
data bit index of Tn Data.

Each measurement result Pn Data is repeated Kn times in the measurement result vector, so that the
measurement population is equal to the number of unit intervals in the qualified waveform, rather than the
number of edge pairs.

Positive and Negative Width
Amount of time the waveform remains above/below the mid reference voltage level.

The application calculates these measurements using the following equations:

Where:

W+ is the positive pulse width.

W— is the negative pulse width.

T— is the VRefMid crossing on the falling edge.

T+ is the VRefMid crossing on the rising edge.

Frequency
Frequency measurement calculates the inverse of the data period for each cycle.

If the Signal Type is Clock
The application calculates clock frequency measurement using the following equation:

Where:

FClock is the clock frequency.
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PClock is the clock period measurement.

If the Signal Type is Data
The application calculates data frequency measurement using the following equation:

Where:

FData is the data frequency.

PData is the data period measurement.

N-Period

If the Signal Type is Clock
The N–Period measurement calculates the elapsed time for N consecutive crossings of the mid reference
voltage level in the direction specified.

The application calculates this measurement using the following equation:

Where:

NPClock is the accumulated period for N clock cycles.

TClock is the VRefMid crossing time for the selected edge polarity.

If the Signal Type is Data
The N–Period measurement calculates the elapsed time for N consecutive unit intervals.

The application calculates this measurement using the following equation:

Where:

NPData is the duration for N unit intervals.
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TData is the VRefMid crossing time in either direction.

If Tn+NData does not exist for a given n, no measurement is recorded for that position.

Positive and Negative Duty Cycle
The +Duty Cycle and –Duty Cycle measurements calculate the ratio of the positive (or negative) portion of
the cycle relative to the period.

The application calculates these measurements using the following equations:

Where:

D+ is the positive duty cycle.

D— is the negative duty cycle.

W+ is the positive pulse width.

W— is the negative pulse width.

PClock is the period.

Related Topics
Period

Positive and Negative Width

CC-Period
The CC–Period measurement calculates the difference in period measurements from one cycle to the next.

The application calculates CC–Period measurement using the following equation:

Where:

ΔP is the difference between adjacent periods.
P Clock is the clock period measurement.
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Positive and Negative CC Duty
The + CC–Duty and – CC–Duty measurements calculate the difference in positive (or negative) pulse
widths from one cycle to the next.

The application calculates these measurements using the following equations:

Where:

ΔW+ is the difference between positive pulse widths of adjacent clock cycles.
ΔW— is the difference between negative pulse widths of adjacent clock cycles.
W+ is the positive pulse width measurement.

W— is the negative pulse width measurement.

TIE
TIE (Time Interval Error) is the difference in time between an edge in the source waveform and the
corresponding edge in a reference clock. The reference clock is usually determined by a clock recovery
process performed on the source waveform. For Explicit-Clock clock recovery, the process is performed
on an explicitly identified source.

If the Signal Type is Clock
The application calculates Clock TIE measurement using the following equation:

Where:

TIEClock is the clock time interval error.

T Clock is the VRefMid crossing time for the specified clock edge.

T ’Clock is the corresponding edge time for the specified reference clock.

If the Signal Type is Data
The application calculates Data TIE measurement using the following equation:
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Where:

TIEData is the data time interval error.

T Data is the VRefMid crossing time in either direction.

T ’Data is the corresponding edge time for the specified reference clock.

The subscript k is used to indicate that there is one measurement per Unit Interval, rather than one
measurement per actual edge.

RJ
Random Jitter (RJ) is the rms magnitude of all timing errors not exhibiting deterministic behavior. A single
RJ value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

Dual Dirac Random Jitter
Dual Dirac Random Jitter (RJ–δδ) is the rms magnitude of all timing errors not exhibiting deterministic
behavior, calculated based on a simplifying assumption that the histogram of all deterministic jitter can
modeled as a pair of equal-magnitude dirac functions (impulses). A single RJ–δδ value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

Jitter Estimation Using Dual-Dirac Models

Jitter Summary
The Jitter Summary is not a single measurement. The Jitter Summary button on the graphical user interface
simply creates one each of all the other jitter measurements, as a convenience. This convenience function
is not supported via the programmable interface.
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TJ@BER
Total Jitter at a specified Bit Error Rate (BER). This extrapolated value predicts a peak-to-peak jitter that
will only be exceeded with a probability equal to the BER. It is generally not equal to the total jitter
actually observed in any given acquisition. A single TJ@BER value is determined for each acquisition, by
means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

Estimation of TJBER and Eye WidthBER

DJ
Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that follow deterministic
behavior. A single DJ value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

Dual Dirac Deterministic Jitter
Dual Dirac Deterministic Jitter (DJ–δδ) the peak-to-peak magnitude for all timing errors exhibiting
deterministic behavior, calculated based on a simplifying assumption that the histogram of all deterministic
jitter can modeled as a pair of equal magnitude dirac functions (impulses). A single DJ–δδ value is
determined for each acquisition, by means of RJ/DJseparation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

Jitter Estimation Using Dual-Dirac Models

Phase Noise
The Phase Noise measurement performs a jitter measurement, converts the result into the frequency
domain, and reports the rms jitter integrated between two specific frequencies selected by the user.
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The phase noise measurement is defined only for clock signals. If the source waveform appears to be a
data signal, a warning message will be produced but the measurement will proceed.

A Phase Noise measurement is required in order to enable the Phase Noise plot.

PJ
Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the deterministic jitter which is
periodic, but for which the period is not correlated with any data pattern in the waveform. A single PJ
value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

DDJ
Data-Dependent Jitter (DDJ) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with the data pattern in the waveform. A single DDJ value is determined for each
acquisition, by means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

DCD
Duty Cycle Distortion (DCD) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with signal polarity, that is the difference between the mean positive edge displacement
versus that on negative edges. A single DCD value is determined for each acquisition, by means of
RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation
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Rise Time
The Rise Time measurement is the time difference between when the VRefHi reference level is crossed
and the VRefLo reference level is crossed on the rising edge of the waveform. The Rise Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Where:

T Rise is the Rise Time.

T Hi+ is the VRefHi crossing on the rising edge.

T Lo+ is the VRefLo crossing on the rising edge.

Fall Time
The Fall Time measurement is the time difference between when the VRefLo reference level is crossed
and the VRefHi reference level is crossed on the falling edge of the waveform. The Fall Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Where:

T Fall is the Fall Time.

T Lo- is the VRefLo crossing on the falling edge.

T Hi- is the VRefHi crossing on the falling edge.
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Skew
The Skew measurement calculates the difference in time between the designated edge on a principle
waveform to the designated edge on another waveform. The closest data edge to the clock edge that falls
within the range limits is used.

The application calculates this measurement using the following equation:

Where:

T Skew is the timing skew.

T Main is the Main input VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input VRefMid2nd crossing time in the specified direction.

High Time
The High Time Measurement is the amount of time that a waveform cycle is above the VRefHi voltage
reference level.

The application calculates the measurement using the following equation:

Where:

T High is the high time.

T Hi- is the VRefHi crossing on the falling edge.

T Hi+ is the VRefHi crossing on the rising edge.

Low Time
The Low Time measurement is the amount of time that a waveform cycle is below the VRefLo voltage
reference level.

The application calculates this measurement using the following equation:
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Where:

T Low is the low time.

T Lo+ is the VRefLo crossing on the rising edge.

T Lo- is the VRefLo crossing on the falling edge.

Setup
The Setup Time measurement is the elapsed time between the designated edge of a data waveform and
when the clock waveform crosses its own voltage reference level. The closest data edge to the clock edge
that falls within the range limits is used.

The application calculates this measurement using the following equation:

Where:

T Setup is the setup time.

T Main is the Main input (clock) VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input (data) VRefMid2nd crossing time in the specified direction.

Hold
The Hold Time measurement is the elapsed time between when the clock waveform crosses its own
voltage reference level and the designated edge of a data waveform. The closest data edge to the clock
edge that falls within the range limits is used.

The application calculates this measurement using the following equation:

Where:

T Hold is the hold time.

T Mainis the Main input (clock) VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input (data) VRefMid2nd crossing time in the specified direction.
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Eye Width
The Eye Width measurement is the measured minimum horizontal eye opening at the zero reference level.

The application calculates this measurement using the following equation:

Where:

UIAVG is the average UI.

TIEpk-pk is the Peak-Peak TIE.

Width@BER
Width@BER is the Eye Width at a specified Bit Error Rate (BER). This extrapolated value predicts a
horizontal eye opening that will be violated with a probability equal to the BER. It is generally not equal to
the eye width actually observed in any given acquisition. A single Width@BER value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics
Jitter Analysis Through RJDJ Separation

Estimation of TJ@BER and Eye Width@BER

Eye Height
The Eye Height measurement is the measured minimum vertical eye opening at the UI center as shown in
the plot of the eye diagram. There are three types of Eye Height values.

The application calculates this measurement using the following equation:

Where:

VEYE-HI-MIN is the minimum of the High voltage at mid UI.

TIEEYE-LO-MAX is the maximum of the Low voltage at mid UI.
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Eye Height-Transition
The application calculates this measurement using the following equation:

Where:

VEYE-HI-TRAN-MIN is the minimum of the High transition bit eye voltage at mid UI.

TIEEYE-LO-TRAN-MAX is the maximum of the Low transition bit eye voltage at mid UI.

Eye Height-Non-Transition
The application calculates this measurement using the following equation:

Where:

VEYE-HI-NTRAN-MIN is the minimum of the High non- transition bit eye voltage at mid UI.

TIEEYE-LO-NTRAN-MAX is the maximum of the Low non-transition bit eye voltage at mid UI.

Mask Hits
The Mask Hits measurement reports the number of unit intervals in the acquisition for which mask hits
occurred, for a user-specified mask. In the Results Summary view, the Mask Hits measurement reports
the total number of unit intervals for which a mask hit occurred in at least one mask zone. In the Results
Details view, the number of hits in each of three segments is reported. The population field shows the
total number of unit intervals measured.

The Mask Hits measurement has several unique properties:

Unlike other measurements, it requires a Mask hits plot. Adding a Mask Hits measurement will cause
the corresponding plot to be created automatically. If you delete a Mask Hits plot, the application will
remove the corresponding Mask Hits measurement after verifying the action with you.

The Mask Hits measurement does not support the Worst-Case Waveforms logging feature.

The Mask Hits measurement does not support Measurement Range Limits.
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High
The High Amplitude measurement calculates the mean or mode of a selected portion of each unit interval
corresponding to a “1” bit.

The application calculates this measurement using the following equation:

Where:

VHI is the high amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

v PERCENT is the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

n is the index of a high bit, a high transition bit, or a high non-transition bit.

Low
The Low Amplitude measurement calculates the mean or mode of a selected portion of each unit interval
corresponding to a “0” bit.

The application calculates this measurement using the following equation:

Where:

VLOW is the low amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

v PERCENT is the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

n is the index of a low bit, a low transition bit, or a low non-transition bit.
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Common Mode
The Common Mode Voltage measurement (also called DC Common Mode) calculates the mean of the
Common Mode voltage waveform.

The application calculates this measurement using the following equation:

Where:

VCM is the common mode voltage measurement.

is the common mode voltage waveform.

i is the sample index of common mode waveform values.

T/nT Ratio
The T/nT Ratio measurement reports the amplitude ratio between transition and non-transition bits.

The measurement calculates the ratios of all non-transition eye voltages (2nd and subsequent eye voltages
after one edge but before the next) to their nearest preceding transition eye voltage (1st eye voltage
succeeding an edge). In the accompanying diagram, it is the ratio of the Black voltages to the Blue
voltages. The results are given in dB.

The application calculates the T/nT Ratio using the following equations:
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following a rising edge.

following a falling edge.

Where:

vEYE–HI–TRAN is the High voltage at the interpolated midpoint of the first unit interval following a positive
transition.

vEYE–LO–TRAN is the Low voltage at the interpolated midpoint of the first unit interval following a negative
transition.

vEYE–HI–NTRAN is the High voltage at the interpolated midpoint of all unit intervals except the first following a
positive transition.

vEYE–LO–NTRAN is the Low voltage at the interpolated midpoint of all unit intervals except the first following
a negative transition.

m is the index for all non-transition UIs.

n is the index for the nearest transition UI preceding the UI specified by m.

In a time trend plot of the measurement results, there is one measurement for each non-transition bit in the
waveform (that is the black arrows in the diagram).

High-Low
The High–Low measurement calculates the change in voltage level across a transition in the waveform.

The application calculates the High–Low using the following equation:

Where:

VHIGH-LOW is the high-low amplitude measurement result.

n is the index of a selected transition.
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i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location following the transition.

VLEVEL = OP[vPERCENT(i)] is the state level of the unit interval (bit period).

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

NOTE. If there are no waveform samples that fall within the identified percentage of the unit interval, the
single nearest waveform sample preceding the center point of the unit interval will be used.

V-Diff-Xovr
The Differential Crossover Voltage measurement (V–Diff–Xovr) calculates the voltage level at the
crossover voltage of a differential signal pair. If there is timing jitter on one of the pair of signal lines
relative to the other, the crossover point will be modulated by the jitter. The measurement is calculated
using the following equation:

Where:

VCrossover is the crossing voltage.

V Source1 is the voltage of the first source waveform.

TCrossover is the crossover time, when the Source1 and Source2 waveforms are equal in voltage.

DDR Setup and Hold Measurements
The following four measurements are modified versions of the basic Setup and Hold measurements found
on the Time tab. In contrast to the basic measurements which always use the Mid voltage reference to
determine edge times, these measurements use the High and Low references as required to conform to
some DDR specifications. For all these measurements, the Strobe signal (DQS) is assigned to Source1 and
the Data signal is assigned to Source2.

The measurements with names ending in “–Diff” are appropriate if you have a have a differential Data
Strobe (DQS) signal. Either connect to DQS+ and DQS– with a differential probe, or acquire these
signals with two single-ended probes and create a (pseudo-) differential signal using a Math expression
(for example: “Math1 = Ch1 – Ch2”). In this case, the data (DQ) signal uses thresholds other than the
mid threshold, but the DQS signal uses a mid threshold set to 0 V.
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Check that the DPOJET reference levels for the data source are set to match the proper values of VIH(ac),
VIH(dc), VIL(ac) and VIL(dc) for the DDR technology that you are measuring. Depending on which
edges you choose to measure (Rising, Falling or Both), you may not need to set up all of these levels.
For more details on reference level setup, refer to DDR Setup/Hold Reference Levels: Differential DQS
(see page 190).

The measurements with names ending in “–SE” are appropriate if you have a single-ended data strobe
(DQS) signal. This is allowed in DDR2 but not in DDR3. In this case, both the clock (DQS) and data (DQ)
signals use thresholds other than the mid threshold.

Check that the DPOJET reference levels for the strobe and data sources are set to match the proper
values of VIH(ac), VIH(dc), VIL(ac), and VIL(dc) for the DDR technology that you are measuring.
Depending on which edges you choose to measure (Rising, Falling or Both), you may not need to set up
all of these levels. For more details on the reference level setup, refer to DDR Setup/Hold Reference
Levels: Single-ended DQS (see page 192).

DDR Setup/Hold Reference Levels: Differential DQS
For systems with a differential DQS signal, the waveform reference points for the Setup (tDS) and Hold
(tDH) measurements details are as shown:

For the Strobe channel (Source1), the mid reference level should be set to 0V and the High and Low
references are not used. The reference levels for the Data channel (Source2) are mapped to the source
configuration panel as follows:
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Typical values for the reference levels for some current technologies can be found here:

DDR2-400, DDR2-533 Reference Levels (see page 193)

DDR2-667, DDR2800 Reference Levels (see page 193)

DDR3-800 through DDR3-1600 Reference Levels (see page 194)
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DDR Setup/Hold Reference Levels: Single-ended DQS
For systems with a single-ended DQS signal, the waveform reference points for the Setup (tDS) and
Hold (tDH) measurements details are as shown:

For both the Strobe channel (Source1) and the Data channel (Source2), the reference levels are mapped to
the source configuration panel as follows:
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Typical values for the reference levels for some current technologies can be found here:

DDR2-400, DDR2-533 Reference Levels (see page 193)

DDR2-667, DDR2800 Reference Levels (see page 193)

DDR3-800 through DDR3-1600 Reference Levels (see page 194)

DDR2-400, DDR2-533 Reference Levels
The following reference levels are typical for single-ended signals in DDR2-400 and DDR2-533
technologies.

The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, and so use this information only for general guidance.

DDR2-667, DDR2-800 Reference Levels
The following reference levels are typical for single-ended signals in DDR2-667 and DDR2-800
technologies.
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The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, and so use this information only for general guidance.

DDR3-800 through DDR3-1600 Reference Levels
The following reference levels are typical for single-ended signals in DDR3-800 through DDR3-1600
technologies.

The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, and so use this information only for general guidance.

DDR Setup-SE
The DDR Setup–SE measures the elapsed time between the designated edge of a data waveform and when
the single-ended strobe (DQS) waveform crosses its own voltage reference level. The closest data edge to
the clock edge that falls within the range limits is used. The strobe is placed on Source1 and the Data
is placed on Source2. This is the base Setup measurement, which does not include slew-rate derating.
Slew-rate derating tables can be found in the applicable JEDEC specification.

This measurement is identical to the basic Setup measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for both the
Data and Strobe (DQS). For more details on the reference voltage setup, refer to DDR Setup/Hold
Reference Levels: Single-ended DQS (see page 192).

The application calculates this measurement using the following equation:

Where:

T Setup is the setup time.
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T Main is the Main input (strobe or DQS) crossing time of VRefHighFall (for falling strobe edges) or
VRefLowRise (for rising strobe edges).

T 2nd is the 2nd input (data or DQ) crossing time of VRefLowFall (for falling data edges) or VRefHighRise
(for rising data edges).

DDR Setup-Diff
The DDR Setup–Diff measures the elapsed time between the designated edge of a data waveform and
when the differential strobe (DQS) waveform crosses its own voltage reference level. The closest data
edge to the clock edge that falls within the range limits is used. The strobe is placed on Source1 and the
Data is placed on Source2. This is the base Setup measurement, which does not include slew-rate derating.
Slew-rate derating tables can be found in the applicable JEDEC specification.

This measurement is identical to the basic Setup measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for the Data.
The Mid reference level is still used for the Strobe (DQS). For more details on the reference voltage setup,
refer to DDR Setup/Hold Reference Levels: Differential DQS (see page 190).

The application calculates this measurement using the following equation:

Where:

T Setup is the setup time.

T Main is the Main input (strobe or DQS) crossing time of VRefMid in the specified direction.

T 2nd is the 2nd input (data or DQ) crossing time of VRefLowFall (for falling data edges) or VRefHighRise
(for rising data edges).

DDR Hold-SE
The DDR Hold–SE measures the elapsed time between the designated edge of the single-ended strobe
(DQS) waveform and the designated edge of a data waveform. The closest data edge to the clock edge that
falls within the range limits is used. The strobe is placed on Source1 and the Data is placed on Source2.
This is the base Hold measurement, which does not include slew-rate derating. Slew-rate derating tables
can be found in the applicable JEDEC specification.

This measurement is identical to the basic Hold measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for both the data
and strobe (DQS). For more details on the reference voltage setup, refer to DDR Setup/Hold Reference
Levels: Single-ended DQS (see page 192).

The application calculates this measurement using the following equation:
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Where:

T Hold is the hold time.

T Main is the Main input (strobe or DQS) crossing time of VRefLowFall (for falling strobe edges) or
VRefHighRise (for rising strobe edges).

T 2nd is the 2nd input (data or DQ) crossing time of VRefHighFall (for falling data edges) or VRefLowRise
(for rising data edges).

DDR Hold-Diff
The DDR Hold–Diff measures the elapsed time between the designated edge of the single-ended strobe
(DQS) waveform and the designated edge of a data waveform. The closest data edge to the clock edge that
falls within the range limits is used. The strobe is placed on Source1 and the Data is placed on Source2.
This is the base Hold measurement, which does not include slew-rate derating. Slew-rate derating tables
can be found in the applicable JEDEC specification.

This measurement is identical to the basic Hold measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for the data.
The mid reference level is still used for the strobe (DQS). For more details on the reference voltage setup,
refer to DDR Setup/Hold Reference Levels: Differential DQS (see page 190).

The application calculates this measurement using the following equation:

Where:

T Hold is the hold time.

T Main is the Main input (strobe or DQS) crossing time of VRefMid in the specified direction.

T 2nd is the 2nd input (data or DQ) crossing time of VRefHighFall (for falling data edges) or VRefLowRise
(for rising data edges).

DDR tCL(avg))
DDR tCL(avg) is defined as the average low pulse width calculated across 200-cycle window of
consecutive low pulses.

The application calculates this measurement using the following equation:

196 DPOJET Jitter and Eye Diagram Analysis Tools



Algorithms DDR tCK(avg)

Where:

N=200, which is configurable.

Range: 200≤N≤1M

DDR tCK(avg)
DDR tCK(avg) is calculated as the average clock period across 200-cycle window.

The application calculates this measurement using the following equation:

Where:

N=200, which is configurable.

Range: 200≤N≤1M

DDR tERR(n) and DDR tERR(m-n)
DDR tERR(n) is defined as the cumulative error across multiple consecutive cycles from tCK(avg). DDR
tERR(m-n) is defined as the cumulative error across multiple consecutive predefined cycles from tCK(avg).

The application calculates this measurement using the following equation:

Where:

n=2 for tERR(2 per)

n=3 for tERR(3 per)

n=4 for tERR(4 per)
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n=5 for tERR(5 per)

6 ≤ n ≤ 10 for tERR(6–10 per)

11 ≤ n ≤ 50 for tERR(11–50 per)

DDR tJIT(duty)
DDR tJIT(duty) is defined as the cumulative set of the largest deviation of any single tCH from tCH(avg)
and the largest deviation of any single tCL from tCL(avg).

The application calculates this measurement using the following equation:

Where:

tJIT(CH) = {tCHi – tCH(avg)}

tJIT(CL) = {tCLi – tCL(avg)}

Where:

i=1 to 200

DDR tJIT(per)
DDR tJIT(per) is defined as the largest deviation of any single tCK from tCK(avg).

The application calculates this measurement using the following equation:

Where:

i =1 to 200

DDR tCH(avg)
DDR tCH(avg) is defined as the average high pulse width and is calculated across 200-cycle window of
high pulses.

The application calculates this measurement using the following equation:
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Jitter Analysis Through RJ/DJ Separation
Many of the jitter measurements are based on the concept of RJ/DJ separation. The application begins with
the measured jitter-versus-time (as represented by the TIE measurement array) and analytically determines
the random and deterministic components of the jitter. The deterministic part is further separated into
independent subcomponents with specific characteristics.

The random jitter (RJ) is assumed to be zero-mean Gaussian, and is assumed to have a flat spectrum when
viewed in the frequency domain. The measured RJ is fitted to a Gaussian mathematical model, which is
parameterized by its standard deviation. Using the mathematical model for RJ, statistically probable jitter
extremes may be predicted for much greater populations than actually measured.

The deterministic jitter (DJ) is predictable and can be generated consistently given known circumstances.
The various DJ measurements each report the peak-to-peak value of the corresponding DJ subcomponent.

Once all the jitter components have been identified and the random jitter has been converted to a
mathematical model, the components can be reassembled such that performance may be extrapolated
to extremely low bit error rates. The probabilistic Total Jitter (TJ@BER) and probabilistic Eye Width
(Width@BER) are examples of such measurements. The reported values are predictions that correspond to
a user-specified Bit Error Rate, rather than observed values.

Two approaches are supported for performing jitter separation. The first method is based on spectrum
analysis. It is only possible when the data pattern is repetitive. A clock waveform is always repetitive.
Other repetitive testing data patterns are used, such as the K28.5 data pattern. Patterns may have rather long
repetition lengths; for example, the CJTPAT pattern is 2640 bits. When using this method, you must specify
the pattern length, and you will receive a warning if the pattern length appears to differ from that specified.

The second RJ/DJ separation method, known as arbitrary pattern analysis, may be used when the data
pattern is not necessarily repetitive. This method works by correlating deterministic jitter observed over
many repetitions with the bit pattern within a time-domain window surrounding each observation.

RJ/DJ Separation via Spectrum Analysis
When the source waveform represents a repeating data pattern, Deterministic Jitter (DJ) has a frequency
spectrum of impulses. The impulses due to the data pattern are equally spaced and occur at predictable
frequencies related to the pattern length and bit rate. Specifically, the pattern-related jitter impulse must
occur at multiples of fo/N, where fo is the data bit rate and N is the data pattern length. Other spectral
impulses may occur due to periodic jitter not correlated with the data pattern.

To obtain measurements of DJ and RJ, all the components of the jitter spectrum that exceed the noise floor
by a chosen margin are attributed to deterministic jitter. Those components that fall at the frequency
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increment corresponding to the pattern length are identified as data-dependent jitter, and those occurring
at other frequencies are attributed to uncorrelated periodic jitter. The remaining spectral noise floor
(appropriately normalized to account for the removed deterministic jitter) is integrated to predict the
standard deviation of the underlying Gaussian random noise process.

Once the spectral components corresponding to each deterministic jitter type have been identified, each
component is inverse-transformed back to the time domain. From these waveforms, the peak-to-peak jitter
for each component is determined. For the random jitter, the RMS deviation is directly computable
from the standard deviation of the Gaussian model.

RJ/DJ Separation for Arbitrary Patterns
When the data pattern borne by the source waveform is not cyclically repeating, any periodic jitter still has
a frequency spectrum consisting of impulses but this is not true of the data-dependent jitter.

In this case, analysis of the data-dependent jitter may proceed based on the assumption that any given
bit is affected by a finite (and relatively small) number of preceding bits. By averaging all events for
which a given bit is preceded by a particular bit sequence, the data-dependent jitter attributable to that
bit sequence is obtained. This is because PJ and RJ are not correlated to a particular data sequence and
thus are averaged out.

If each bit is assumed to be affected by N preceding bits, there are a total of 2N possible data sequences.
The sequence length N is a configurable parameter. To get statistically sound average values for the
data-dependent jitter, a minimum population of observations is required for each individual pattern that
occurs at least once. This population limit is also configurable by the user.

By the above means, the data-dependent jitter is characterized. Once characterized, the data-dependent
jitter, on a bit-by-bit basis, may be removed from the original jitter versus time record. The remaining
jitter is composed of periodic and random jitter. This jitter is transformed into the frequency domain,
and the spectral analysis approach is used to separate the impulsive periodic jitter from the broad noise
floor of random jitter.

Estimation of TJ@BER and Eye Width@BER
One of the outcomes of the RJ/DJ separation was a mathematical model for random jitter’s probability
density function (PDF) and measured values for the PDFs of the deterministic jitter components. Since
all of these components are assumed to be statistically independent, the PDF of the total jitter can be
calculated by convolution.

Integration of the PDF yields the cumulative distribution function (CDF), which can then be used to create
the bit error rate curve (bathtub curve). Based on the bathtub curve, the eye opening (Width@BER) and
eye closure (TJ@BER) can be estimated for a given bit error rate.

The application calculates the eye opening at the specified BER using the following equation:

Eye opening = 1–TJ@BER when TJ@BER is less than one Unit Interval

Eye opening = 0 when TJ@BER exceeds one Unit Interval
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Jitter Estimation Using Dual-Dirac Models
Jitter estimation based on RJ/DJ separation depends in part on the specific jitter components modeled.
For the purposes of analyzing jitter and identifying root cause, it is very useful to identify components
as specifically as possible. But for the purposes of determining compliance, it has been found that a
simplified jitter model yields results that are more consistent across different measurement instruments
and different vendors.

A simplified model that has found acceptance in several industry standards is known as the Dual-Dirac
model. This is because the probability density function (PDF) of all the deterministic jitter is replaced
with a PDF consisting of two Dirac functions such that the total jitter and eye opening at very low bit
error rates is unchanged. The Random Jitter and Deterministic Jitter values derived from this model
are identified as RJ–δδ and DJ–δδ, respectively.

Two slightly different Dual-Dirac models have been defined. Both models begin with a jitter versus
BER (bathtub) curve, either created from a full jitter analysis based on RJ/DJ separation, or from direct
measurement of error rate versus sample point offset. The two models differ in how the RJ–δδ and DJ–δδ
values are extracted from the curve.

For the Fibre-Channel standard, values for RJ–δδ and DJ–δδ are chosen such that the Dual-Dirac bathtub
curve exactly matches the measured curve at the BER = 10-5 and BER=10-9 points.

For the PCI-Express and FB-DIMM standards, the bathtub curve is re-plotted using a different y-axis.
Instead of directly plotting against the log of the BER, the y-axis is converted to the Q-scale. The BER to
Q-scale transformation was designed such that Gaussian distributions are converted to straight lines, with a
slope that is directly related to the standard deviation of the Gaussian.

When using the Dual-Dirac jitter measurements, it is critical that you select the model that matches the
applicable standard. This may be configured in the DPOJET preferences, which are found under Analyze
> Jitter and Eye Analysis > Preferences, on the Measurement tab.

Results
The application calculates statistics for all selected measurements. The application displays the following
statistics in the Results menu:

Mean

Std Dev (Standard Deviation)

Max (Maximum Value)

Min (Minimum Value)

p-p (Peak-to-Peak)

Population
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Max-cc (Maximum positive cycle-to-cycle variation)

Min-cc (Maximum negative cycle-to-cycle variation)

Mean
The application calculates the mean value using the following equation:

Standard Deviation
The application calculates the standard deviation using the following equation:

It may seem odd that the equation for the estimate of the Standard Deviation contains a 1/(N-1) scaling
factor. If you knew the true mean of X and used it in place of the estimated mean then you would, in fact,
scale by 1/N. But, is an estimate and is likely to be in error (or bias), causing the estimate of the Standard
Deviation to be too small if scaled by 1/N. This is the reason for the scaling shown in the equation. (Refer to
Chapter 9.2 in A. Papoulis, Probability, Random Variables, and Stochastic Processes, McGraw Hill, 1991.)

NOTE. RMS value can be calculated using the relation (rms)2= (mean value)2+ (stddev)2

Maximum Value
The application calculates maximum value using the following equation:

Max(X) = Most Positive Value of X

Minimum Value
The application calculates minimum value using the following equation:

Min(X) = Most Negative Value of X

p-p
The application calculates peak-to-peak using the following equation:

p-p(X) = Max(X )– Min(X)
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Population
Population is the total number of events or observations over which the other statistics were calculated.

Population (X) = N

Max-cc
The application calculates Max-cc using the following equation:

Max-cc(X) = Max(XCC )

Where:

XCC is the first difference of X.

Min-cc
The application calculates Min-cc using the following equation:

Min-cc(X) = Min(XCC )

Where:

XCC is the first difference of X.
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About the GPIB Program
You can use remote GPIB commands to communicate with the DPOJET application. An example
of a GPIB program that can execute the DPOJET application is included with the application in
C:\TekApplications\DPOJET\Examples.

The example shows how a GPIB program executes the application to do the following tasks:

1. Start the application.

2. Recall a setup.

3. Take a measurement.

4. View measurement results and plots.

5. Exit the application.

NOTE. Commands are not case and space sensitive. Your program will operate correctly even if you do
not follow the capitalization and spacing precisely.

GPIB Reference Materials
To use GPIB commands with your oscilloscope, you can refer to the following materials:

The GPIB Program Example in C:\TekApplications\DPOJET\Examples for guidelines to use
while designing a GPIB program.

The Parameters topics for range of values, minimum units and default values of parameters.

The programmer information in the online help of your oscilloscope.

Argument Types
The syntax shows the format that the instrument returns in response to a query. This is also the preferred
format when sending the command to the instrument though any of the formats will be accepted. This
documentation represents these arguments as follows:

Table 76: Argument types
Symbol Meaning
<NR1> Signed integer value.
<NR2> Floating point value without an exponent.
<NR3> Floating point value with an exponent.
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Table 76: Argument types (cont.)
xxx

DPOJET: ADDMeas
This set-only parameter adds the specified measurement to the bottom of the current DPOJET list of
measurements and will appear in the results summary page.

Syntax
DPOJET:ADDmeas {PERIod | CCPeriod | FREQuency | NPERiod | PWIdth | NWIdth |

PDUTy | NDUTy | PCCDuty | NCCDuty | TIE | RJ | RJDirac | TJber | DJ | DJDirac

| PHASENoise | DCD | DDJ | PJ | RISEtime | SETup | HIGHTime | FALLtime | HOLD

| LOWTime | SKEW | HEIght | WIDth | MASKHits | WIDTHBer | COMmonmode | HIGH |

TNTratio | HIGHLOW | LOW | VDIFFxovr| DDRSETUPSe | DDRSETUPDiff | DDRHOLDSe

| DDRHOLDDiff| DDRTCLaverage | DDRTJITDuty | DDRTCKaverage | DDRTERrn |

DDRTJITper | DDRTCHaverage | DDRTERRMN}

Arguments
Same as syntax for measurement options.

Outputs
NONE

DPOJET:CLEARALLMeas
This set-only parameter clears the entire current list of defined measurements in DPOJET.

Syntax
DPOJET:CLEARALLMeas

Arguments
NONE

Outputs
NONE

206 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:STATE

DPOJET:STATE
Returns the current measurement state of DPOJET.

Syntax
DPOJET:STATE { RUN | SINGLE | RECALC | CLEAR | STOP }

Inputs
{ RUN | SINGLE | RECALC | CLEAR | STOP }

Outputs
The current state of the DPOJET measurement sequencer, including any of the possible inputs.

DPOJET:LASTError?
Returns the contents of the last pop-up warning dialog box. It returns an empty string should no error have
occurred since startup, or since the last call to DPOJET:LASTError?.

Syntax
DPOJET:LASTError?

Inputs
STRING

DPOJET:MEAS<x>
Returns the branch query for the application measurement slot with index <x>. This will always match
the measurement defined at the associated index <x> displayed in the DPOJET screen, where index 1 is
the first, or top of the measurement list.

Branch queries will only contain the measurement branches for those branches which have measurements
defined. This is required because of the number of measurements that can be defined in DPOJET, is 99.
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Syntax
DPOJET:MEAS<x>

DPOJET:MEAS<x>?

DPOJET:MEAS<x>:NAME?
Returns the measurement name for the measurement in slot x.

Syntax
DPOJET:MEAS<x>:NAME?

Outputs
String

DPOJET:MEAS<x>:CUSTomname
This sets or queries the custom measurement name for the measurement in slot x.

Syntax
DPOJET:MEAS<x>:CUSTomname

Inputs
String

Outputs
String

DPOJET:MEAS<x>:MEASStart
Sets or queries the measurement start value.
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Syntax
DPOJET:MEAS<x>:MEASStart

Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:EDGEIncre
Sets or queries the measurement edge increment value.

Syntax
DPOJET:MEAS<x>:EDGEIncre

Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:N
Sets or queries the measurement N value.

Syntax
DPOJET:MEAS<x>:N

Inputs
<NR3>
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Outputs
<NR1>

DPOJET:MEAS<x>:SOUrce1
Sets or queries the Source1 value.

Syntax
DPOJET:MEAS<x>:SOUrce1

Inputs
{CH1 - CH4, MATH1 - MATH4, REF1 - REF4}

Outputs
{CH1 - CH4, MATH1 - MATH4, REF1 - REF4}

DPOJET:MEAS<x>:SOUrce2
Sets or queries the Source2 value. May return NONE for single-source measurement.

Syntax
DPOJET:MEAS<x>:SOUrce2

Inputs
{CH1 - CH4, MATH1 - MATH4, REF1 - REF4}

Outputs
{CH1 - CH4, MATH1 - MATH4, REF1 - REF4}

DPOJET:MEAS<x>:EDGE1
Sets or queries the Source1 edge type.
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Syntax
DPOJET:MEAS<x>:EDGE1

Inputs
{RISe, FALL, BOTH}

Outputs
{RISe, FALL, BOTH}

DPOJET:MEAS<x>:EDGE2
Sets or queries the Source2 edge type.

Syntax
DPOJET:MEAS<x>:EDGE2

Inputs
{RISe, FALL, BOTH}

Outputs
{RISe, FALL, BOTH}

DPOJET:MEAS<x>:SIGNALType
Sets the signal type for various measurements.

Syntax
DPOJET:MEAS<x>:SIGNALType

Inputs
{CLOCK, DATA, or AUTO}
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Outputs
{CLOCK, DATA, or AUTO}

DPOJET:MEAS<x>:TOEdge
Sets the TOEdge value for the measurement.

Syntax
DPOJET:MEAS<x>:TOEdge

Inputs
{SAMEas, OPPositeas}

Outputs
{SAMEas, OPPositeas}

DPOJET:MEAS<x>:FROMedge
Sets the FROMedge value for the measurement.

Syntax
DPOJET:MEAS<x>:FROMedge

Inputs
{RISe, FALL, BOTH}

Outputs
{RISe, FALL, BOTH}

DPOJET:MEAS<x>:FILTers:RAMPtime
Sets or queries the current filter ramp time.

212 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:MEAS<x>:FILTers:BLANKingtime

Syntax
DPOJET:MEAS<x>:FILTers:RAMPtime

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:BLANKingtime
Sets or queries the current filter blanking time.

Syntax
DPOJET:MEAS<x>:FILTers:BLANKingtime

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC
Sets or queries the current high pass filter specification.

Syntax
DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC {NONE, FIRST, SECOND, THIRD}

Inputs
{NONE, FIRST, SECOND, THIRD}
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Outputs
{NONE, FIRST, SECOND, THIRD}

DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ
Sets or queries the current high pass filter frequency.

Syntax
DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:LOWPass:SPEC
Sets or queries the current low pass filter specification.

Syntax
DPOJET:MEAS<x>:FILTers:LOWPass:SPEC {NONE, FIRST, SECOND, THIRD}

Inputs
{NONE, FIRST, SECOND, THIRD}

Outputs
{NONE, FIRST, SECOND, THIRD}

DPOJET:MEAS<x>:FILTers:LOWPass:FREQ
Sets or queries the current low pass filter frequency.
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Syntax
DPOJET:MEAS<x>:FILTers:LOWPass:FREQ

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:BER
Sets or queries the current RJDJ BER value.

Syntax
DPOJET:MEAS<x>:RJDJ:BER

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:TYPe
Sets or queries the current RJDJ measurement type.

Syntax
DPOJET:MEAS<x>:ENVIronment:RJDJ:TYPe {ARBITrary, REPEating}

Inputs
{ARBitrary, REPEating}
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Outputs
{ARBitrary, REPEating}

DPOJET:MEAS<x>:RJDJ:PATLen
Sets or queries the current RJDJ pattern length.

Syntax
DPOJET:MEAS<x>:RJDJ:PATLen

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:WINDOwlength
Sets or queries the current RJDJ window length.

Syntax
DPOJET:MEAS<x>:RJDJ:WINDOwlength

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:POPUlation
Sets or queries the current RJDJ population.
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Syntax
DPOJET:MEAS<x>:RJDJ:POPUlation

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:METHod
Sets or queries the current Clock recovery method.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:METHod {STANDARD, CUSTOM, CONSTMEAN, CONSTFIXED,

EXPEDGE, EXPPLL, CONSTMEDIAN }

Inputs
{STANDARD, CUSTOM, CONSTMEAN, CONSTFIXED, EXPEDGE, EXPPLL, CONSTMEDIAN}

Outputs
{STANDARD, CUSTOM, CONSTMEAN, CONSTFIXED, EXPEDGE, EXPPLL, CONSTMEDIAN}

DPOJET:MEAS<x>:CLOCKRecovery:MODel
Sets or queries the current clock recovery model.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:MODel {ONE | TWO}

Inputs
{ONE, TWO}
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Outputs
{ONE, TWO}

DPOJET:MEAS<x>:CLOCKRecovery:STAndard
Sets or queries the current clock recovery standard, as specified in the user interface.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:STAndard

Inputs
String

Outputs
String

DPOJET:MEAS<x>:CLOCKRecovery:DAMPing
Sets or queries the clock recovery damping value.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:DAMPing

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth
Sets or queries the clock recovery loop bandwidth.

218 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:DATARate

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:DATARate
Turns on or off the usage of DATArate.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:DATARate

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate
Sets or queries the clock bit rate. Used if DATARate is 1.

Syntax
DPOJET:MEAS<x>:ENVIronment:CLOCKRecovery:CLOCKBitrate

Inputs
<NR3>
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Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency
Sets or queries the clock frequency. Used with Constant Clock - Fixed clock recovery method.

Syntax
DPOJET:MEAS<x>:ENVIronment:CLOCKRecovery:CLOCKFrequency

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:PATTern
Turns on or off the usage of CLOCKPath to specific a known data pattern.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:PATTern

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath
Sets or queries the current known clock pattern path.
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Syntax
DPOJET:MEAS<x>:ENVIronment:CLOCKRecovery:CLOCKPath

Inputs
String

Outputs
String

DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate
Sets or queries how often the clock is calculated, either FIRST, or on EVERY acquisition.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate

Inputs
{FIRST, EVERY}

Outputs
{FIRST, EVERY}

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset
Sets or queries the clock offset.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset

Inputs
<NR3>
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Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier
Sets or queries the clock multiplier.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITType
Sets or queries the measurement bit type setting.

Syntax
DPOJET:MEAS<x>:BITType

Inputs
{ALLBits, NONTRANsition, TRANsition}

Outputs
{ALLBits, NONTRANsition, TRANsition}

DPOJET:MEAS<x>:BITPcnt
Sets or queries the percentage of the center of bit to measure.
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Syntax
DPOJET:MEAS<x>:BITPcnt

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITCfgmethod
Sets or queries the measurement bit configure method.

Inputs
{MEAN, MODE}

Outputs
{MEAN, MODE}

DPOJET:MEAS<x>:MASKfile
Sets or queries the current mask file name.

Syntax
DPOJET:MEAS<x>:MASKfile

Inputs
String

Outputs
String
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DPOJET:MEAS<x>:MEASRange:STATE
Turns on or off the measurement range limits.

Syntax
DPOJET:MEAS<x>:MEASRange:STATE

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:MEASRange:MIN
Sets or queries the minimum measurement range limit value.

Syntax
DPOJET:MEAS<x>:MEASRange:MIN

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MEASRange:MAX
Sets or queries the maximum measurement range limit value.

Syntax
DPOJET:MEAS<x>:MEASRange:MAX
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Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:PHASENoise:LOWLimit
Sets or queries the lower phase noise integration limit.

Syntax
DPOJET:MEAS<x>:PHASENoise:LOWLimit

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:PHASENoise:HIGHLimit
Sets or queries the upper phase noise integration limit.

Syntax
DPOJET:MEAS<x>:PHASENoise:HIGHLimit

Inputs
<NR3>

Outputs
<NR3>
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DPOJET:MEAS<x>:LOGging:STATistics:SELect
Sets or queries the given measurement for inclusion in any statistic logging. Statistic logging is turned on
or off as a whole, using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:LOGging:STATistics:SELect

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:LOGging:MEASurements:SELect
Sets or queries the given measurement for inclusion in any measurement logging. Statistic logging is
turned on or off as a whole, using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:LOGging:MEASurements:SELect

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?
Queries current file name that will be used for the measurement, should measurement logging be turned on.
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Syntax
DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

Outputs
String

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect
Sets or queries the given measurement for inclusion in any worst case logging. Statistic logging is turned
on or off as a whole, using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:LOGging:WORSTcase:SELect

Inputs
1/0

Outputs
1/0

DPOJET:GATING
Sets or queries the gating state.

Syntax
DPOJET:GATING

Inputs
{OFF, ZOOM, CURSORS}

Outputs
{OFF, ZOOM, CURSORS}
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DPOJET:QUALify:STATE
Turns on or off measurement qualification.

Syntax
DPOJET:QUALify:STATE

Inputs
1/0

Outputs
1/0

DPOJET:QUALify:SOUrce
Sets the qualifier source.

Syntax
DPOJET:QUALify:SOUrce

Inputs
{CH1 – CH4, MATH1 - MATH4, REF1 - REF4, SEARCH1 – SEARCH8}

Outputs
{CH1 - CH4, MATH1 - MATH4, REF1 - REF4, SEARCH1 – SEARCH8}

DPOJET:QUALify:ACTIVE
Sets the active state for the qualifier source, either HIGH or LOW.

Syntax
DPOJET:QUALify:ACTIVE
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Inputs
{HIGH, LOW}

Outputs
{HIGH, LOW}

DPOJET:POPULATION:STATE
Turns on or off population limits.

Syntax
DPOJET:POPULATION:STATE

Inputs
1/0

Outputs
1/0

DPOJET:POPULATION:LIMITBY
Sets or queries the mechanism by limits, either acquisition or population.

Syntax
DPOJET:POPULATION:LIMITBY

Inputs
{ACQuisitions, POPUlation}

Outputs
{ACQuisitions, POPUlation}
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DPOJET:POPULATION:LIMIT
Sets or queries the current limit value.

Syntax
DPOJET:POPULATION:LIMIT

Inputs
<NR3>

Outputs
<NR1>

DPOJET:POPULATION:CONDition
Sets or queries the current population limit condition.

Syntax
DPOJET:POPULATION:CONDition

Inputs
{EACHmeas | LASTmeas}

Outputs
{EACHmeas | LASTmeas}

DPOJET:LIMITRise
Turns on or off the ability to limit Rise/Fall measurements to transition bits only.

Syntax
DPOJET:LIMITRise
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Inputs
1/0

Outputs
1/0

DPOJET:DIRacmodel
Sets or queries the current dirac model.

Syntax
DPOJET:DIRacmodel

Inputs
{FIBREchannel, PCIExpress}

Outputs
{FIBREchannel, PCIExpress}

DPOJET:INTERp
Sets or queries the current interpolation model.

Syntax
DPOJET:INTERp

Inputs
{LINear, SINX}

Outputs
{LINear, SINX}
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DPOJET:SOURCEAutoset
Performs a DPOJET horizontal, vertical, or autoset on both horizontal and vertical for any sources used in
current measurements.

Syntax
DPOJET:SOURCEAutoset

Inputs
{HORIzontal | VERTical | BOTH}

DPOJET:REFLevels:AUTOSet
Performs a DPOJET reflevel autoset on any sources selected using DPOJET:REFLevels:CH<x>:AUTOSet.

Syntax
DPOJET:REFLevels:AUTOSet

Inputs
EXECute

NOTE. All pieces of the reflevel branch have the ability to set ref levels for CH1-CH4, MATH1-MATH4,
and REF1-Ref4. Only the CH<x> portion is shown in this OLH,, but it exists and matches exactly for
MATH (DPOJET:REFLevels:MATH<x> and REF (DPOJET:REFLevels:REF<x>).

DPOJET:REFLevels:CH<x>:AUTOSet
Sets or clears the reflevel autoset state of the given source. When set to 1, the given source will have a ref
level autoset done on it during the next acquisition.

Syntax
DPOJET:REFLevels:CH<x>:AUTOSet
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Inputs
1/0

Outputs
1/0

NOTE. The Ref Level Autoset state is shown only for Ch1-Ch4 sources. It is the same for MATH and Ref
waveforms. For example: DPOJET:REFLevels: MATH<x>, DPOJET:REFLevels:REF<x>.

DPOJET:REFLevels:CH<x>:BASETop
Sets the base-top method for autoset.

Syntax
DPOJET:REFLevels:CH<x>:BASETop {MINMax, FULLhistogram, EYEhistogram, AUTO}

Inputs
{MINMax, FULLhistogram, EYEhistogram, AUTO}

Outputs
{MINMax, FULLhistogram, EYEhistogram, AUTO}

DPOJET:REFLevels:CH<x>:ABsolute
The ABSolute branch specifies the ref levels in the event a user chooses not to run a ref level autoset on a
given source. In the event the user does run a ref level autoset, the percentage values below are used.

DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh
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Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:RISEMid
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:RISEMid

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:RISELow
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:RISELow

Inputs
<NR3>

Outputs
<NR3>

234 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh

DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLMid
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:FALLMid

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLLow
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:FALLLow
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis
Sets the hysteresis value used for autoset.

Syntax
DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent
Sets percent reflevel parameters work as the absolute parameters do, only setting the various percentage
levels used by the autoset.

DPOJET:REFLevels:CH<x>:PERcent:RISEHigh
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:RISEHigh
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:RISEMid

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISEMid
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:RISEMid

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISELow
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:RISELow

Inputs
<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLMid
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:FALLMid

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLLow
Sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:FALLLow
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis
Sets the hysteresis value used for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts?
Returns the measurement branch for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts?

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?
Returns the population measurement value for the currently selected measurement for measurement
slot <x>.
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

Outputs
<NR1>

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?
Returns the pass/fail status for the population measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?
Returns the mean measurement for the currently loaded limit file.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?
Returns the pass/fail status for the mean measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?
Returns the standard deviation of the measurement value for the currently selected measurement for
measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:StdDev?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?
Returns the pass/fail status for the standard deviation measurement for the currently loaded limit file.
(Set using DPOJET:LIMits:FILEName)

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?
Returns the maximum value of the measurement value for the currently selected measurement for
measurement slot <x>.
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?
Returns the pass/fail status for the max measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?
Returns the minimum value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?
Returns the pass/fail status for the minimum measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?
Returns the peak-to-peak value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?
Returns the pass/fail status for the peak-to-peak measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?
Returns the maximum positive cycle-to-cycle delta of the selected measurement.
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?
Returns the pass/fail status for the max cycle-to-cycle measurement for the currently loaded limit file.
(Set using DPOJET:LIMits:FILEName)

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?
Returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?
Returns the pass/fail status for the min cycle-to-cycle measurement for the currently loaded limit file.
(Set using DPOJET:LIMits:FILEName)
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?
Returns the mean measurement value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?

Outputs
<NR1>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?
Returns the mean value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:STDev?
Returns the standard deviation for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:STDev?
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?
Returns the maximum value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?
Returns the minimum value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:PK2PK?
Returns the peak-to-peak value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:PK2PK?

Outputs
<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?
Returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?
Returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?
Returns the minimum mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?

Outputs
<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?
Returns the maximum mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits?
Returns the mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?
Returns the minimum mask hits measurement for all segments.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?

Outputs
<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?
Returns the maximum mask hits measurement for all segments.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?
Returns the mask hits measurement for all segments.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?
Returns the mask hit population.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?

Outputs
<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULTS:STATus?

DPOJET:MEAS<x>:RESULTS:STATus?
Returns the status of the given measurement values in slot MEAS<x>. Valid for currently valid
measurements, or the error status such as “Not enough edges”.

Syntax
DPOJET:MEAS<x>:RESULTS:STATus?

Outputs
String

DPOJET:ADDPlot
This set-only command creates a plot of the specified type on the specified DPOJET measurement. Up
to four plots can be created.

Syntax
DPOJET:ADDPlot

Inputs
{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |

WAVEform | BATHtub}, MEAS<x>}

Example
DPOJET:ADDPlot HISTOgram, MEAS2

DPOJET:CLEARALLPlots
This set-only parameter clears the entire current list of defined plots in DPOJET.

Syntax
DPOJET:CLEARALLPlots
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GPIB Commands DPOJET:PLOT<x>:TYPe?

Arguments
NONE

Outputs
NONE

DPOJET:PLOT<x>:TYPe?
Returns the current plot type for the selected plot.

Syntax
DPOJET:PLOT<x>:TYPe?

Outputs
{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE

| WAVEform | BATHtub}

DPOJET:PLOT<x>:SOUrce?
Returns the source measurement for the selected plot.

Syntax
DPOJET:PLOT<x>:SOUrce?

Outputs
{MEAS1 - MEAS99}

DPOJET:PLOT<x>:TREND:TYPe
Sets or returns the trend type setting for Trend plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:AUTOset

Syntax
DPOJET:PLOT<x>:TREND:TYPe

Inputs
{VECTOR | BAR}

Outputs
{VECTOR | BAR}

DPOJET:PLOT<x>:HISTOgram:AUTOset
Runs a histogram autoset for the specified slot.

Syntax
DPOJET:PLOT<x>:HISTOgram:AUTOset

Inputs
{EXECute}

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE
Sets or returns the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE

Inputs
{LINEAR | LOG}
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale

Outputs
{LINEAR | LOG}

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale
Sets or returns the horizontal auto scale settings.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale

Inputs
1/0

Outputs
1/0

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution
Sets or returns the horizontal resolution used in Eye Diagram plots.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution

Inputs
<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:NUMBins

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:NUMBins
Sets or queries the current histogram resolution.

Syntax
DPOJET:PLOT<x>:HISTOgram:NUMBins

Inputs
{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred}

Outputs
{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred}

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter
Sets or returns the histogram center.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter

Inputs
<NR3>

Outputs
<NR3>

NOTE. Undefined for non-histogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN
Sets or returns the histogram span.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

Inputs
<NR3>

Outputs
<NR3>

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE
Sets or returns the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for non-spectrum plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE
Sets or returns the horizontal scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for non-spectrum plots.

DPOJET:PLOT<x>:SPECtrum:BASE
Sets or returns the spectrum base. Undefined for non-spectrum plots.

Syntax
DPOJET:PLOT<x>:SPECtrum:BASE

Inputs
<NR3>

Outputs
<NR1>

DPOJET:PLOT<x>:SPECtrum:MODE
Sets or returns the spectrum mode.
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

Syntax
DPOJET:PLOT<x>:SPECtrum:MODE

Inputs
{NORMal | AVErage | PEAKhold}

Outputs
{NORMal | AVErage | PEAKhold}

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE
Sets or returns the vertical scale setting for applicable plots, either Linear or Log. Undefined for
non-transfer plots.

Syntax
DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE
Sets or returns the horizontal scale setting for applicable plots, either Linear or Log. Undefined for
non-transfer plots.

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:MODE

DPOJET:PLOT<x>:TRANSfer:MODE
Sets or returns the transfer plot mode.

Syntax
DPOJET:PLOT<x>:TRANSfer:MODE

Inputs
{NORMal | AVErage}

Outputs
{NORMal | AVErage}

DPOJET:PLOT<x>:TRANSfer:NUMerator
Sets or returns the transfer plot numerator.

Syntax
DPOJET:PLOT<x>:TRANSfer:NUMerator

Inputs
{MEAS1 - MEAS99}

Outputs
{MEAS1 - MEAS99}

NOTE. Undefined for non-transfer plots.

DPOJET:PLOT<x>:TRANSfer:DENominator
Sets or returns the transfer plot denominator.
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GPIB Commands DPOJET:PLOT<x>:PHASEnoise:BASEline

Syntax
DPOJET:PLOT<x>:TRANSfer:DENominator

Inputs
{MEAS1 - MEAS99}

Outputs
{MEAS1 - MEAS99}

NOTE. Undefined for non-transfer plots.

DPOJET:PLOT<x>:PHASEnoise:BASEline
Sets or returns the phase noise baseline.

Syntax
DPOJET:PLOT<x>:PHASEnoise:BASEline

Inputs
<NR3>

Outputs
<NR1>

NOTE. Undefined for non-phase noise plots.

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE
Sets or returns the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:BATHtub:VERTical:SCALE

DPOJET Jitter and Eye Diagram Analysis Tools 259



GPIB Commands DPOJET:PLOT<x>:BATHtub:BER

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

NOTE. Undefined for non-bathtub plots.

DPOJET:PLOT<x>:BATHtub:BER
Sets or returns the bathtub BER value.

Syntax
DPOJET:PLOT<x>:BATHtub:BER

Inputs
<NR3>

Outputs
<NR1>

NOTE. Undefined for non-bathtub plots.

DPOJET:PLOT<x>:EYE:HORizontal:RESolution
Sets or returns the Horizontal Eye resolution.

Syntax
DPOJET:PLOT<x>:EYE:HORizontal:RESolution

Inputs
<NR3>
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GPIB Commands DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale

Outputs
<NR1>

NOTE. Undefined for non-eye plots.

DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale
Sets or returns the horizontal auto scale setting.

Syntax
DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale

Inputs
1/0

Outputs
1/0

NOTE. Undefined for non-eye plots.

DPOJET:PLOT<x>:EYE:STATE
Sets or returns the eye state, either on or off.

Syntax
DPOJET:PLOT<x>:EYE:STATE

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:PLOT<x>:EYE:MASKfile

NOTE. Undefined for non-eye plots.

DPOJET:PLOT<x>:EYE:MASKfile
Sets or returns the mask file.

Syntax
DPOJET:PLOT<x>:EYE:MASKfile

Inputs
String

Outputs
String

NOTE. Undefined for non-eye plots.

DPOJET:PLOT<x>:EYE:SUPERImpose
Sets or returns whether superimposed eyes are generated in eye diagrams.

Syntax
DPOJET:PLOT<x>:EYE:SUPERImpose

Inputs
1/0

Outputs
1/0

NOTE. Undefined for non-eye plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:ALIGNment

DPOJET:PLOT<x>:EYE:ALIGNment
Sets or returns eye alignment state for eye plots.

Syntax
DPOJET:PLOT<x>:EYE:ALIGNment

Inputs
AUTO, LEFT, CENter

Outputs
AUTO, LEFT, CENter

NOTE. Undefined for non-eye plots.

DPOJET:REPORT
This set-only parameter executes a DPOJET report save operation for the currently defined report
configuration.

Syntax
DPOJET:REPORT

Inputs
EXECute

DPOJET:REPORT:SETupconfig
Turns on or off including setup configuration in reports.

Syntax
DPOJET:REPORT:SETupconfig
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GPIB Commands DPOJET:REPORT:APPlicationconfig

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:APPlicationconfig
Turns on or off including complete application configuration in reports.

Syntax
DPOJET:REPORT:APPlicationconfig

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:PASSFailresults
Turns on or off including pass/fail results in reports.

Syntax
DPOJET:REPORT:PASSFailresults

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:REPORT:DETailedresults

DPOJET:REPORT:DETailedresults
Turns on or off including detailed results in reports.

Syntax
DPOJET:REPORT:DETailedresults

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:PLOTimages
Turns on or off including detailed plot images in reports.

Syntax
DPOJET:REPORT:PLOTimages

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:AUTOincrement
Turns on or off auto increment of report file names.

Syntax
DPOJET:REPORT:AUTOincrement
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GPIB Commands DPOJET:REPORT:VIEWreport

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:VIEWreport
Turns on or off viewing report after generation.

Syntax
DPOJET:REPORT:VIEWreport

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:REPORTName
Sets the current report file name.

Syntax
DPOJET:REPORT:REPORTName

Inputs
String

Outputs
String
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GPIB Commands DPOJET:LOGging:SNAPshot

DPOJET:LOGging:SNAPshot
DPOJET export of the specified type, either for statistics or measurements.

Syntax
DPOJET:LOGging:SNAPshot {STATistics | MEASurements}

Inputs
{STATistics | MEASurements}

Outputs
{STATistics | MEASurements}

DPOJET:LOGging:STATistics:STATE
Turns on or off the future logging of statistics. Individual measurements included in the logging are
selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire set of
included measurements.

Syntax
DPOJET:LOGging:STATistics:STATE

Inputs
1/0

Outputs
1/0

DPOJET:LOGging:STATistics:FILEname
Sets or returns the current file used for statistics logging.
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GPIB Commands DPOJET:LOGging:MEASurements:STATE

Syntax
DPOJET:LOGging:STATistics:FILEname

Inputs
String

Outputs
String

DPOJET:LOGging:MEASurements:STATE
Turns on or off the future logging of measurements. Individual measurements included in the logging
are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire
set of included measurements.

Syntax
DPOJET:LOGging:MEASurements:STATE

Inputs
String

Outputs
String

DPOJET:LOGging:MEASurements:FOLDer
Sets or returns the current folder used for measurement logging.

Syntax
DPOJET:LOGging:MEASurements:FOLDer

Inputs
String
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GPIB Commands DPOJET:LOGging:WORSTcase:STATE

Outputs
String

DPOJET:LOGging:WORSTcase:STATE
Turns on or off the future logging of worst case waveforms. Individual measurements included in the
logging are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the
entire set of included measurements.

Syntax
DPOJET:LOGging:WORSTcase:STATE

Inputs
1/0

Outputs
1/0

DPOJET:LOGging:WORSTcase:FOLDer
Sets or returns the current folder used for worst case logging.

NOTE. Waveform filenames generated while worst case logging is on will follow the syntax of,
“Measurement Name”-“Source”_Min1.wfm and “Measurement Name”-“Source”_Max1.wfm, For
example: Period1-Ch1_Max1.wfm, Period1-Ch1_Min1.wfm, Rise Time1-Ch1_Max1.wfm, Rise
Time1-Ch1_Min1.wfm

Syntax
DPOJET:LOGging:WORSTcase:FOLDer

Inputs
String
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GPIB Commands DPOJET:LIMits:STATE

Outputs
String

DPOJET:LIMits:STATE
Turns on or off the pass-fail limit system. Pass-fail status can be queried using the DPOJET:MEAS
<x>:RESULTS node.

Syntax
DPOJET:LIMits:STATE

Inputs
1/0

Outputs
1/0

DPOJET:LIMits:FILEName
Sets or returns the current limits filename.

Syntax
DPOJET:LIMits:FILEName

Inputs
String

Outputs
String

DPOJET:DESKEW
Performs a DPOJET deskew operation with the settings specified in DPOJET:DESKEW.
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GPIB Commands DPOJET:DESKEW:REFChannel

Syntax
DPOJET:DESKEW EXEcute

Inputs
EXEcute

DPOJET:DESKEW:REFChannel
Sets or queries the reference channel used for deskew operation.

Syntax
DPOJET:DESKEW:REFChannel

Inputs
{CH1-CH4}

Outputs
{CH1-CH4}

DPOJET:DESKEW:REFMidlevel
Sets or returns the reference channel midlevel value.

Syntax
DPOJET:DESKEW:REFMidlevel

Inputs
<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:DESKEW:REFHysteresis

DPOJET:DESKEW:REFHysteresis
Sets or returns the reference channel hysteresis value.

Syntax
DPOJET:DESKEW:REFHysteresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:DESKEWchannel
Sets or queries the channel to be deskewed.

Syntax
DPOJET:DESKEW:DESKEWchannel

Inputs
{CH1-CH4}

Outputs
{CH1-CH4}

DPOJET:DESKEW:DESKEWMidlevel
Sets or returns the deskew channel midlevel value.

Syntax
DPOJET:DESKEW:DESKEWMidlevel
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GPIB Commands DPOJET:DESKEW:DESKEWHysteresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:DESKEWHysteresis
Sets or returns the deskew channel hysteresis value.

Syntax
DPOJET:DESKEW:DESKEWHysteresis

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:MAXimum
Sets or returns the maximum deskew value possible.

Syntax
DPOJET:DESKEW:MAXimum

Inputs
<NR3>

Outputs
<NR3>
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GPIB Commands DPOJET:DESKEW:MINimum

DPOJET:DESKEW:MINimum
Sets or returns the minimum deskew value possible.

Syntax
DPOJET:DESKEW:MINimum

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:EDGE
Sets or returns the edge types used when calculating deskew.

Syntax
DPOJET:DESKEW:EDGE

Inputs
{RISE | FALL | BOTH}

Outputs
{RISE | FALL | BOTH}

DPOJET:VERsion?
Returns the current DPOJET version string.

Syntax
DPOJET:VERsion?
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GPIB Commands DPOJET:NUMMeas?

Outputs
String

DPOJET:NUMMeas?
Returns the current number of defined measurements.

Syntax
DPOJET:NUMMeas?

Outputs
<NR1>

DPOJET:MEAS<x>:DDR:NPERCycle
Sets or returns the NPercycle value used in various DDR measurements.

Syntax
DPOJET:MEAS<x>:DDR:NPERCycle

Example: DPOJET:MEAS34:DDR:NPERCycle?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:DDR:MPERCycle
Sets or returns the MPercycle value used in various DDR measurements.
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GPIB Commands DPOJET:MEAS<x>:DDR:WINDowsize

Syntax
DPOJET:MEAS<x>:DDR:MPERCycle

Example: DPOJET:MEAS34:DDR:MPERCycle?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:DDR:WINDowsize
Sets or returns the window size used in various DDR measurements

Syntax
DPOJET:MEAS<x>:DDR:WINDowsize

Example: DPOJET:MEAS34:DDR:WINDowsize?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:HIGHPerfrendering
Sets or queries the current high-performance eye rendering setting.

Syntax
DPOJET:HIGHPerfrendering
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GPIB Commands DPOJET:UNITType

Inputs
1/0

Outputs
<NR1>

DPOJET:UNITType
Sets or queries the current unit typesetting for DPOJET, either Unit Interval, or seconds.

Syntax
DPOJET:UNITType

Inputs
{UNITinterval, SEConds}

Outputs
{UNITinterval, SEConds}

DPOJET:SAVE
Set-only parameter saves the specified DPOJET measurement result, to the specified ref. For Example:
DPOJET:SAVE MEAS4, REF2

Syntax
DPOJET:SAVE

Inputs
{MEAS1-MEAS99, REF1-REF4}

DPOJET Jitter and Eye Diagram Analysis Tools 277



GPIB Commands DPOJET:EXPORT

DPOJET:EXPORT
This sets-only parameter saves the specified DPOJET plot, to the specified file path. The Format is
determined through the filename extension, with a default of png should no extension be specified.

Supported extensions include jpeg, jpg, tif, tiff, bmp, emf, and png. For example: DPOJET:EXPORT
PLOT1, “savedimage.tif”.

Syntax
DPOJET:EXPORT

Inputs
{PLOT1-PLOT4, <file string>}
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